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Using the Manuals 

Cg Compose 2 Manual 

Getting Started 

Your Personal Composition System will be installed following the procedures in 
Chapter 6, Setting Up Your System, in the Lisa Office System Manual. Each of the 
Personal Composition System software tools has a manual that teaches how to 
use the tool. 

This manual will teach you to use of Cg Compose 2 software. It also includes a 
separate chapter on each one of the output devices and a quick reference section 
describing the set up of output devices. If you are already familiar with the 
Personal Composition System you may want to turn to Chapter 3:Cg Compose 2 
Reference, to learn about the software enhancements. If you are new to the 
Personal Composition System, you should follow the steps listed below. 

1 Go through Chapters 1 and 2 in the Lisa Office System Manual for an 
introduction to the Lisa. This includes booting the system with Lisa Guide and 
completing the interactive training. 

2 The Lisa Office System Manual also contains other information about how to 
use your System. For example, it has a trouble shooting section to help you 
solve problems when the System is not working as it should. As you become 
more familiar with the System and need more information, check the Table of 
Contents or the Index for assistance. This may include installing software, 
setting Preferences, using the calculator, tips on caring for the Lisa, and other 
desktop management activities. 

3 When you are familiar with Personal Composition System basic operating 
procedures, turn to each of the tool manuals to learn the essentials of using 
that tool. To learn Compose you will have to know at least the LisaWrite and 
LisaDraw tools. 

~ Go to Chapter 1 of each tool manual to learn about a tool. 

~ Go to Chapter 2 for self-paced instructions on using a tool. 

~ Go to Chapter 3 for specific instructions for performing a task with a tool. 

4 When you feel confident that you can create documents in LisaWrite and 
LisaDraw you will be ready to learn Cg Compose 2. Go to Chapter 1 of this 
manual to begin learning about the Compose tool. 

5 Your Personal Composition System may be set up with a number of different 
output devices. You can identify the devices and where they are connected by 
opening your System Preferences. General instructions for checking and 
changing device connections are found in the Lisa Office Systems Manual. 
Specific intructions for connecting the typesetter or EP 308 are found in 
Chapter 4: System Set Up, of this manual. 

Introduction 7 



Introducing Compose 

About This Manual 
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With Cg Compose 2 you can merge text with all kinds of drawings, such as 
organization charts, diagrams, flowcharts, and graphics for slide presentations. 
You can assemble page layouts for reports, brochures, pamphlets, and small 
newspaper productions. The page on your Personal Composition System screen 
is displayed as it will appear on the printed page. 

Compose (Cg Compose 2) can assist you in communicating information with 
professional looking graphics. It is a tool that makes it easy to merge text with 
figures. After you copy and paste in information from other document tools, you 
Compose them so they can be output on a typesetter or EP 308. You use the 
mouse to produce compartments for text, create rules, and move information 
around on the screen. Text can be added in your choice of size and style to 
complete the page. 

This manual contains three approaches for learning to use Compose: 

• Chapter 1: Learning Cg Compose 2, gives you practice with the basic skills of 
Compose by taking you step by step through a typical example. 

• Chapter 2: Using Cg Compose 2, contains detailed instructions for 
performing specific tasks with Compose. This Chapter'is also a step-by-step 
guide. It includes three sample jobs that demonstrate how to apply Compose 
efficiently and effectively. 

• Chapter 3: Cg Compose 2 Reference, summarizes the functions of Compose 
menus and menu items. It covers how each menu item and dialog box works. 

Chapters 4 through 8 of this manual contain reference information about specific 
procedures to set up and operate your Personal Composition System. Chapter 4: 
System Set up, contains preventive maintenance, dilly operating procedures, and 
trouble shooting information that will be of specific help to all Personal 
Composition System users. Chapter 5 covers installing fonts on to the System. 
You may only need to use the information in this chapter when you first purchase 
your fonts. Some of the chapters may refer to the configuration of equipment that 
is not part of your system. 

Each Chapter begins with a table of contents so you can look up different topics 
easily. If you can't fmd what you need in the table of contents, check the index at 
the end of this manual. The index lists many topics in several ways to help you 
find the information you are looking for-even if your not sure what it's called. 

CgCompose2 
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Introduction 

Have you gone through 
LisaGuide? 

What You'll Need To Get 
Started 

Seeing What's 
On A Disk 

This Chapter gives you actual hands-on experience with Compose. By going step­
by-step through an easy example, you will become familiar with the basic 
Compose operations. Use this example to experiment with each menu item. Try 
out several ways to change the text with each new function you learn. Use this 
time to gain experience and understanding of how Compose works. 

It's OK if your screen is a little different than the pictures in the manual, 
especially if you are developing confidence in using the tool. After completing 
this chapter you will be able to create, edit, store, and print Compose documents. 

The material in this manual assumes that you have gone through LisaGuide, 
which teaches you the fundamentals of using the Lisa. The LisaGuide diskette 
comes in the Lisa 717 package. Instructions for using LisaGuide appear in Chapter 
1 of the Lisa Office System manual. Important background information about 
the desktop is found in Chapter 2 of that manual. Make sure you understand the 
concepts in that section before going on with this manual. 

1 A Personal Composition System set up and plugged in. 

2 The Disk set up with Lisa Office System and tools, Compugraphic fonts, and 
Cg Compose 2 software installed. 

3 The system turned on. 

4 A basic understanding of tool operations, especially LisaDraw and LisaWrite. 

5 About 45 minutes. 

Note: If Your System is not set up, or if you need to install tbe Cg Compose 2 tool, tbe Cg 
Compose 2 Examples Folder, or tbe Cg Compose 2 Software, see Cbapter 4 System Set Up, 
in tbis manual. 

To get the document you'll work with, you first need to have a duplicate of the 
Examples Folder copied on your Disk. An explanation of how to duplicate the 
folder is in Chapter 4. Open the Disk icon as described in the steps below. The 
icon you will open may be called the ProFile, Internal Hard Disk, Disk, or you 
may have already named it something else. When you open the Disk you access 
information stored on the hard disk. 

The way you open the Disk will illustrate the most general principle of your 
Personal Composition System: 

• First you select something . 

• Then you do something to what you've selected. 

Chapter 1: Learning Cg Compose 2 11 



To Open the Disk Icon 

12 

1 Select (highlight) the Disk icon by placing the tip of the pointer on it and 
clicking the mouse button. (Icon not highlighted? Try again.) 

2 To open the Disk icon, choose Open "Disk" from the File/Print menu. 

~ Press and hold down the mouse button with the tip of the pointer on 
File/Print in the menu bar. 

~ Move the pointer down and release when Open "Disk" is highlighted. (Is the 
Open menu item dim? You probably clicked somewhere else on the gray part 
of the screen and deselected the Disk icon. Go back to step 1 and make sure 
the Disk icon is selected.) 

Edit Housek 
Set Hside !'.vel'!jt.hinfJ 
Set nsidt,~ 

••• 
Duplicate 'I ItO 
'f en!' OH Stnti(mel'!l 
MnKe stnt:iom?I'!! P(l() 

Monitor the Printer ••• 

3 Notice the Disk window zooms open on your Lisa's desktop. Your Disk is like 
a very large file drawer-it's where you 'II perform most of your work. 

r- Desk file/Print Edit 

~ m ~ LJ ~ ~ 
LisaWrite Paper LisaDraw Paper lisaTerminal Paper Cg Compose 2 E~amples Lisaproject Paper 

lliJ ~ II . :: LJ 
LisaCalc paper LisaLis! Piper LisiGraph Paper cg Compose 2 Paper Empty folders 
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Opening a Document 

To Open the Compose 
Examples Folder 

Inside the Disk window you should see several stationery pads and folders. The 
Compose Examples folder contains the example you'll be working on here. In 
the steps below, you will: 

• Open the Compose Examples folder. 

• Tear off a sheet from the Getting Started stationery pad. 

• Move the new sheet, or document, to a clear spot in the folder. 

• Give the new document the name Annual Report. 

• Open the document. 

1 Select the Compose Examples folder by clicking on it. 

2 Choose Open Compose Examples from the FilelPrint menu. 

Notice the window to the Compose Examples folder and its contents zooms 
open, as shown. In the folder one of the icons is a stationery pad that has column 
patterns to indicate it is a Compose icon. This Stationery pad is entitled Getting 
Started. It contains an example document you will use to learn Cg Compose 2. 

,.. Desk File/Print Edit 

~ m [t!J • ~ 
LisaWrite Paper LisaDraw Paper LisaTerminal Paper Cg compose 2 Examples LisaProjec\ Paper 

II ffiI ~ II L:J 
LisaCalC paper LisaList Paper Lisa Graph Paper cg compose 2 Paper Empl~ Folders 

Chapter 1: Learning Cg Compose 2 
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To Tear off Stationery 

To Rename the 
New Document 

1 Select the Getting Started stationery pad icon. 

2 Choose Tear Off Stationery from the File/Print menu and wait a moment 
until the new document appears, as shown. 

3 Move the new icon out of the way to a clear spot in the folder: 

... Place the pointer on the icon. 

... Press and hold down the mouse button and move the icon as shown . 

... Release the mouse button. 

1 Make sure the new document icon is still selected (highlighted). If you've 
deselected the icon by clicking elsewhere on the screen, select it again by 
clicking on it once. 

2 Type the name Annual Report. (Typing mistake? Use the IBackspacelkey to 
correct it.) 

,.. Desk File/Print Edit 

~ m ~ II ~ 
lisaWrite Paper lisa Draw Paper lisaTerminal Paper Cg Compose 2 Examples lisaProject Paper 

lliJ ~ iD == L:J 
Lisacalc paper LisaList paper LisaGraph Paper Cg compose 2 paper Empty Folders 
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To Open the 
Annual Report 

rulers 

compartment with text 

1 Make sure the document icon is selected (highlighted). 

2 Choose Open ''Annual Report" from the File/Print menu. 

Notice how the icon zooms open into a window. Wait a minute-the hourglass 
means wait-until the Compose tool displays the Annual Report document. 

The Compose document is made up of several items that may be new to you. 
Study the Annual Report document below before going to work on it. 

.. ..... : ........... : ........... : ......... : : 

... : ........... : ....................... ~.. .. . ... .. ............ i "..... .. ............. ~ ............................................... : .. 
............... : ........... ; ........... :. 

galley with a figure J.~I-.:;k~~==~===:=~~ i ~ 

pasted on it •••••••• D~i 

galley with text 

Compose Document The Annual Report document is now open on your desktop. 

Across the menu bar at the top of the screen are the Compose menu names. Each 
menu contains a list of actions you can use in a Compose document. 

The Compose tool combines the writing and text editing features of Lisa Write 
with the drawing capabilities of LisaDraw. Text, spreadsheets, lists, drawings, and 
other graphics can be cut or copied from other Lisa tools and stored ongaUeys 
that are created at the bottom of the Compose window. 

Compose is a paste-up tool for assembling text and graphics. The most efficient 
way to work is to perform the major editing in the source tools, and assemble the 
final page in Compose for the typesetter or printer. A page layout is accomplished 
by drawing compartments in the Compose document and then filling the 
compartments with text and figures from the galley. Compartments can be varied 
in size. They can be individually styled for a page, or you can select to repeat the 
same layout for each page of the document. When a graphic is placed into a 
compartment, the text will automatically indent to run around the graphic. 

Chapter 1: learning Cg Compose 2 15 
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Practice with 
Compose 

Once the page layout is displayed the way that you want it, you may choose to 
accept the page from the Edit menu. This prohibits any changes to that page 
unless you choose to edit it again from the Edit menu. 

When possible you should make stationery pads out of your most commonly 
used page layouts and store them on micro diskettes. This will greatly reduce 
your production time and minimize the time you will have to spend setting up 
your documents. 

Without pressing the mouse button, move the pointer around the screen and 
notice that it is shaped like an arrow. In Compose this is how it appears when you 
move compartments and galleys and select menu items. 

You will see other kinds of pointers as you go through Getting Started. To enter 
text into a compartment you will create a the text insertion point by placing the 
change pointer into the compartment, holding down the~key, and clicking 
the mouse button. The shape of the pointer changes to a drawing symbol when 
you draw a rule or choose Make A Compartment from the Page Layout menu. 

Imagine you work for a fictional company called Switch-On Communications, 
Inc. You will put the finishing touches on last year's Annual Report for the big 
annual meeting. 

Text for the Annual Report has been written, edited, and copied as a LisaWrite 
document. A galley has been created at the bottom of the Compose document on 
your screen, and the text has been pasted on it through the clipboard. 

Two graphs and the company logo have been completed in LisaDraw and copied 
onto three other galleys at the bottom of the Compose document. You will 
assemble these components into the Annual Report. 

In the next several pages you will learn to: 

• Make compartments. 

• Move a figure to a page. 

• Format text in a galley. 

• Merge text from the galley into a compartment. 

• Enter text into a compartment. 

• Change the typestyle of text. 

• Kern text. 

• Cut unwanted material from the text. 

CgCompose2 



• Insert a rule into the report. 

• Change the Composition Defaults. 

• Use Verticaljusification. 

• Make a Space Block. 

• Insert Word Breaks. 

• Make a Header and Footer 

• Insert a page number. 

• Accept a page. 

• Design a new page. 

• Align and Match 

• Set Tabs 

• Output the report on an ImageWriter 

• Output the report on a Typesetter or EP 308. 

• Change the selected printer 

• Put Your Document Away. 

When you are finished, the first page of your report will look like the three pages 
tht follow. If you should have trouble with one of the steps as you go through the 
example, try comparing the Annual Report document on the screen with the 
finished pages. 

Chapter 1: Learning Cg Compose 2 17 



18 

The Annual Report 
Page 1 

SWITCH-ON COMMUNICATIONS 
Annual Report 

To The Shareholders: 

During fiscal 1984, operating results at 
Switch-On Communications were substan­
tially improved and the Company's financial 
position was significantly strengthened. The 
return to profitability in 1984 was the result 
of the successful completion of four major 

and compatibility. A computer that performs 
one kind of information processing very often 
will not perform another, and even computers 
of similar design and function often will not 
communicate with each other. The Company 
met this need with new software and hardware 
products. 

corporate initiatives: ,-______________ ---, Software 

Comparison of Costs vs Revenues 
1984 was the year 

the Software Products 
Division began full 
scale marketing and 

Profits on the Rise 

In Millions of Dollars Revenues manufucturing. When 

• The introduction of a 
number of options and en­
hancements for the new 
Switch-On Teleport Pro­
ducts (STEP Tm). 

300 ,----------, D it was formed in 1981, 
we projected that it 

• The improvement of 
productivity through cost 
reduction programs, con­
solidation of operations 
and more efficient use of 
personnel and facilities. 

• The improvement of the 
corporate financial posi­
tion through the purchase 
of two component supply 
houses that were respon­
sible for 75 % of our 
finished product costs. 

• The improvement of 
office communications us­
ing a Personal Composi­
tion System. 

200 

100 

o 
1982 1983 1984 

Fiscal Year 

II1II 

Costs would develop, license 
and sell telephone and 
communication 
products for systems. 
This year, our plans 
reached fruition when 
the division began to 
manufucture and deliv­
er the new Memory 
Re-Dial Option for 
STEP Systems. 

Hardware 
The company has 

developed important 
hardware compatibili­
ty enhancements as 

New Options 
well. This year, for 

'------------------' example, the STEP 

Throughout 1984, we continued to expand 
the number of system configurations for the 
new product, and also to develop and intro­
duce add -on options and enhancements de­
signed to broaden the applications and :he 
price range of this product fiunily. 

Within the business environment, equipment 
can be of limited utility if it lacks versatility 

System's ability to "listen to," or accept, in­
formation from other computers was upgrad­
ed to a two-way, "listen and talk ," to receive 
information from word and data processing 
systems and convert it into typesetting keys­
trokes. It can also transmit information back 
to the orginal workstation for additional edit­
ing. This is called "telecommunications," 
because it can occur over ordinary telephone 

Page 1 
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SWITCH-ON COMMUNICATIONS 
Annual Report 

~
'~. ,linesorbydirectcable . 
: . . . . . : It makes STEP capable 

• ~., S ',.. of complete interaction 
, ,with the multifunction 
: - • networks and systems 
: 0 : in modem businesses. 

'... ......••• ••••. All of the Company's 
telecommunications 

devices are supported by the Communications 
Assistance Center, which expanded its staff 
and resources this year. The center offers na­
tionwide set-up and diagnostic assistance to 
customers with telecommunications. 

Cost Control And Productivity 
During the first half of 1984, our manufac­

turing organization met a steadily accelerat­
ing STEP production schedule while syste­
matically phasing out our obsolete products. 
With the purchase of A -I Radio Supply and 
Eastern Data Bits, we now have direct control 

over the price of the microchips that are used 
in the STEP System. 

Cost Reduction Programs 
The overall proouctivity of our employees 

has improved as a result of the hiring freeze 
and reduction of the work force. It has be­
come apparent that our new company motto 
"Get Serious Or Get Out" has indeed been 
taken seriously. With this new program, each 
employee's salary will correspond directly to 
the meeting of department objectives. 

Inter-Office Communication 
The communication requirements to meet 

department objectives have been satisfied by 
the purchase of Personal Composition Sys­
terns for each department. The reduction of 
typing, filing and copying activities has 
increased the amount of time available for 
project goals and customer problems. The 
economy of typeset communications has 

Employee Productivity 
We're Getting Serious 

Hundreds No of Employees 
5000 D 

4000 Average salary .. 
3000 Units Produced 

2000 EJ 

1000 

0 

1982 1983 1984 

Fiscal Year 
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The Annual Report 
Page 3 

SWITCH-ON COMMUNICATIONS 
Annual Report 

~
:~.: proven itself. Our cus-
: . . . . . ' tomers have responded 
• ~.: S ':-: positively to the profes-
: : sional approach of our 
: - : fiscal 1984 "Are You 
• 0 • Really Satisfied" cam-
: '. . .... 'paign. The concept 
: . ....... : was bold and unortho-
.... ...... .................. dox; but backed up 

with the excellent brochure and return ques­
tionnaire, response was an incredible 54 % re­
turn by customers. The graph on the preced­
ing page shows the increase of productivity, 
performance and income. 

Market reception to the STEP System and 
its growing number of options and upgrades 
has been quite favorable. The underlying po­
pularity and programmability features of this 
line of systems give our customers the latest 
communication capabilities. Yet STEP Sys­
tems are sufficiently flexible to allow up-

grades and system expansion when we deve­
lop new capabilities or when the customer's 
needs change. This versatile system is the 
foundation to our continued growth. 

Total Number of Units 

1983 1984 

Hardware ... 240 ....... 320 

Software .... 150 ....... 850 

Support ..... 57.. .. ... 980 

Page 3 
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Making A Compartment The Annual Report requires finishing touches. To layout your page you must 
make compartments. Compartments control the position of the text on the page. 
You make a compartment by drawing a rectangle, just like in LisaDraw. 

1 Choose Make a Compartment from the Page Layout menu. Notice how the 
pointer changes to a drawing pointer when the menu item is chosen. 

2 Use the pointer to draw the compartment beginning 1 Y2 inches from the top 
of the page, and 1 inch from the left side of the page. Draw the compartment 
to the 4 inch mark on the top margin ruler and down to the 9 Y2 inch mark 
on the side, page ruler. 

~ Place the pointer where the upper-left corner of the compartment will be 
located (see the figure). 

~ Press and hold down the mouse button as you move the pointer down to the 
9 V2 inch mark and to the right to the 4 inch mark. A box will appear. 

~ Release the mouse button when you reach the correct size. 

,.. Desk File/Print Edit Type Style Fonts Format 1f Page layout Arrangemert 

EI • . .,. 

L I 11 I I I 21 I I I 31 I I I I 4 I I I sl I I I I ~ I I i I I ~ ~ 
-. • .....•........... ['SWITCB='ON'''COlBlUNlCATIQNSn'l' ....•.. m; 

J-= .. : . . ...!, ~ : m _: ,H;:~.~ .. ; 
_ . ~. __ u ••••••• _. __ •• __ •• _._ •• _ •• _ •••••••• _ ••••••••• _ •• _ ••••• ___ ••• __ ... _ ••• ___ ••• _. ____ ~--.-...J. .. 

_ ...... !' .. ---.--.-..... --.---.~ ..... -.--. .a.-••.. --.. -~.-.... ------_ ... _---", .. 

- i i 
2: j : 

=-- "'Hi i 
- . ~ + 
-. "j : .. 

- . 1 1 
j : . . \J 

L ....... j i ... ~ 

~ To The ShaIeholdelS: 
4J! The company has made great strides in IJ 

101m 
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Duplicating 
a Compartment 

Aligning Compartments 

22 

The text for the report will be set in dual columns so the compartment that you 
just made must be duplicated and the new compartment must be placed correctly 
on the page. Follow the steps below to duplicate the compartment and position it 
on the right side of the page. 

I With the compartment selected, choose Duplicate from the Edit menu. (Pull 
down the menu, point to the menu item, and release the mouse button.) 

2 Place the duplicate compartment 4lh inches from the left margin. Align the 
top edges of both compartments. (Box not in the right spot? Place the pointer 
into the box and move it into position.) 

If you have trouble aligning the top edges of the compartments, you may choose 
a menu item to help you. Notice what happens when you select a compartment. 
Handles appear on the edge of the drawing, showing that it's selected. You can 
change the shape of the compartment by selecting and moving the handles. You 
may choose more than one compartment at a time by holding down the IShiftl 
key as you select another compartment. 

I Press down and hold the IShiftl key and select both compartments. 

~ Place the pointer on a compartment. 

~ Click the mouse button as you continue holding down the IShiftl key. 

~ Select the other compartment. 

2 Choose Align Objects ... from the Arrangement menu. 

3 Choose Align ... Tops from the dialog box that appears . 

...... ", ......... " ........ ". 
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Locking In Place 

Moving a Figure 
to the Page 

You will find that it is easier to work with compartments if they are locked to the 
page. Then you will not accidentally move them around when you are trying to 
perform other functions. 

1 With both compartments still selected choose Lock in Place from the 
Arrangement menu. You will notice that this places a check mark in front of 
the item on the menu. If you were to select the menu item again, the check 
mark would be removed and you could again move the compartments. 

'::, n ;" 

Bring To Front 
--------~ ~~&d 

._------1 Repeat on all Pages 

AU", IJljeds ... 

Shade IJljeds ... 

The galley is the mechanism for entering documents into Compose. A figure can 
be copied from LisaDraw, LisaProject, or Lisa Graph and pasted onto a galley. It 
will remain on the galley until you merge it into the Compose document. You 
will take the graphic from the galley and move it into the Annual Report. It can be 
placed anywhere on the page. The most dramatic position will be to place it in 
the middle of the page so it slightly overlaps both columns of text. 

1 You may change the rulers to help you with your layout. 

~ Choose Customize Rulers ... from the Page Layout menu. 

~ Choose Adjustable Zero-Point: On from the dialog box that appears. 

~ ChooseOK. 

~ Click the mouse button on the 41,4 inch mark on the ruler. Notice that the 
ruler now displays a 0 (zero). This will help in centering the graph figure. 

Chapter 1: Learning Cg Compose 2 23 



Formatting Text in a Galley 
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2 Move the graph figure from the galley to the page. 

~ Place the pointer in the upper left corner of the galley with the graph. Press 
and hold down the mouse button to select it. 

~ Move the pointer to drag the galley onto the page. Release the mouse button 
when the figure is centered between the compartments. The upper left 
corner will be positioned automatically where the mouse button was 
released. You may move it around by selecting it. 

Note: The figure should be correctly sized before it is brought into Compose. You can not 
change the size or content of a figure after it has been pasted on a Compose galley. 

Text that is created in LisaWrite, LisaCalc, and LisaList can be copied and pasted 
into a Compose document by placing it first in a galley. While it is being stored in 
the galley you may change the typestyle, point size, and compress the text by 
adding character compensation or kerning. By applying these format attributes 
to text when it is in the galley you can determine how it will appear before it is 
placed into a compartment. You can always select blocks of text on the page and 
change them after you have merged it into Compartments. 

1 Select the galley that contains two lines of text by placing the pointer on it 
and clicking the mouse button. 
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Linking Compartments 

2 Choose Change Fonts in Galley from the Fonts menu. Select the following 
items to format the text: 

~ Change from Apple Classic 

~ 12 point 

~ Change to Cg Times 

~ With a point size of: 12 

~ Kerning: Text 

~ Character Compensation: Book 

3 Click OK. The text on the galley will now change. 

,.. Desk Fllt!lPrlnt Edit 

Change Fonts in Galley ... 
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o 8 pt,20 pitch 

08 pt,15 pitch 

Change To: 

DIlRUSIt 

o AOCKliELL lID IT 

DlIIll.I1VIM~IIDIT 
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o 10 pt,12 pitch 

o 12 pt,10 pitch 

o ROCKVELL I'D 

o IIIILIIVIMTE 

• co TIlE! 

o co MGA 

It1th point size of: f1il 
L..-J 

Kerning: 0 off • text 0 dl!slgner 

Format If PaQI! Layout Rrr~ 

( (anrel ) 
• Apple a.ASSI( 

.12 point o 18 point 

014 point 024 point 

( (IeIII' Entry J 

o ROCKWELL I'D IT DROCKIIfLLIID 

o TRIL!tVIMTE IT o TRILllVIMTE lID 

o co TIlE! ITALIC o co TIIEI BOLD 

Charlll±er (OII1M!flSIItion: 0 none • book set 0 ad set 0 tight set 

I 

The text that has been pasted into the galley area can be moved into the 
compartments after you establish the way you want the compartments to be 
linked. By linking compartments, text will fill the one compartment and then 
begin filling the next in the order that you link them together. The line length of 
the text will become the same width as the compartment. If the size of the 
compartment is changed at any time, the text will recompose through all of the 
compartments that are linked together. 
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Merging Text into 
Compartments 

1 Create a galley at the bottom of the Compose document. 

~ Place the pointer in an open space in the lower part of the document. 

~ Draw a rectangle at least 1 inch by 1 inch. 

2 Drag the galley into the compartment at the top left side of the page. 

~ Place the pointer on the empty compartment. Press down and hold the 
mouse button. 

~ Move the pointer to the compartment on the left side of the page and release 
the mouse button. 

~ Select the galley again. This time move it to the right compartment and 
release the mouse button. These two compartments are now linked so that 
text will flow from left to right. Changes in the size or content in one of the 
compartments will ripple through both of them to keep them full . 

... 

1 Select the galley that shows text on the top two lines by placing the pointer on 
it. Press and hold down the mouse button. Drag the galley up to the first 
compartment that you made and release the mouse button. 

2 As you watch the compartment, text will flow from the galley into it. Once 
the compartment is full text will begin to fill the second compartment on the 
right, because it is linked with the left one. 
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Entering Text Into A 
Compartment 

Changing Typestyle 

3 Choose Save and Continue from the File/Print menu. Then if you want to 
come back to this arrangement of your document, you can choose Revert to 
Previous Version. 

To work on any text that is in a compartment you must use the ~ key before 
you perform an operation. Otherwise, you will only select the compartment that 
holds the text. In the next few pages you will make use of this principle. First, 
you will add to the title of your document. 

1 To select an insertion point. 

~ Press down and hold the ~ key. 

~ Place the pointer at the end of the title after the "s" in COMMUNICATIONS. 

~ Press down, then release the mouse button, and the ~ key 

~ The pointer will become a blinking insertion mark. 

2 Type the text you want to enter. 

~ IReturnl 

~ Annual Report 

To change the typestyle of the text, you will work as you do in any of the other 
Lisa tools, except you will use the ~key. Change the typestyle of the first 
sentence to make it a subtitle by following the instructions on the next page. 
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Kerning Text 
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1 First select the text. 

~ Press down and hold the ~key. 

~ Place the pointer in front of the "T" in To the Shareholders:. 

~ Press down and hold the mouse button. 

~ Drag the pointer through the colon":" at the end ofthe sentence. 

2 Choose Cg Times Bd It (Bold Italic) from the Fonts menu. 

Note: Tbis text assumes tbat you bave tbe true fonts Cg Times Bold and Cg Times Bold Italic. 
You sbould use tbe true fonts wben tbey are available. You may use tbe pseudo Bold and Italic 
from the 'IJlpstyle menu if you do not have the true fonts. 

3 Choose Other Cg Pt. Size ... from the Typestyle menu. 

4 Type: 14 point in the dialog box that appears. Click OK. 

To kern the report title (remove extra white space from certain letter pairs), you 
will select all of the title and apply designer kerning. (If you do not have Designer 
Kerning, choose Text) 

1 Select all of the text in the title. 

~ Press and hold down the ~key. 

~ Place the pointer in front of the "S" in SWITCH-ON COMMUNICATIONS 
Annual Report. 
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Cutting Text 

~ Press and hold down the mouse button. 

~ Drag the pointer through the text. 

~ Release the mouse button. 

2 Choose Compress Text from the Format 1 menu. 

3 Choose Designer from the dialog box that appears. Click OK. 

... 

To cut the first sentence of the Annual Report, The Company made great strides 
in fiscal 1984, you must also use the~key. 

1 Press and hold down the~key. 

2 To select the entire first sentence of the Annual Report, press the mouse 
button before the "T" in The and release after the" . "at the end of the 
sentence. It will highlight when selected. 

If you have trouble selecting the sentence, remember to hold the ~ key 
before each attempt. If you did not lock the compartment to the page, you may 
accidently move the entire compartment. If so choose Undo "Move 
Fig./Comp." (the last change) from the Edit Menu and try again. 

4 Choose Cut from the Edit menu when the entire sentence and the space up to 
the next sentence is highlighted. 

Cutting something will place it on the clipboard. If you don't want to save the 
text, it is faster to select the text and press the IBackspacel key on the keyboard. 
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Inserting Rules 

30 

Next you need to place rules (lines) on the page to set off the title from the rest of 
the text. A rule is placed in a document the same way that a line is made in 
LisaDraw. 

1 Activate the rule size you will draw by selecting 2.0 pt. Rule from the Page 
Layout menu. 

2 Move the pointer on to the page below the compartment that contains the 
title SWITCH-ON COMMUNICATIONS. Place the pointer at the far left side of 
the page and begin the rule at the left edge of the text compartment. 

3 Press the mouse button and move the pointer horizontally across the page. 

4 Release the mouse when the rule is at the edge of the right compartment. 

Note: Notice how handles appear on ends of the line. The length can be changed by moving one 
of the handles. The position can be changed by placing the pointer on the line between the 
handles, pressing down the mouse button and dragging the rule. 

,.. Desk FllelPrlnt Edit T 
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Changing Composition 
Defaults 

Text is positioned on the page by information that is entered in the Composition 
Defaults dialog box in the Edit menu. Word, letter and line spacing, 
hyphenation, and several other features are controlled by checking or pointing to 
items in the box. The defaults that you set will apply to an entire page of the 
document. After you become familiar with positioning text on the whole page 
with Composition Defaults, you will learn how to manipulate the location of 
individual lines and paragraphs of text. 

1 Choose Save and Continue from the File/Print menu. 

2 Choose Composition Defaults from the Edit Menu. 

3 In the Line Spacing item choose 1. This will make the line spacing tighter. 

4 In the Word Spacing item move both the Pref pointer and the pointer on the 
right of the matrix to the left. This will close the space between words as text 
is justified on a line. 

5 In the Point Sizes item, replace the 36 with the number 14. The 14 will now 
show in the last position on the 1)rpestyle menu. Choose OK to bring your 
document back to the screen and see the changes. 

Note: 7ry other settings and see how the text is displayed on the page. When you select the box 
Set Compugraphic Defaults at the lower left of the dialog box the settings will revert to the 
automatic defaults. 

r' Desk FIII!/Prltt Edit 1i II! Forts FIII1IIIII: U P 
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Using Vertical Justification 
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If you want to change the line spacing of selected amounts of text on the page, 
you can manipulate the vertical justification. This can be done over a few lines 
or over an entire compartment of text. 

1 First you must select the text. Select the section of text on the left side of the 
graph. Select all of the paragraphs that begin with (.) bullets. 

• Place the pointer in front of the first bullet. 

• Press and hold down the ~key. 

• Press and hold down the mouse button as you drag the pointer through the 
text. The amount of text can be two or more lines. In this case select the text 
through the end of the word System. 

2 Choose Set Vertical Justification from the Format Text menu. Small arrows 
will appear on the page ruler pointing to the top and bottom of the selected 
text. 

3 Select the bottom arrow and pull it upward about 1f.I inch on the ruler. Gray 
dotted lines will connect the arrows with the selected text. The text will 
compress and you will see less space between each line. 
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Making a Space Block 

Final Editing 

You can add extra line space between paragraphs by making a space block at the 
end of a paragraph. 

1 To make a space block you must place an insertion point at the end of 
sentence on a paragraph return. 

~ Place the pointer after the: colon at the end of the first paragraph. 

~ Press and hold down the ~key. 

~ Click the the mouse button. 

2 Choose Make Space Block from the Format Text menu. A double line will 
appear in the text between the paragraphs. 

3 Scroll through the document and put a space block between each paragraph 
and subheading. Tme space block can be made larger by holding down the 
~ key, selecting the bottom line of the space block, and pulling it 
downward. If you accidently move the compartment while you are selecting 
an insertion point, you can always choose to Undo"Move Fig.lComp." from 
the Edit menu. 

As you go through the text adding space blocks, you can put the finishing touches 
on this page before you make the next page. You should change each subheading 
and improve the hyphenation if line endings are unsatisfactory. 

~ Choose Cg Times Bold and 14 point type for each of the subheadings: New 
Options, Software, Hardware 

~ To learn more about changing the line endings, look at the next section on 
word breaks before you go through and edit the page. 
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Inserting Word Breaks In some cases you may want to change the hyphenation that occurs 
automatically. You can insert a word break manually to change the automatic 
hyphenation of a particular line. You can turn off the automatic hyphenation for 
the whole page in the Composition Defaults dialog box. 

1 As you scroll through the Annual Report look at each line and choose a 
hyphenated word, or a sentence that has a large gap and could be improved if 
a hyphen were placed differently. Because there are so many factors that 
determine line endings, it will be difficult to say where the unstisfactory word 
breaks may be in your Annual Report. Place an insertion point at another 
place in the word where it might be better to make the hyphen. 

~ Press down and hold the ~key. 

~ Click the mouse button. 

2 Choose Insert Word Break from the Format Text menu. The word will now 
hyphenate where you have chosen. There are certain limits to how much you 
can change the hyphenation. The control you have over these limits is in the 
word and letter space settings that you make in the Composition Defaults. If 
you choose to allow more word and letter space, you have a wider range of 
control. If you do not want a word to hyphenate, you may place a word break 
before or after a word. If the entire word will fit on the line, the word will not be 
hyphenated. 

3 To remove the word breaks you've inserted, choose Delete Word Break 
from the Edit menu. 
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Making A Header 

Making A Footer 

Thus far we have been working with a one page document. In the next few pages 
you will learn how to carry the page design through a longer document. A header 
will carry the title and the rule to all other pages of the document. 

1 Select the compartment that contains the title by placing the pointer on it and 
clicking the mouse button. 

2 Press and hold the Shift key. 

3 Select the rule so that both the compartment and the rule are highlighted at 
the same time. 

4 Choose Repeat on all Pages from the Arrangement menu. 

The objects will now appear on each page of the document. 

r- Desk FilelPrint Edit Fonts Format 

IIIIII Annual Report IIIIII Bring To Front 
Send To Back 

Group Db jects 

At the bottom of the page you can place a footer that will appear on all pages of 
your document. Next to the footer compartment you can insert a page number 
that will increase by one on each page. 

1 Scroll to the bottom of the page and draw a compartment in the middle of the 
page about V2 inch wide and V2 inch deep. 

~ Choose Make a Compartment from the Page Layout menu. 

~ Draw the rectangle as shown in the figure on the next page. 
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Inserting Page Number 
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2 Insert the word Page into the compartment by placing the pointer in the 
compartment, pressing down the ~ key, and clicking the mouse button. 
A blinking insertion point will appear. Type the word Page. 

3 To format the footer 

~ choose Right from the Format Text menu. 

~ Choose Cg Times Bold from the Fonts menu. 

~ Choose 18 point from the Typestyle menu. 

4 Select the Page compartment and choose Repeat on all Pages from the 
Arrangement menu. 

A page number can be inserted anywhere on the page except in a compartment. 
Once a page number is inserted on a page, it will repeat on all pages and appear in 
the same place on subsequent pages. 

1 Click to place an insertion mark to the right of the Page compartment you 
just made. 

2 Choose Insert Page Number from the Page Layout menu. 

3 While the unique page number compartment is still highlighted, choose Cg 
Times Bold from the Fonts menu. 

~ Choose 18 point from the Typestyle menu. 

r Desk Edit Fonts Format 
ill I i Rnnua I Repor t ',II 
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Accept and 
Design a Page 

Page 2 Layout 

Once you have finished working on a page you must accept it to be able to work 
on the next page. 

1 Choose Accept page 1 from the Edit menu. The grid lines will disappear. 

2 Choose Design Page from the Page Layout menu. When the dialog box 
appears, choose Style next page" like last page. Click OK. This will draw 
compartments in the same position as the first page. You will automatically 
scroll to the next page. 

,. Desk flll!lPrlrt Edit T II! forts fDmllll: If pagr 
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3 The compartments and text of the repeating header and footer, including the 
page number 2 will appear on the page. Click on the page to activate it. 

You will perform work on page 2 as you did on the first page. You will arrange 
the compartments and figures. Then you will pour text from the galley into the 
compartments. Finally you will scroll through and edit the page placing space 
blocks, making the subheadings bold, and inserting other editing touches to 
finish up the page. 

1 A graph will be placed at the bottom of the page that will occupy 
approximately one third of the page. 

~ Press the view control at the very bottom right of the Compose document. 
There you will find another figure that has been pasted onto a galley. It is the 
graph that will be placed on the page 2. 
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~ Scroll down so that you can see the 6 inch mark on the side page ruler. 

~ Select the galley by placing the pointer in the upper left corner. 

~ Press and hold down the mouse button. 

~ Drag the galley to the far left side of the page just outside the left text column 
about 5 Y2 inches down from the top of the page and release the mouse 
button. Center the figure on the page. The lower line in the figure should be 
even with bottom of the compartments. 

2 In the galley area you will see the company logo. It is a small figure with an 
S/O on it. You will place the logo in the upper left corner of this page, and 
format it to repeat on the remaining pages. 

~ Place the pointer in the upper left corner of the figure. Press and hold down 
the mouse button. Drag the figure to the upper left corner of the 
compartment on the page. When the pointer is on the corner, release the 
mouse button. 

~ Choose Repeat on all Pages from the Arrangement menu. You will see the 
figure when you design the next page. 
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3 Take the text galley and place it in the left compartment. 

~ Place the pointer on the galley. 

~ Press and hold the mouse button. 

~ Drag the galley into the compartment and release the mouse button. 

4 Scroll through the text and edit it like the first page. 

~ Place Space Blocks at the end of each paragraph. 

~ Choose Cg Times Bold and choose 14 point type for each of the 
subheadings: Cost Control and Productivity, Cost Reduction Programs. 

~ Check the hyphenation and insert word breaks where needed. 

5 After going through this page, you should accept it and begin to design the 
final page. 

~ Choose Accept Page from the Edit menu. 

~ Choose Design Page from the Page Layout menu. 

~ Choose Style and Fill next Page-like last page from the dialog box that 
appears. By selecting this menu item, you will see page 3 with text already 
placed in the compartment on the left side of the page. 
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Page 3 Layout 

Setting Tabs 
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The third page will have two short columns with a table placed at the end of the 
text. You will go to the bottom of the third page and make the compartments 
smaller by dragging them up the page. 

1 Scroll to the bottom of the page. 

2 Select both compartments using the IShiftlkey. 

3 Choose Lock in Place from the Arrangement menu. This will remove the 
check mark and unlock the compartments. 

4 Place the pointer on the center handle at the base of one of the compartments. 

~ Press down and hold the mouse button 

~ Drag the bottom of the compartments up to the 5 V2 inch mark on the page. 

One method for organizing a list of numbers is to place them in a table using tab 
stops. In Compose, tabs are inserted into text the same way that they are used in 
LisaWrite. If tabs are already in your LisaWrite source document they will appear 
in Compose. 

Insert the table in the lower part of the right column at the end of the text in the 
compartment. 

~ Place the pointer into the compartment. 

~ Press down and hold the ~ key. 

~ Click the mouse button. You will see a blinking insertion point where you can 
begin to enter text. 

2 Press the IReturnl key twice. 

3 You will enter text in Cg Times Bold 18 point. 

~ Choose Cg 18 point from the Typestyle menu. 

~ Choose Cg Times Bold from the Fonts menu. 

~ Type: Total Number of Units. 

~ Press [RetUm]IReturnIIReturnl. 

4 Choose Show Rulers from the Page Layout menu. 
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5 To set up the first tab stop. 

~ Place the pointer on the ruler at the 2 inch mark. Click the mouse button. 

~ Choose Set Centered Tab from the Format' menu. 

~ Choose Set Tab Fill from the Format' menu. 

~ Place a . (period) in the dialog box. Check OK. 

6 To set the second tab stop. 

~ Place the pointer on the ruler at the 1 inch mark. Click the mouse button. 

~ Choose Set Centered Tab from the Format' menu. 

~ Choose Set Tab Fill from the Format' menu. 

~ Place a . (period) in the dialog box. Check OK. 

5 Choose 14 point from the Typestyle menu. 

~ PresslTablType: 1983 

~ Press ITablType: 1984 

~ Press IReturnllReturn~ 

6 Choose Cg Times (This text will be 14 point not bold) 

~ lYpe: Hardware 

~ Press the ITabl key. 

~ Type: 240 ~ 320 

~ Press IReturnllReturnl. 

7 lYpe: Software 

~ Press the ITabl key. 

~ lYpe:150 ~ 850 

~ Press [RetUm]IReturn~ 

8 Type: Support 

~ Press the ITabl key 

~ Type: 57 ITabl 980 

9 To emphasize the information in the table, place a 1.0 point rule above and 
below it on the page. 

~ Choose 1 pt. Rule from the Page Layout menu 
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~ Place the pointer on the left side of the left compartment above the dates and 
draw the rule to the right side of the compartment. 

~ Release the mouse button 

~ Click the mouse on a blank place on the page. 

~ Follow the same proceedure to place a rule below the table. 

BI3 1984 

lBudalNil ••• 240 ....... 320 

~_ .... 150 ....... 850 

.... ST ....... !180 

At this time you have worked through the Annual Report and it is almost ready to 
print. You should scroll to the bottom of the text compartments and adjust them 
so that the last lines in both compartments are the same depth on the page. If 
necessary change the depth of the compartments or use vertical justification to 
make them even. 

You have now composed an Annual Report and used the major functions of the 
tool Cg Compose 2. After printing your document you may want to tear off 
another sheet of paper from the Getting Started stationery pad for more practice, 
or you can go on to the next section, Chapter 2: Using Cg Compose 2, for more 
information about working with documents in Compose. 
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Output On the 
ImageWriter Printer 

For proofing purposes it is a good idea to first print your document on a Dot 
Matrix printer before you send it to the typesetter. Follow the steps below to 
output your document on the ImageWriter printer. If you don't have a Dot Matrix 
printer, skip ahead to a section covering an output device that you do have 
connected to your Personal Composition System. 

1 To be certain that the information displayed on the screen is stored on your 
disk for future retrieval, pull down the File/Print menu and select Save and 
Continue. 

2 To select the device on which you will output your report, you must have that 
device physically connected to your Personal Composition System and have 
the device indicated in the Format for Printer menu. 

3 Choose Format for Printer from the File/Print menu. A dialog box will 
appear to allow format choices. The information in this dialog box must agree 
with choices that you've already made in the Page Size dialog box. You will 
learn more about these choices in Chapter 2, Using Compose. 

4 The title at the top of the page should be Format for ImageWriter Printer­
serial port B. If the title is something else, check New Printer .•. and from the 
dialog box that appears check ImageWriter. 

r Desk 'iI1flml Edit Type Style Fonts· Format 11 
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Printing Quality 
o High Resolution. Low Resolution 

Page layolt Iffangemert 
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~ The Printing orientation should be portrait. This means the person icon is 
straight up and not on it's side. (Landscape printing rotates the image 
90 0 sideways.) 

~ Choose High Resolution for the Printing Quality. 

~ ClickOK 
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5 Select Print from the File/Print menu. The Print dialog box willIet you 
specify some final details concerning the output of your Annual Report. 

~ Check Finished Quality, Fanfold, 1, and All Pages. 

~ Check OK. 

,.. Desk ,., •• Edit Type Style fonts format 11 Page Layout Frrangement .., 

Print on lmagekotiter Printer - serial port B ( [ancel 
• Finished Quality 0 Quick Draft (text only) 

Paper feed 
• Fanfold 0 Single Sheets 

Number of Copies 
.[D000ITJ0[D0~ 

Pages to Print ,._ .... _ ..... _ .............. , , ...... _ ..................... .. 
• All Pages 0 Only pages: L .......................... __ .! Through: L. .............. _ .. ........ J 

....... :.. .~ ............. :.. .... .. .............. ~ ..... . 

If you have trouble printing your document, turn to the ImageWriter printer 
section of the Office System manual for more information. 

Check over the proof copy of your document. Make any needed corrections. You 
may go to a specific page in your document by choosing Go to Page. .. from the 
Edit menu and type the page number into the dialog box. Remember, to edit a 
new page, you must accept the current page on which you are working. Once 
everything is OK you may output your document on the typesetter or EP 308. 

After making the appropriate corrections to your draft, you will output it on the 
typesetter or EP 308 by following the steps listed below. 

1 If you make corrections, save the corrections by choosing Save and 
Continue from the FileIPrint menu. 

2 You must have the Cg Printer connected at Serial A to output on that device. 
You must also have Device Driver software installed through your 
Preferences. Instructions for installing this software are found in Chapter 4 of 
this manual. You must also have the output device listed at the top of the 
Format for Printer dialog box. 

3 Choose Format for Printer from the FileIPrint menu. A dialog box will 
appear to allow for additional format choices. The information in this dialog 
box must agree with choices that you've already made in the Page Size dialog 
box. You will learn more about these choices in Chapter 2: Using Compose. 

CgCompose2 



4 The title at the top of the dialog box should be your finished quality output 
device. Let's assume that device is the EP 308. Then the dialog box should 
read: Format for EP 308 - serial port A. If the title is something else, check 
New Printer ... and check EP 308 from the dialog box that appears. 

Note: If EP 308 is not on tbe list, you must install tbe Device Driver software 

r Desk 'i1Ifl#llll' Edit Type Style Fonts Format If Page Layout Arrangemert 

Format for Compugraphic EP308 - serial port A 

Paper Size 
• Letter (8.5" x 11 ") 
o Legal (8.5" x14") 
o A4 (210 x 297mm)' 
D210mm x 12" 

Printing Orientation 

o El ~ _. c::J' 
( New Printer ... 

, 

~ The Printing orientation should be portrait. This means the person icon is 
straight up and not on it's side. (Landscape printing rotates the image 
90 0 sideways) 

~ The Printing Quality High Resolution is automatically selected for the EP 
308. Click OK 

5 Select Print from the File/Print menu. The Print dialog box will let you 
specify some final details concerning the output of your Annual Report. 

~ For the EP 308 check All Pages, 1 Copy, Pages Collated, Automatic Feed 

r Desk 'i1IfljMl1' Edit Type Style Fonts Format If Page layout Arrangement 
, 

Print on Compugraphic EP30a serial port A Cancel 

Pages to Print 

.AII Pages DOnly pages: Through:, .............................. .. 

Number of Copies 
.ITJ[}]ITlmm[!Jm!il~ 0 Other: l 

[ollation o Pages Collated • Pages Not Collated 

Media Input 
• Automatic Feed 0 Manual Feed 

OK 
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For the 8400 or 8600 '!Ypesetter check Printing Orientation Portrait (click on 
the upright person) 

~ Check Print Quality High Resolution. 

~ Check OK. 
,. Desk W hi Edit· T!II!! Style Format Ir PiII!l.a!pt 

Format for ~aphic 8400 Tpsetter - serial port A 
Paper Size 

• Letter (8.5 x 11 ") o Legal (8.5 x 14") 
DA4 (210 x 297mm) 
D210mm x 12" o Special Paper Size 

Prlrting lKierUl:iOll 

ag 
Printing ~lIb.I 

• High Resolution 0 Low Resolution 

Seardl Spelling 

~. ( New Printer...) CJiCl 
~ To print check All Pages 

~ Check OK. 

,. Desk ..... Edit T!II!! Style Fonts Format Ir Pape Leyout Arranpemert 
Print 011 [arqJlqaphlc 8400 T~ - serial port A 
PI!!!. to Print 

.AII Pages DOnly pages:! IThrough:C""1 

cancel 

II( 

Click twice on the document icon in the upper left corner of your page. Your 
document will take a minute as it is being saved and then it will zoom back into 
the icon form that you saw before you opened it. It will return to the same spot 
where you opened it. 

~ If you have trouble printing and receive an alert message, try to determine 
what is causing the error. Make sure that your device is connected in the 
Preferences, and that the device driver software is also installed. Check all of 
the cable connections and make sure each component of the System is 
powered up and in good operating order. 

This manual has several chapters that can help you with problems. There are also 
specific chapters in the Lisa Office System Manual that can help with various 
aspects of your System's performance. Look in the table of contents or the index 
for the Chapter which seems to best describe your problem. 

~ If you see any other alert message, follow the instructions on the Personal 
Composition System screen. 

~ To learn more about printing, refer to the chapter on your output device. 

CgCompose2 



Chapter 2 

Using Cg Compose 2 



Contents 50 Introduction 

51 The Cg Compose 2 Window 

52 Text and Figures 
52 About Menus 
54 Pointers 
54 Selecting 
55 Compose Paper 
56 The Compose Page 
56 Linking Compartments 
57 Page Size 
57 Group and Lock Objects 
57 Entering And Editing Text 
58 Format Text 
59 Tabs 
60 Page layout 
60 Design Page 
60 Rulers 
61 Scrolling 
63 Output 

Typeset a Memo 64 Making a Stationery Pad 
66 Format a Blank Piece of Stationery 
66 Page Size 
67 Composition Defaults 
68 Default Printer 
68 Making a GaUey 
69 Making Compartments 
69 Entering Text 
71 Copying a Source Document 
72 Pasting a Figure 
72 Making a Rule 
73 Placing Rules 
74 Making a Stationery Pad 
74 Creating a Source Document 
76 Pasting Text onto a GaUey 
77 Changing Fonts 
78 Output Memo on Typesetter 
79 Putting a Document Away 

Prepare a News Release 82 Preparing a Source Document 
83 Making a Compartment 

48 CgCompose2 



Create a Brochure 

84 Matching a Compartment 
85 Establish Compartment Links 
85 Merging Text into Compartments 
86 Changing Linespace 
87 Cut and Paste Text 
87 Changing Fonts 
89 Setting Verticaljustification 
90 Changing Wordbreaks 
90 Inserting Space Blocks 
91 Output Your Document 

93 The Landscape Mode 
94 Editing in the Source Tool 
97 Page Size 
97 Making Compartments 
99 Matching Compartments 
100 Change Fonts in Galley 
101 Meerging Text 
101 Making a Space Block 
103 Placing Rules 
104 Merging Text 
105 Moving Compartments Filled with Text 
106 Placing Compartments Within Compartments 
107 Shading a Compartment 
109 Typeset the Brochure 

Chapter 2: Using Cg Compose 2 49 



Introduction 

Before you Begin 

50 

This Chapter explains Cg Compose 2 concepts, describes the screen, menus, 
pointers and general working environment. It also guides you, step-by-step, 
through several real-life examples. To get the maximum value from the chapter, 
you should tryout the examples on your Personal Composition System as you go 
through it. Major Compose features are covered in the examples. 

A complete description of each Compose operation can be found in Chapter 3: 
Compose 2 Reference in this manual. 

Before you begin this chapter, be sure you have completed the interactive 
LisaGuide, and Chapter 1: Learning Cg Compose 2 in this manual. Chapter 1 
introduces you to Compose Operations. 

To complete this tutorial, you will need: 

• The Cg Compose 2 Stationery paper that is on the Disk. 

• The sample documents in the Examples Folder. 

You should have duplicated the Cg Compose 2 Examples Folder onto the Disk. 
Instructions for this procedure are found in Chapter 4: System Set Up. When you 
have finished learning Compose, you will probably want to throw the Examples 
Folder into the Wastebasket to make room on your Disk. If you need it again, you 
can duplicate the original folder that is on the micro diskette. 

You should understand the following procedures before beginning this chapter: 

• How to move the pointer around the screen using the mouse. 

• How to open menus and choose menu items. 

• How to select text or objects on the screen. 

• How to open and save documents. 

• How to change the size of a window and move it around on the desktop. 

• How to prepare text in LisaWrite. 

• How to make LisaDraw figures. 

• How to copy and paste documents. 

• How to scroll the window to see different parts of the document. -

The arrow symbol appears before each activity in the chapter and indicates "Do 
something." For example, 

~ Turn the page to learn more about Cg Compose 2. 
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The Cg Compose 2 
Window 

Cg Compose 2 Terms 

This Chapter is divided into two parts. The first part briefly explains basic 
Compose concepts. The second part contains three examples of work you might 
perform on your Personal Composition System. Each example gives directions 
for accomplishing specific tasks. These tasks illustrate important points. You may 
use Chapter 2 as a reference guide when you want a reminder on how to do a 
specific task or when you want more information about a particular subject. You 
can look for specific topics and procedures in the index. 

To use Cg Compose 2 you must understand the basic concepts and terminology 
associated with the Compose document. The basic operations that you perform 
in Compose, such as selecting, scrolling, entering text, changing text and 
formatting text, are similar to those you have learned in LisaWrite and LisaDraw. 
With Compose you will take these operations several steps farther. You will learn 
to have even more control over the final product-your document. 

When you create and edit Cg Compose 2 documents, the desktop looks 
something like the figure below. 

Fonts 

[erter 
Right 
.kIstiFy 

····~g··COiii"jiose·Lr~-··r: Sf't VelticiJl .k~tificati()n 
, , . Clear Vertir:al Justif'iCiltirlrl i ! ·I·d ...........................................................................• 
i i Cledr TalJ Stop 
: i Set. Normi.,j 'r ~'.Ib 

····L __ ~j ::::~;: 
~'.~. COlY~l\i.1 '.' ri~.\ 

"', i,;.' 

.: ::i ': 1: :: ii m ii ii :ii i: " '; : " .... 
Si.~: lab fill,,, 

Icon 

Window 

Menu bar 

Insert Word Break 

Word Breaks 

A graphic symbol representing something on 
the Desktop. 

Displays the contents of an open document. 

Shows the names of the available menus in Compose. 
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Title bar 

Menu item 

Pointer 

Compartment 

Design Page ... 

Rule 

Galley 

Rulers 

Scroll bar 

Shows the name of the document. 

An operation, command, or instruction that is applied 
to the current selected item. 

Used to select, move, create, stretch, shrink, or 
reshape objects on the desktop. 

Rectangle used to position text on a page. 

Used to set the format of the next page after you have 
accepted the current one. 

A horizontal or vertical line. 

A temporary storage area for moving figures and text 
into Compose. 

Used to help layout the page. 

Controls that allow you to move the document within 
the window to see different parts of it. 

Compose lets you merge graphic figures with text. Compose documents may 
contain figures such as drawings, company logos, graphs or flowcharts. Figure 
objects include graphs and anything you draw-lines, circles, graphs, boxes, etc. 
Text consists of material pasted in from LisaWrite, LisaList, LisaCalc and the fonts 
displayed on the screen, including letters, numbers, symbols, and punctuation. 

With Compose you can layout your text with multiple columns, perform cut 
runarounds, indents, and other page layout functions that cannot be performed 
on a standard typewriter or word processor. 

Many of the operations performed in Compose are accomplished by choosing an 
item from a menu. The Compose menus are listed on the menu bar shown in the 
previous figure. A description of all Compose menu items is found in Chapter 3: 
Compose 2 Reference 

To choose a menu item, move the pointer to the menu bar and position it over the 
name of the menu, press the mouse button and hold it down. Notice that the 
menu is displayed. Move the pointer to the menu item you want to select. When 
the item is highlightled, release the mouse button. 

Some menu items have an Apple symbol and a letter beside them. As a shortcut 
you can hold down the ~ key and press the letter to select a function rather 
than choosing the item from the menu with the mouse. Refer to Appendix 2, 
Apple Keys, in this manual, for a list of menu items that you can choose using the 
Apple key. 
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Some menu items are followed by an ellipsis ( ... ). When you choose one of 
these menu items, you must respond to a dialog box before the item takes effect. 
(Dialog boxes are explained below.) 

When a menu item is shown in gray instead of black, it cannot be chosen at that 
time. This is usually because it does not apply to the current selection. 

Some menu items are grouped together and represent the available choices for a 
particular menu setting. The current setting has a check mark next to it. If you 
choose another setting, the current one automatically turns off. Choosing one of 
these menu items excludes the ability to perform other similar operations. For 
instance, the same text cannot be both Bold and Plain at the same time. 

Other menu items have check marks when they are on, but they can also work 
with other menu items. For example, you can use Bold and Underline at the same 
time. When you do, both items will be checked on the Typestyle menu. In this 
case, choosing Plain Text turns off both Bold and Underline. 

A few menu items such as Group Objects or Lock in Place, show check marks 
when they have been selected and are on. The reselection of the same item will 
turn them off. 

,1,1' [g Compose 2 Papel 02/05 'I, , 

................. : ... r''''· ... '-'"'-'''-'''''"'':-
Repeat on all Pages 

: 
IHiqn Objed\." 

L __ ._.~.-... --... ~ .. --.u .... ~----.... -.... -.. -.i· 
Shade Db jects ... 
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As you move the mouse, the pointer moves around the screen. Depending on 
what you are doing, the pointer can have any of the following shapes: 

The check pointer is used to make choices within a dialog box. 

The hourglass appears when you must wait while the Lisa finishes a task. 

The arrow pointer appears when you can make changes to the screen display. It is 
used for view controls, menu items, selecting icons, and moving figures around 
on the desktop. 

The drawing pointer appears when you draw a rule or make a compartment. 

The text pointer appears when you have pressed the ~key and clicked the 
mouse button in a compartment. When the text symbol is activated, there is an 
insertion point marking where the text will appear in the compartment. 

To work on a passage of text or a graphic object, you must indicate what you 
want to change or alter by selecting it on the screen. To select something place 
the pointer on it and click the mouse button. This is an important concept: you 
must always select the text or figure before you can edit or format it. 

When you press the ~ key and click the mouse button to select a point of 
insertion, a vertical bar blinks to show where the next typed character will 
appear. This vertical bar is called the insertion point. The text pointer 
temporarily disappears (it reappears as a text pointer when you move the mouse). 
Any previously selected text is deselected. 

If you try to select a point at the bottom of a document or in a blank area and 
can't, there is no text to be selected. You can place the insertion point after the 
last text and press IReturnl to move the insertion point down, or you can press 
the spacebar to move the insertion point to the right across the page. 

After selecting text, you can type new text to replace the selection or you can 
choose a menu item to edit or format the selection. For example, to replace a 
misspelled word, select the word and type it correctly. 

The table on the next page explains how to select a point of insertion, one or 
more characters, or a text passage of any length. Selected text is highlighted on 
the screen; however, highlighting doesn't print. 
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Compose Paper 

To Select Text Do the Following 

Insertion point Move the pointer to the desired location and press the 
~key as you click the mouse button. 

One or more characters Move the pointer to the left of the first character. 
Press the ~ key. Press and hold the mouse 
button. Pull through to the last character and release 
the mouse button. 

Select everything Choose Select All of Document from the Edit 
menu. This selects the text and objects. 

Deselect 

Extend the selection 

To Select Objects 

Figures, lines, etc. 

Multiple objects 

Click the mouse button when the pointer is in a blank 
area of the document. 

Move the pointer to the end of the text you want 
included in the selection. Press and hold the IShiftl 
key and click the mouse button. 

Do The following 

Move the pointer so that it touches the object. If the 
object is filled, you can move the pointer anywhere 
inside the object. Click the mouse button. Be sure you 
don't move the mouse while clicking. Handles ~ppear 
to show that the object is selected. 

Press the IShiftl key and hold it down. Move the 
pointer to each object you want to select and click the 
mouse button. Handles appear as the objects are 
selected. Release the IShiftlkey. 

In Compose, you can choose three kinds of paper from the Page Layout menu. 

• Plain paper is completely blank with no grid lines. 

• Grid paper has grid lines that are useful as a visual drawing aid. Use grid paper 
to position objects and text manually. 

• Auto-grid paper also has grid lines. Everything you draw will snap to these 
grid lines automatically, as if the lines are magnetic. The auto-grid is useful 
when you are drawing charts or anything that has to be aligned perfectly. 
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With a Compose document you may edit only one page at a time. You must 
accept the contents of the page you are on before you can change the contents of 
another page. This is done by choosing Accept Page from the Edit menu. You 
then go to the new page and click the mouse button on it. 

Text can only be entered onto the Compose page by placing it into a 
compartment. A compartment is made the same way as drawing a rectangle in 
LisaDraw. You must choose Make a Compartment from the Page Layout menu. 

Each block of text or figure that you copy and bring into Compose from another 
tool must be placed on agalley. You draw a galley in the lower part of the 
Compose document. You must draw seperate gallies for holding text and figures, 
then assemble the text and figures on the page. 

You merge text from a galley into a compartment by selecting the galley and 
dragging it up to the compartment. Release the mouse button when the pointer is 
in the compartment you are filling with text. 

You can link a galley with several compartments on a page, so that text will 
merge into one compartment from the galley and then automatically begin filling 
the next compartment. First create a blank galley at the bottom of the page. Place 
the pointer onto the galley. Press and hold down the mouse button. Drag the 
galley into the first compartment and release the mouse button when the arrow is 
on the compartment. The galley will change shape and become the same length 
as the compartment. When you bring the text galley into the first compartment, 
text will fill that and all other compartments that are linked with it. 

This procedur~ allows text to be composed as it moves from the galley into the 
compartment, and back to the galley again if the compartment size is changed. 
You may break the association link between compartments on the same page by 
choosing Break Compartment Links from the Page Layout menu. 

When you choose Accept Page from the Edit menu, the link between the galley 
and the compartment is broken. Because the association is no longer active, if the 
compartment is made smaller, the text will automatically flow onto an overflow 
galley, which appears in the galley area. The contents of a galley can be merged 
into the next compartment that is associated with that galley. 
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Page Size 

Group Objects 

Lock Objects 

Changing Shapes 

Entering and Editing Text 

When you tear off a piece of stationery for the first time, you see a Page Size 
dialog box that you must complete. The decisions you make will be carried with 
the document and with duplicates of the document. The Compose document 
Page Size designates the intended output size of the paper (letter or legal), the 
graphic resolution (high or low), and the mode, of output (landscape or portrait). 
In the Format for Print dialog box you must match the attributes of the page 
size to output the document. You can paste material from one size page to 
another size page to change the output resolution, mode or length of paper. 

Note: The EP 308 can only output high resolution pages 

You can select several objects and treat them as one single object by grouping 
them. This technique is used when you want to move or change all the objects as 
a single unit. Later, if you want to edit parts of the group, you can ungroup the 
objects. They will be separate again. 

You can also choose Align Objects ... from the Arrangement menu to straighten 
selected objects. The dialog box that appears gives you the added choice of 
matching existing characteristics of some of the items selected. 

You can lock selected parts of a document into place. Once locked, these 
selections cannot be changed, deleted, or moved until you unlock them. 

In Compose, you can stretch or shrink any compartment, space or rule. You can 
make it wider or thinner, taller or shorter, or change both dimensions at the same 
time. The wayan object changes when you stretch or shrink it depends on which 
of the handles you move when the figure is selected. 

When you enter text, you type it for the first time. When you edit text, you add 
to, rearrange, replace, or remove existing text. Compose allows you to enter new 
text and edit text that is already in the document. 

You can type in Compose without worrying about the length of the line. As you 
type, any word that exceeds the right compartment edge automatically moves 
down to start a new line at the left margin. This feature is called word wrap. You 
press the ~ key only when you want to start a new paragraph. 

Text wrapped together in one paragraph is treated as a unit for many Compose 
operations. For example, when you add or remove text from a wrapped 
paragraph, all gaps between the text and the compartment edge are readjusted 
automatically. If you change the size of the compartment, the text realigns 
between the new borders. 
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When you create, edit, and format a Compose document, its contents can be 
viewed as groupings of text, paragraphs, and pages. 

• Text is a group of one or more characters, including letters, numbers, symbols, 
punctuation, and nonprinting, characters such as spaces, tabs, and paragraph 
returns. Some Compose operations, such as cutting, copying, and replacing 
text, work with any amount of text that you select in a document, whether it 
is part of a word in the middle of a line, a sentence in the middle of a 
paragraph, two paragraphs, or the entire document. 

• A paragraph is a group of text that ends with a paragraph return character. A 
paragraph return character by itself is also a paragraph. (A paragraph return 
character is the result of pressing the IReturnl key.) Some of the formatting 
styles available in Compose work on a paragraph-by-paragraph basis such as 
the selection of alignment. 

• A page is text and figures that will print on one piece of paper. Compose has 
special formatting features for pages. Page length, page numbers, repeating 
page layout formats, and single page editing create style attributes associated 
with pages . 

. Formatting text determines the appearance of your document by specifying the 
fonts, paragraph alignment, and page design. You can set the document format 
you want before entering text, or you can change it after you've entered text. 

Formatattributes result from selecting the operations from the Edit, Typestyle, 
Fonts, and Format' menus. From the Composition Defaults ... dialog box on 
the Edit menu you choose letter, word, and line spacing, as well as automatic and 
manual hyphenation. This dialog box displays the settings in effect for the 
current page you are editing. 

The Format' menu allows you to choose paragraph alignment, set tabs and 
vertical justification and control the word breaks. The menu item Compress Text 
allows you to apply book set, ad set, or tight set Character Compensation and 
text or designer Kerning to make the text tighter on the page. 

The type used in a document is chosen from the Typestyle and Fonts menu and 
applied to text that has been selected. The size of the characters is chosen from 
the J'ypestyle menu, and the typeface is chosen from those available on the Fonts 
menu. This is applied when text is first entered into Compose by choosing 
Change Fonts in Galley from the Fonts menu, or it can be added later when the 
text is edited. 
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The top of the Typestyle menu is displayed in the same arrangement as the 
LisaWrite Typestyle menu with the variations of Plain Text, Underline, Boldface, 
Italic, Subscript and Superscript. The bottom section of the menu shows the 
available type sizes including the ability to indicate sizes other than those shown 
on the menu. 

The Fonts menu contains the typefaces Apple Classic and Apple Modern and the 
typefaces purchased from Compugraphic. You can display 14 typefaces on the 
menu at one time. You may have up to 100 typefaces on the Disk. Fonts can be 
accessed from the disk by the menu item, Replace Menu Fonts. 

After you have finished a page, and accepted it in the Edit menu you can choose 
the method of designing and filling the next page from the Page Layout menu. 
The Design Page ... item allows you to maintain the same format parameters as 
you continue, or to change them as you style a new page. 

When you change a page format, the new attributes will be applied to all of your 
work until you change them again. The Design Page ... dialog box allows your 
work to be uniform, but gives the flexibility to change the layout if you choose. 

• Setting Format Styles Before Entering Text: 

Before you start typing, you can choose the formatting styles you want from the 
various menus. The settings you choose become active at the current insertion 
point. When you type, your text automatically conforms to them. To increase 
your production speed, you may want to make many of your format decisions 
when you are working on your source documents with the other tools. 
Typestyle, size, and paragraph alignment can be applied to your document when 
you are working in LisaWrite. These attributes will carryover into Compose. 

• Changing Format Style of Text In Compose: 

To change the format of text displayed in the middle of a document, highlight the 
text you want to change, and choose the format item you want. The format 
attributes set in the Composition Defaults ... dialog box apply to the entire page. 

• Standard Format Settings: 

The blank stationery pad that comes with Compose has some standard format or 
default settings. To change settings or set specific Compose formats, including 
the design of your own stationery pads, see Typesetting A Memo in this Chapter. 

Tabs In Cg Compose 2 you can set tabs to line up information. If you have a source 
document that already has tabs, the material will remain in tabs when it is moved 
into a compartment. 
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You set tabs in a Compose document the same way you set them in LisaWrite. You 
bring the ruler to the screen. Place the pointer on the line of text where you will 
set the tab stop. Press the ~ key and the mouse button. With the insertion 
point blinking in the text, you mark the type of tab stop at the location you wish 
on the ruler. When you press the Itablkey on that line, text moves to align with 
the tab stop. You can set Left (normal), right, center, decimal and comma tab 
stops. You can use fill patterns to place repeating characters on the page between 
text that is in tabs. 

Layout is the assembling of graphic elements on the page. It is the positioning of 
text, rules, headers, footers, and figures on the page. The Compose document 
layout is performed by drawing compartments and placing figures on the page. 
Text is then merged into the compartments from galleys. The page layout is 
changed by using the mouse to move the position of the compartments. Text 
placed on the screen is viewed the way it will appear on the printed page. What­
you-see-is-what-you-get. 

To expedite the production of your documents it is best to have a specific plan in 
mind when you begin to layout a page. The Personal Composition System allows 
for considerable experimentation and ease in changing document display. 
However, your ability to plan ahead in assembling components will greatly 
simplify your work. 

The manipulation of compartments and figures is the most fundamental page 
layout operation. You also can insert Rules on your page and use Space Blocks 
to leave room for adding artwork that can not be pasted onto a galley. 
Compartments can be shaded, and brought to the front, or sent to the back as you 
do in LisaDraw to hide or crop figures. 

When you choose Design Page ... from the Page Layout menu, you can designate 
the compartment layout on the new page to: 1) repeat from the current page, 2) 
repeat from the preceding page, or 3) copy a page layout that has been placed on 
the clipboard. If you want the text in a compartment to repeat on all pages, such 
as for a header or footer, you can designate that the compartment and contents 
Repeat on All Pages from the Arrangement menu. 

The Horizontal Paragraph Ruler is used to set tabs and help position 
compartments and margins on the page. It appears when you choose Show 
Rulers from the Page Layout menu. By checking items on the Customize 
Rulers .•. dialog box, you can change and redefine the measuring increments that 
display on the rulers. 

The vertical page ruler is used to set vertical justification and measure the 
placement of compartments, figures, margins, headers, and footers. You bring it 
to the screen by choosing Show Rulers from the Page Layout menu. 
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Scrolling 

When you use the vertical page ruler, the basic Compose screen changes to look 
similar to the figure below. This figure shows only the top half of the page ruler. 
When you choose Customize Rulers ... from the Page Layout menu, you can 
change the incremental scale shown on the rulers. 

, 

r- Desk File/Print Edit Type Style Fonts Formal: U Page Layout Arrangemert 

CUSTOMIZE RUlERS ... 

AUlER 
o HORIZONTAL 0 VEATICAL • BOTH 

Ruler Formal: 
• Inches o Centimeters 

Major Division Spacing 
o 0.5" .1" o 1.5" 02" 03" 

Number of Minor Divisions ~ 
01 02 03 04 05 0& .8 010 012 

Numbering Increment .1 02 03 04 05 0& DB 010 012 

Adjustable Zero-Point: 0 On • Off 

Your document can be longer and wider than the display 
window on your Lisa. Most of the time you'll want to keep the 
window wide enough to see both ends of a line. The window 
has view controls that you use to bring hidden portions of the 
document into view and to see more than one area of the 
document at a time. The figure below shows these controls. 
Some of them are duplicated because the window has been 
split into two sections, one for the document and one to hold 
the galleys. 
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The following brief descriptions explain the items you see in the figure. 

Scroll bars 

Scroll arrows 

Elevators 

View buttons 

Panel elevator 

To Scroll in Compose 

Line by line 

Column by column 

Continuous lines or 
horizonal increments 

Allow you change the view of the document. 

Allow you to view hidden portions of a document, 
either vertically line-by-line, or horizontally column­
by-column. 

Indicate the current window's view in relation to the 
rest of the document. They enable you to move 
quickly to the top or bottom of the document. 

Allow you to scroll the document one full screen view 
at a time. 

Lets you resize the page and galley panels. 

Do the Following 

Move the pointer over one of the vertical scroll arrows 
and click the mouse button. 

Move the pointer over one of the horizontal scroll 
arrows and click the mouse button. 

With the pointer on the scroll arrow, press and hold 
the mouse button. Release it when the document is 
positioned where you want it. 

View-sized increments Move the pointer to the view button and click the 
mouse button. 

Continuous view-sized With the pointer on the view button, press and hold 
increments the mouse button. Release it when the document is 

positioned where you want it. 

Large jumps With the pointer on the elevator, press and hold the 
mouse button, moving the elevator up or down in the 
scroll bar. 

To the top With the pointer on the elevator, press and hold the 
mouse button, move the elevator to the top of the 
scroll bar, then release the mouse button. 

To the bottom With the pointer on the elevator, press and hold the 
mouse button, move the elevator to the bottom of the 
scroll bar, then release the mouse button. 
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Output 

Dialog Boxes 

You have several options for outputting your document on the Personal 
Composition System. This includes electronic communication with another 
system, printing on a dot matrix printer, or EP 308 printer, or typesetting on a 
Compugraphic 8400, or 8600. 

The output device is initially connected through the Connect Devices dialog 
box of the Preferences icon. The appropriate device must be indicated in the 
Format for Printer dialog box before each printing cycle output. You may 
select a device as the Default in the preferences. This will allow the device to 
remain selected in the Format for Printer Dialog Box. 

Directions for making the correct device connections are given in Chapter 4: 
System Set Up. For an example of the sequence of steps you must follow to 
change the output device connections, see Chapter 1: Learning Cg Compose 2. 

A dialog box is a screen that appears in response to choosing certain menu items. 
It allows you to accept or change various options that apply to the command. A 
dialog box for Compose is shown below. 

For each option you wish to change, move the check pointer to the box and click 
the mouse button. Placing a check in the box will fill the box with shading. 
When the dialog box reflects the options you want, click OK. 

r Desk lijalM' Edit Type Style Fonts Format If Page layout Arrangement 

Format ~or Compugraphic EP308 - serial port A 

Paper Size 
• Letter (8.5" x 11") 
DLeqal (8.5" x 14") 
D 1',4>210 x 297mm), 
D210mrn x 12" 

Printing Orientation 

II B ~ _. r:=J' 
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Starting a New Document 

This part of the chapter will lead you through the normal cycle of creating and 
working on a Cg Compose 2 document. You will gain experience with basic 
operations of the Personal Composition System by completing each of the 
objectives listed below: 

• Format a blank piece of stationery. 

• Paste a figure from another document into your document. 

• Make a galley. 

• Make compartments. 

• Make the document into a stationery pad. 

• Tear off a piece of stationery. 

• Paste a text from another document into Compose. 

• Output your document. 

When you are finished with this chapter, your document will look like the one 
shown on the next page. 

To make your memo writing more efficient you can format several stationery 
pads and store them for future use. By doing this you will not have to set up 
document formats each time you want to write a memo-you will tear off a piece 
of stationery and begin typing. 
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Typeset a Memo 

~
. . . . . 

: S : 

o 
..... . . .. 

Memorandum 

To: All Personnel 

From: EDahlberg, Senior Vice President 

Date: July 1, 1984 

Subject: Interoffice Communication 

Reference: Finance FD-l 

To Improve and expedite all internal paperwork, 

supervisors and managers are requested to limit all 

messages and memorandums to a single page. The most 

effective way to meet this requirement is to compose all 

documents on the Personal Composition System and use 

a typsetting output device. 

Typeset copy consumes less space, has superior 

readability and will be rembered longer. 

F. Dahlbeg, Senior Vice President 
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Format a Blank 
Piece of Stationery 

Page Size 

To begin your task of formatting, you must tear off a blank piece of stationery 
from the Compose Paper icon. If the stationery pad is on the desktop, you can 
use the Desk menu to select and open a new document. 

~ Open the Disk icon on your screen. 

~ Select the Compose Paper icon. 

~ Move this icon from the Disk onto the window. 

~ Choose Cg Compose 2 paper from the Desk menu. 

~Disk 

~lisalttite Paper 
!;iI Preferences 
IilI Wastebasket 

This menu item will tear off a piece of stationery, name the tool, place the date on 
the top, and open the document. You can rename the document by clicking on 
the shadow where the document will return when it is closed. However, it is 
more efficient to change the name when you close the document for the first 
time. We will call this document Memo Pad 

After a short while, you will see a dialog box like the one displayed below. 
Every time you open a new piece of Cg Compose 2 stationery you will be asked to 
specify the size of paper you will use for this document. The decision you make 
concerning the page size is critical if you intend to print your final document in 
the landscape mode. You must specify at this time if you intend the landscape 
document to be LoRes (Low Resolution) or HiRes (High Resolution). For more 
information about this choice turn to the Create a Brochure section in this 
chapter. In this case, we will use letter size paper and print portrait style. 

~Check the OK box. 

,. Desk FilelPrint Edit TUPt! style Foots Format 11 Page layout Arrangement 

SIZE ••• 

PAGE SIZE 

You may now choo .. the size you wish your Cg Compose 2 page, to bo. 
Thi, will b. the ONLY chince you will have to make this doci,ion 
for this document. Note: Be SUIe that the printing Preferene .. 
agree with the page size chosen h!re. 

letter • 8~~114" 0 ~ 8.5 X 11" 

210 X 297mm 0 210mm X 12" 0 

STYlE ••• 
Portrait • la~ 0 ~ 
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Composition Defaults A blank piece of Compose stationery paper will appear open on the screen. Now 
you can choose default spacing variables for all of the documents that are 
produced on this stationery. 

~ Choose Composition Defaults .•. from the Edit menu 

In this dialog box you can set the parameters for the document, such as word and 
line spacing, hyphenation, etc. The basic items necessary for typesetting have 
already been preset and are called Compugraphic Defaults. For our Memo 
Stationary Pad, we will make a few changes. For more information about each of 
the items, turn to Chapter 3: Compose 2 Reference. 

~ Check number 7, the second entry from the right, on the Line Spacing item. 
This allows more space between each line. Place the pointer on the box and 
click the mouse button. 

~ Place the pointer on the Pref arrow of the Word Space item. 

~ Press the mouse button and drag it four spaces to the left. This indicates that 
the overall word spaces in your document will be a little tighter than the 
Compugraphic Defaults. 

~ Type the number 14 in the sixth (6) box on the line Point Size. This means 
that the in the sixth position of the Typestyle menu the point size 14 will be 
available for Cg type. 

~ Check OK to bring back the Memo Pad document. 

,.. Desk File/Print Edit Type Style Fonts Format 1r Page layout Arrangement ., 

Compugraphic Composition Preference Sheet 

Hyphenation o • 
Off 01'1 

Letter spacing U-1...J 
HtnMtx 

line Spacing 0000000.0 

~Ii!il!i 
illlll! 

Tiqht 0 3 Loose 

Word spacing II I I I I I I I I I I I I I I I I I I I I I IllllJ 
Mtn t Htx 

Pref 

Point Sizes 1 8 2 10 3 12 4 18 5 24 

Rule Weights 1 1. 0 2 1. 5 3 2. 0 4 4. 0 5 O. 0 
(in points] 

( Set Compugraphic defaults) 

Chapter 2: Using Cg Compose 2 67 



Default Printer 

Making a Galley 

68 

The Format for Printer ... dialog box can be set so that a specified printing 
device is designated in the stationery pad. 

~ Choose Format for Printer ... from the File/Print Menu. 

Your Typesetter or EP 308 will be the designated output device if it is listed at the 
top of the menu. If another device is displayed, check the New Printer item. You 
willsee a list of all available output devices. If a device is not listed, but you think 
it should be, see Chapter 4: System Set Up on installing Device Driver software. 

~ If you are setting up for the typesetter in your Format for Printer menu, 
choose High Resolution for the print quality. 

To set up the basic format of your Memo Pad you will make a galley, draw 
compartments, paste in the company logo, and enter the text you will want to 
repeat on every memo. The rulers will help position compartments on the page. 

~ Choose Show Rulers from the Page Layout menu. 

Note: When you select the rulers the page will scroll slightly up and to the left. 

You will have to make a galley for holding the company logo. 

~ Move the pointer to the bottom part of the document. This part of the 
document is the galley area. 

~ Press down and hold the mouse button. As you draw a horizontal line to the 
left, pull the line into a rectangle at least 1 inch high and 1 inc he wide. 

~ Release the mouse button. 

File/Print Edit Type Style Fonts Format If Page lauout Arrangement 

ill: Cg Compose 2 Paper 02105 1111: 

~ ) 
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Making Compartments 

Entering Text 

You will make several compartments in your document to hold text and figures. 

~ Choose Make a Compartment from the Page Layout menu. 

~ Draw the compartment by placing the pointer 2 inches from the left margin 
and 1 inch from the top of the page. Press down and hold the mouse button. 

~ Drag the rectangle larger to the right until it reaches the 6 Vz inch mark on the 
ruler by a little more than a Vz inch deep. Release the mouse button. 

~ Draw two other compartments next to each other below the original. The 
easiest way to correctly position them on the page is to note the coordinates 
in the diagram below. All three of these compartments line up at the 2 inch 
mark on the margin ruler. 

Note: lfthe compartments you make do not match those in the example below, you can resize 
them by either selecting the handles at each corner or choose Clear from the Edit menu and 
beginning again. 

r Desk Fill!/Print Edit TIIM! StylI! Fonts Format 11 PaQI! layout ~rangl!rmt .... 

I rg Lompo,e 2 Paper 02/05 I 

, 
, , 
... _ ••••• _ ... _ ............ _____ ._ ••••• __ ••• _ •• _ ••• _. __ ._,.. ___ .......... _. __ ........ _ • .,.1. 

2 .. r---··------------------i· r--··-----------·-------·-·· ..... --------------·-··.:...--·--····"r'··· 
I r I I 

·1 i·1 I .. 
! !.: ! 
I : I • 

3 .. I f.·l L ... 
! ~ i 1 
: ~ : I 

. ~---.-... :-......... :.----.~ .... -... :.--.. --:-.-.--.-~--.-.-.--~.-.--.~ __ --~--... -: ..... _ .... : ....... __ .: . .,J; . 
. . ... ..... .................... . ........................................... . 

Now place the title of your stationery pad into the compartment at the top of the 
page. We will choose to have this title show up on all following pages. 

~ Position the pointer in the first box that you made. 

~ Press downand hold the ~key. 

~ Click the mouse button. 
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~ Choose Center from the Format' menu. 

~ Choose Cg Times Bold from the Fonts menu and 24 point from the 
Typestyle menu. If you do not Not have a true bold font, you can use a psuedo 
bold from the Typestyle menu. 

~ Type Memorandum in the compartment. 

~ Choose Repeat on all Pages from the Arrangement menu. 

You will need to format some text that will appear on all of your memos in the 
lower left compartment. 

~ Place the pointer in the small box on the left. 

~ Press and hold the ~ key. 

~ Click the mouse button. 

~ Choose Right from the Format' menu. 

~ Choose Cg Times Bold from the the fonts menu and 16 point from the 
Typestyle menu. 

~ Type 

To: IReturnl 

From: IReturnl 

Date: IReturnl 

Subject: IReturnl 

Reference: 
FilelPrint Edit Type style Fonts Format II Page LBUOut Arrangement 

I (g lornpl) f' ; PalJt'1 UJ/Wl II 

. . . . ·I----·--.,:.---------To~·· r------·_------...:--------------.:..-----------..:.----------_·-...:-----_01"'." ... ~ ... 

. 1 Prom~ .1 I.. .. ~ , 
I Date~ I I : r: I 

.. I S-1.l....t~1 t ...... :.. . 
I .. uJIi"", I I • 

! D_L. __ ~! I 
I .IUJ.IIJ .......... -; : : . 

. ~. ___ -':".-•• -.-•• ~-----~ . L_._ ••• _~ __ --.-_.~-.---.--__:_---_-':" ••• - •• _-':" •••• -.-•• ~_ •••••••• ~-_ .... ~._.-•• __:--:' .. , : . 

~HI ,- ~~i 

~ 
[) . ! 
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Copying a 
Source Document 

Now you will place a figure on your memo pad. To enter the company logo you 
will open another folder and another document, copy the logo, and paste it to 
the galley on the Memo Pad. The company logo is in the folder Chapter 2 in the 
Compose Examples Folder 

~ Open the Compose Examples folder. 

~ Open the Chapter 2 folder. 

~ Tear Off Stationery from the Stationery pad entitled News Release. 

~ Open the piece of stationery. 

To copy the Logo that is in the upper left corner. 

~ Select the logo by placing the pointer on it and clicking the mouse button. 

~ Choose Copy from the Edit menu. 

~ Set the News Release document aside. 

~ Click on the Memo Pad Compose document to activate it. 

~ Click on the galley that is on the bottom of the Memo Pad document. 

~ Place the Logo onto the galley by choosing Paste from the Edit menu. 
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Now the logo can be placed next to the compartment that was made at the top of 
the page. 

~ Place the pointer on the upper left corner of the galley containing the logo. 

~ Press down the mouse button and drag the galley to the top left side of the 
Memorandum compartment. 

~ Release the mouse button when the right side of the Logo is touching the 
compartment. The Logo should be about a IA inch above the word "To:." 

Note: Figure not placed where you want it? Use the mouse to move it around on the screen. 

Now you will create a compartment for the body of the text. 

~ Scroll down the document so that the two adjacent compartments are just 
visible at the top of the screen. 

~ Choose Make a Compartment from the Page Layout menu. 

~ Place the cursor at a point 2 inches from the left margin and approximately 
IA inch below the other two compartments. 

~ Draw the compartment down to the 9 inch mark on the page. The width of 
the compartment should be 4 V2 inches, or to the 6 V2 inch mark on the margin 
ruler at the top of the page. 

Below the text compartment you should place a signature line for the author of 
the memo. The line will be a rule placed in a compartment. Below the rule will 
be the title of the author. 

~ Making A Compartment beginning 2 inches from the left margin. It should 
be approximately 4 V2 inches wide and 1 inch deep. 

You will draw a rule across the center of the signature compartment just like you 
would make a line in LisaDraw. 

~ Choose 1.5 pt. rule from the Page Layout menu. 

~ Place the pointer on the left edge of the compartment in the middle. Press 
and hold the mouse button as you draw the rule across the compartment. 
Release the mouse button at the right edge of the compartment. 

~ Place the pointer inside of the compartment, press the ~ key and click 
the mouse. The insertion point will be at the top left of the compartment. 

~ Choose Cg Times Bold from the Fonts menu and 16 point from the 
Typestyle menu. 

~ Press the IReturnlkey two times. 
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Placing Rules 

~ When the blinking insertion point appears below the signature line, type F. 
Dahlberg, Senior Vice President 

11,1 [g [ompole 2 Paper 02/0, 111 

] ••••••••••• 4 ••••••••••• -•••••••••••••••• __ ••••••••••••••••••••••••••• : •••••••••••••••••••••• r. 
~ ~ 

........... iF. Dahlbeg. Senior Vice President i 
~ _____ ........ -... , .... --... ,-.... -..•...... --., .... -..... , ....... t, .......... ~ 

You will place two more rules in the Memorandum compartment on the page. 

~ Scroll up your document so the Memorandum compartment is in view. 

~ Choose 4.0 pt. Rule from the Page Layout menu. Draw the rule. 

~ Insert the first rule below Memorandum as shown below. Before you can 
draw the second rule you must click on the screen somewhere away from the 
top rule to deselect the first rule that was drawn. 

~ Choose 1.5 pt. Rule from the Page Layout menu for the bottom rule. Draw 
the Rule. 

If you have trouble lining up the rules, you can choose to turn off the Auto-grid 
from the Arrangement menu. You can also choose Match longest and then 
Align left sides to help in the placement of the rules. 

~ Place the rules as shown in the diagram below . 

. ~ ....................................................... , .... . 
.. - . IYlemOranuum 1 

•• ~ •.. S ....• .......... ~ .......... : ..... ,.~ .......................... ::I ....................................... , .... . 

t ................. ~ ................... ---...... ----~ .. -.......... -...... ~ ...... --.. -.. --.. ~ .. -..... _ .... -..... : .......... ; .. . 
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Creating a 
Source Document 

You have formatted your blank piece of stationery. To be able to use this 
stationery paper for future jobs, you must make it into a Stationery Pad. 

~ Choose Save & Put Away from the File/Print menu. 

~ While the icon is still selected choose Make Stationery Pad. You now have 
an endless supply of paper for writing memos. 

~ Name the stationery pad Memo Pad 

The best way to use your stationery pad is to prepare your document in Lisawrite 
first and then merge the LisaWrite document into Compose. Follow the 
instructions below to learn this procedure. 

~ Open your Disk. 

~ Tear off a piece of stationery from your LisaWrite paper. 

~ Name the new document Memo Draft. 

CgCompose2 
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~ Open Memo Draft and type the following information. 

All PersonnellReturnl 

F. Dahlberg, Senior Vice President IRefii!ij 

July 1, 1984IReturnl 

Interoffice Communication [Retiim] 
Finance FD-1lReturnl 

To improve and expedite all internal paperwork, supervisors and managers 
are requested to limit all messages and memorandums to a single page. The 
most effective way to meet this requirement is to compose all documents on the 
Personal Composition System and use a typesetting output device. 
~ IReturnl 

Typeset copy consumes less space, has superior readability, and will be 
remembered longer. 

Your work should be saved about every 15 minutes to prevent loss of data from an 
unexpected power interruption. After you have saved your work, you will merge 
your memo draft into a Compose document. 

~ Choose Save and Continue from the File/Print menu. 

~ Choose Select All of Document from the Edit menu. 

~ Choose Apple Modern 12 point from the Typestyle menu. 

~ Choose Copy from the Edit menu. 

~ Choose Save & Put Away so that your Memo Draft is no longer on the 
screen. You should store your source or draft documents on a micro diskette. 
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Now you will be able to merge your Memo Draft into a page of the Compose 
Stationery Pad that you have created. 

~ Select your Compose stationery Memo Pad. (Remember, if your Memo Pad is 
on the Desktop, you can open and name a document in one step with the 
Desk menu.) 

~ Choose Tear Off Stationery from the File/Print menu. 

~ Name your piece of stationery Memo #1. 

~ Open Memo #1. 

You may paste your draft document onto the galley that you made to hold the 
Switch-On logo. Although you cannot mix text and figures on the same galley, 
once a galley is empty, you can paste anything you want to it. 

~ Move the pointer onto the screen area below the memo #1 document. 

~ Place the pointer on the galley. 

~ Press the mouse button. 

~ With the galley highlighted choose Paste from the Edit menu. 

The first few words of the memo will appear on the galley. 
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Changing Fonts 

Merging Text 

You can change the typestyle of your document while the text is in the galley. 
You can change from one of the Apple fonts to one of your Cg fonts. 

~ Choose Change Fonts in Galley ... from the Fonts menu. 

~ Complete the dialog box with the following information: 

Change From: Apple MODERN 12 point 

Change To: Cg Times 

With a point size of: 16 

Kerning: Text 

Character Compensation: book set 

Click OK 

r Desk File/Print Edit Type Style Fonts Format U Page Layout Arrangement 

Change Fonts in Galley ... 
I~I 

Change From: • Apple MDDEAN o Apple CLASSIC '----
o 8 pt,20 pitch o 10 pt,12 pitch • 12 point o 18 point 

o 8 pt, IS pitch o 12 pt,1O pitch o 14 point 024 point 

Change To: r Clear Entry J 

o BRUSH 0 ROm!Ell MD o ROC,WEll MO IT o ROC,WEll 60 

o ROm'Ell SD IT 0 TRlUlWIRRTE o TRIUMVIRRTE IT o TRIUMVIRRTE BD 

o TRIUMVIRRTE 6D IT • CG TIMES o co TlMEi ITALIC o co TIMES BOLO 

o CG TIllE! 60 IT o co OIIEGA 

With point size of: 10 

( OK ] 

Kerning: 0 off • text 0 designer 

Character Compensation: 0 none • book set 0 ad set 0 tight set 

, 

Now bring the galley into the top empty compartment and fill that compartment 
with the text on the galley. 

~ Place the pointer on the text galley and press the mouse button. 

~ Drag the galley up into the empty compartment. 

~ Release the mouse button when the pointer is inside of the compartment. 
Text will flow from the galley into the empty compartment. 
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Output Memo 
on Typesetter 

When the-screen redisplays, move the galley into the second compartment. 

~ Place the pointer on the galley. 

~ Press and hold the mouse button. 

~ Bring the galley up so that the pointer is in the compartment immediately 
beneath the one you have just filled. Text will move from the galley to fill this 
compartment, completing your memo . 

. ~lrperiioIiiier·················'········-·············'·· .... _ .......... __ ., .... _ ...... 1' .. . 

iF: Dahlberg, Senior Vioe President i .. 
~uly I, 1984 . 

tInteroffioe Communioation 
ltefi~re:O:l8~ ~inanoe FD-I 

...1-...•..... , ............. , ....•......• : L" ••• __ .~ ••••••••••• ~ ••.•••••••. ~_ .•••••••• ~ .•••••••••• ~ ••••••••••• ~ .••••••.... ~_ ... _ .•..• , •••• _ ••••. ~J . 

You should now Save your document and prepare to output it on the typesetter. 

~ Choose Save & Continue from the File/Print menu. 

Your Format For Printer .•. dialog box should indicate the typesetter or EP 
308, which you designated in your stationery pad, is the selected output device. 

The Format For Printer ... dialog box must be set to agree with the information 
that you indicated in the Page Size dialog box wh·en you first opened the Memo 
Pad icon. The information in the dialog box was set when we created the 
stationery pad. Because there are no changes and it will not be necessary to 
answer any further questions, you can choose to print the document way it is. 

~ Choose Print As Is ... from the File/Print menu. 

If you wanted to change some information for this printing cycle, you could look 
at the Format for Print dialog box. 
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Putting the 
Document Away 

~ You must choose those items you selected originally on the Page Size menu, 
in this case, portrait (the picture icon displays the person in an upright 
position), and for the typesetter, High Resolution. 

~ Choose OK to return to your Memo #1. 

r Desk 1M'.' Edit TIP style Fonts Format U Page L!JOlt Rrranqemert 

Format For (OIIlPU!Taphlc EP30B - serial port R ( cancel J 
Paper Size 

• Letter (8.5" x 11") 
DLegal (8.5" x'14") . 
o A4 (210 x 297mm)" 
D210mm x 12" 

Printing Orientation 

A,£; ~ 
( New Printer ... 

r Desk 11i1itJdt!1. Edit Type Style Fonts Format U Page Layout Rrrangement 

Print on Compugraphic EP30a serial port A Cancel) 

Pages to Print 
.>:.11 Pages DOnly pages: Through: 

Number of Copies 

amUJ00ITlITlITl[D[ill 0 
(Dilation o Pages Collated • Pages Not Collated 

Media Input 
• Automatic Feed 0 Manual Feed 

OK 

After you have completed the Format for Printer ... dialog box you may complete 
the Print dialog box if you want to make changes. 

~ Choose Print from the File/Print menu. 

~ Make the appropriate changes, such as the number of copies for the EP 308. 
Choose OK on the dialog box to begin printing. 

~ Choose Save and Put Away after the printing has been completed. You may 
wish to save this document as a sample for your own memo format, or if you 
are finished with the memo, you can throw it in the Wastebasket. 

Print As Is 
Format For Printer ... 
Print ... 

consumes less space, has superior 

and will be rembered longer. 
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Prepare a 
News Release 

Editing In Compose 

The next two sections of this chapter will cover some more basic office 
applications of Compose. This approach will demonstrate alternative methods 
for using Compose in office tasks. 

You will be provided with a text file from LisaWrite called Conference Draft. You 
will edit this file in different ways and merge the document into Compose. You 
will prepare a news release and a brochure with Compose. Use these tutorials to 
experiment with the operations of Compose menu items. If the learning process 
takes you in a different direction from the steps in the tutorial, follow your own 
curiosity. The exercises are short and you can easily start again from where you 
left off. 

• In the News Release tutorial, you will merge the text in the Conference 
Draft document with a page from the Compose News Release Stationery 
Pad. The page format for the Compose Stationary Pad was developed and 
pasted from a LisaDraw document. The major editing of the News Release 
document will be done in Compose. 

• In the Brochure tutorial the same Conference Draft text will be edited in 
LisaWrite. Most of the editing and format commands will be made before the 
document is pasted into Compose. The brochure will be set up and printed in 
Landscape and High Resolution. 

As you work on the News Release tutorial you will: 

• Select and edit all of a source document. 

• Paste text into a galley. 

• Resize a compartment by matching. 

• Insert word breaks. 

• Move text. 

• Change typestyle. 

• Vertically justify text. 

• Insert space blocks. 

When you have finished with your News Release it will look like the document 
shown on the next page. 
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The News Release 

U.·.rml .. ~ ... ·.·.+l-N-~:,~-C~_~-,~"C~-rrun R-U"ic~-t;o~-s E_f\_SE_-----'1 ~ 1-800-222-222 

Switch-On Communications 
announces a new seminar in 
Management Development. 

Fannington. May 1984-- The SWlIch-On Educational 

Sevices Divi~on will present a new one-day ~cminar 

entitled You as a Manager, a practical workshop for 

supcrvisor~ who will be moving into management 

po~lt]()ns 

According to Marion Camhell, Switch-On spokcs­

per~on, "one of the responsibilit!es of every supervisor 

is the management and training of employee~. Most 

supervisors, however, have never been provided with 

the basic skills to enable them in making management 

decisions even though the next step in their career will 

be to become a manager." 

This seminar is designed for supervi~ors, foremen. ad­

minstrative assistants, and other [inc managers who 

have on-going responsibility for the training and 

management of employees 

"The persons who allend thi~ seminar should be 

serious candidates for management positions." 

Chapter 2: Using Cg Compose 2 

The ~cmmar i, being offered as a practical worbhnp 

~trcs~ing the fundamentals of managing employee~ 

Thi~ w\l1 include ,uhject matter ~uch as: 

The move from ~upcrvisor to manager 

How do people respond to manager,. 

Communicating with people. 

Being Strong-minded 

Management styles. 

Cambell ~aid that panicipant~ will return to their com­

pany with skills that will have an immediate impact 

on their ability to deal with other employees 

This seminar will join over 25 other workshops in im­

proving the quality and efficiency of the work 

The first seminar offered by Switch-On will be Tues­

day, June 7, 1984 from the hour~ of 8:00 am to 5:00 

pm at the Sherwood Forest Inn, Farmington. The 

registration fee is $250.00 per person Registration is 

limited to the first 30 applicants. 

For funher information call toll free 1-800-222-222 

-End-
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Preparing a 
Source Document 

Pasting a Document into 
Compose 

82 

A document has already been provided for you in LisaWrite. You will open this 
document, change the typestyle and the paragraph alignment before you move it 
into the Compose document. 

~ Open Chapter 2 folder. 

~ Tear Off Stationery from the Conference Draft stationery pad. 

~ Name the document Release Draft. 

~ Open Release Draft. 

~ Choose Select all of Document from the Edit menu. 

~ Choose Apple Classic and 12 point from the Type Style menu. 

~ Choose Justify from the Format Text menu. 

~ Choose Copy from the Edit menu. 

~ Choose Save and Put Away the Release Draft document. 

The News Release stationery pad has already been created, using the same 
procedures you performed to create the Memo Pad in the previous tutorial. The 
frame and the rounded corner column boxes were prepared in LisaDraw and then 
pasted into a compose document. To make the news release document, you only 
have to tear off a piece of stationery from the News Release Pad and then paste a 
document that was drafted in LisaWrite. 

CgCompose2 



Making A Compartment 

~ Choose Tear Off Stationery from the Compose News Release stationery 
pad in the Chapter 1 folder. 

~ Name the document Conference Release. 

~ Open the document. 

Make a galley in the bottom area of the Conference Release document. You will 
paste the text draft from the clipboard onto the galley. 

~ Place the pointer in the area below the Conference Release document. 

~ Draw a rectangle that is about 1 inch tall and 1 V2 inches wide. The rectangle 
will display as a galley. 

~ While the galley is still highlighted, Choose Paste from the Edit menu. 
,.. Desk File/Print Edit Style Fonts Format l!u.....!::2.!:J~.....!~~~L.. __ ~""I 

ilill [onferen(E' Reled'e ,li,11 

NEWS RELEASE 
Sw:UclI- 011 CommllllicatiollS 
Far_ton 
, -800 -222 -222 

Scroll down to the boxes drawn in the middle of the page. 

~ Choose Make a Compartment from the Page Layout menu. 

~ Make a compartment in the left rectangle on the page. Stay about an eighth of 
an inch inside the lines that are already on the paper. 

~ Drag the compartment down to the bottom of the page and stay the same 
distance from the rules that are already on the paper. 

Text inside a compartment will run up to the compartment borders and leave a 
thin white space between the text and the boxes drawn on the page. 
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Matching a Compartment 
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F,mningtrn, May 19M-SNitch-On 
Commurications anJ'JDl.l'lces a lIfW 

To place a compartment in the box on the right side of the page, you will match 
the size and position of the first compartment. 

~ Scroll up to the place where you began the first compartment. 

~ Choose Make a Compartment from the Page Layout menu. 

~ Draw the second compartment in the box on the right side of the page. 

You will only need to draw about a square 1 inch by 1 inch, but you must start 
your drawing at a point inside of the column rules similar to where you began the 
first compartment on the left side of the page. 

~ Press the IShiftlkey. 

~ Select both compartments. 

~ Choose Align Objects from the Arrangement menu. 

~ Choose Match •.•. Tallest from the dialog box which appears. Choose OK. 

~ Choose Align Objects again from the Arrangement menu. 

~ Choose Match ..•. Widest from the dialog box. Choose OK. 

You will now see two identical compartments in each of the boxes. 
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Establishing 
Compartment Links 

Merging Text 
Into Compartments 

~;,;;,;,;,;.....;..;.;,;;,;.;.;.;.;, __ .;;,;;,;, __ ~ Style Fonts Format ...... ..;",;;;,l;;;..;;,;;;;;;,;;;., II.DIIII.. __ ~ 
Bring To Front 1111: I Confer ence Relea\e 1111 

Send To Back 

Group Objects 

lock in Place 

Repeat on all Pages 

•.................. ,. .................. ~ , , , , , , , , 
I I • • , , 
, I , , 
I , 

~-... -.-.------.c ...... -.-.............. . 

Now you can fill the compartments with text. 

~ Draw another galley at the bottom of the document. We will use this blank or 
empty galley to associate the text galley with both compartments. 

~ Place the pointer on the galley at the bottom of the Compose document. 

~ Press and hold down the mouse button. 

~ Drag the blank galley to the first (left) compartment and release the mouse 
button when the pointer is inside of the compartment. 

When the galley appears again at the bottom of the Compose document, you will 
move the blank galley into the second compartment. Follow the instructions for 
selecting the galley, drag it to the compartment on the right side of the page, and 
release the mouse button when the pointer is inside of the compartment. The 
compartments are now linked together. 

Now you can change the typestyle of the text that is in the galley and fill the 
compartments with text. 

~ Place the pointer on the text galley and click the mouse button. 

~ Choose Change fonts in Galley from the Fonts menu. 

~ Choose Change from: Apple Classic. 

~ Choose 12 point. 

~ Choose Change to: Cg Times. 
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Changing Linespace 

86 

~ With a point size of: 12 point. 

~ Kerning: Off 

~ Character Compensation: Book Set. 

~ ChooseOK 

~ Press down and hold the mouse button on the galley. 

~ Drag the galley into the left compartment and release the mouse button when 
the pointer is in the compartment. Text will merge into both compartments. 

r' Desk File/Print Edit Type Style Fonts Format If Page Layout Arrangement 

Change Fonts in Galley ... 
( cancel) iii!ii! 

Change From: 0 Apple MODEAN • Apple CLASSIC 

o B pt,20 pitch D 10 pt,12 pitch • 12 point 0 IB point 

o B pt, IS pitch 0 12 pt, 10 pitch 0 14 point 0 24 point 

Change To: 

o BRUSH 

o ROCKWELL BO IT 

o TRIUMVIRATE BO IT 

o CG TIMES BO IT 

With point size of: '2 

o ROCKWELL MO 

o TRIUMVIRATE 

• CG TIMES 

D CG OMEGA 

Kerning: • off 0 text 0 designer 

( Clear Entry) 

o ROCKWELL MO IT o ROCKWELL BO 

o TRIUMVIRATE IT o TRIUMVIRATE BO 

o CG TIMES ITALIC o CG TIMES BOLD 

( OK ) 

Character COll1lensation: 0 none • book set 0 ad set 0 tight set 

The basic document parameters, such as spacing and hyphenation, can be set 
from the Composition Defaults menu. 

~ Choose Composition Defaults ... from the Edit menu. 

~ Select Line Spacing number 5 to allow more space between each line. 

~ Choose OK to set aside the dialog box. 

r' Desk File/Print Edit Type Style Fonts Format If Page Layout Arrangement .., 

Compugraphic Composition Preference Sheet 

Hyphenation o • 
Off On 

Letter spacing ~ 
HtnHtx 

Line Spacing 00000.000 
Tight 0 8 Loose 
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Cut And Paste Text 

Every time you make a change in your document, the window on the screen will 
have to refresh, or repaint. To speed up this process and have the document 
window refresh faster, pull the lower part of the document over the galley area. 

~ Place the pointer on document view button on the right scroll bars. 

~ Press down on the button and drag it downward so the bottom of the 
document window is at the bottom edge of the desktop. 

1111,1 Confetence Release illill 

Moving selected text around on the page in a Compose document is similar to 
doing it in the other Lisa tools, except that you must remember to press the Apple 
key to get inside a compartment. You will select the first three words in the left 
compartment and move them into a new paragraph after the first sentence. 

~ Place the pointer in front of the "F" in Farmington. 

~ Press and hold the ~ key. 

~ Press and hold down tl}e mouse button. 

~ Pull the pointer through the text and stop after the" - ". 

~ Release the mouse button and the ~ key. 

~ Choose Cut from the Edit menu. 

Move the cut text after the first sentence in the document 

~ Place the pointer after the word Development. Make an insertion point. 
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Changing Fonts 

88 

Be sure to press the ~ key and the mouse button to get the insertion 
point inside of the compartment. 

~ Press the IReturnlkey 

~ Choose Paste from the Edit menu. 

The text will now be pasted into your document following the insertion point. 

\I'ltl Hlll (1Ilrllllllllll;ltlill!, 

,lillllllllll>-' ,I 11>-'\\ .,'"'rrJIldl III 

, L!lI.l~:,",JWllt D>-'\'c'ltljlJrl"IIt' 

To make the text of the first paragraph larger so it will appear as the title of the 
news release you will select the first sentence of the document and change the 
type size and style. 

~ Place the pointer before the "S" in Switch-On. 

~ Press and hold down the ~ key. 

~ Press and hold down the mouse button. 

~ Drag the pointer through the word "Development." 

~ Release the mouse button. 

~ Choose Cg Times Bold (if available) from the Fonts menu. 

~ Choose Other Cg Pt. Size from the Typestyle menu. 

~ Type 16 point in the dialog box. 

~ ChooseOK. 
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Setting 
Vertical Justification 

The paragraph has a lot of extra space in it because the paragraph alignment is 
set toJustify. With the text still highlighted, change the paragraph alignment. 

.. Choose center from the Format' menu to tighten up the spacing. 

Set Vertical Justification 
Clei.lr Vf.~rti«ll Justifit:al:iorl 1------1 

Clear Tab Stop .& 
Set Normal Tab .&{ 
Set Centered Tab .&1 
Set Right Flush Tab .&} 
Set Decimal ',' Tab .: 

hlSf!lt Wll,.,l Iln!~lk 

r:Jelete Word B,.el.lk 
kIord BrNks 

To change the linespacing of the first paragraph, which is still selected on the 
page, you will have to set .vertical justification. 

.. Choose Set Vertical Justification from the Format' menu. 

Small arrows will appear on the vertical ruler. These arrows will allow you to 
change the linespacing of the text. If you move the bottom arrow up, the space 
between lines will get tighter. If you move it down, the space will increase. 

.. Place the pointer on the bottom arrow . 

.. Press and hold down the mouse button . 

.. Move the arrow up about 1/8 inch to tighten the linespacing of the text in the 
title. Release the mouse button. 

wlfe - n .ommulU('~ Ilon. 

IinnOUDl~ Ii now oomillllI ill 

Mana, ment Development 
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· Changing Word Breaks 

Inserting Space Block 

90 

Scroll through your document and look at the word breaks that have occurred as 
a result of the automatic hyphenation. 

To change or remove one of the word breaks: 

~ Place the pointer where you wish the new word break to occur. 

~ Press the ~ key and click the mouse button. 

A blinking insertion point will appear in the text. 

~ Choose Insert Word Break from the Format Text menu. 

To delete a word break, you must place an insertion point on the word break and 
choose Delete Word Break from the Format Text menu. Scroll through your 
document to make certain that all of the word breaks are where you want them . 

Edit 

Clear Tab stq:I 
Set Normal Tab 
Set Centered Tab 
Set Right Flush Tab 
Set Decimal '.' Tab 

Make Space Block 

Extra space should now be placed between each paragraph of text. 

~ Place the pointer after the word Development. 

~ Press the ~ key and click the mouse button. A blinking insertion point 
will appear. 

~ Choose Make Space Block from the Format' menu. 

Two bold lines that mark the top and bottom of the space block will appear 
across the compartment. 

CgCompose2 
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Output Your Document 

The size of the SPace Block can be increased by selecting the bottom line and 
pulling it down. 

~ Select the bottom line and pull it down about Vi inch. When you have placed 
the pointer in the correct position on the bottom line and clicked the mouse 
button, the space block will appear to jump on your screen when it is 
selected. (Remember, press the ~key before you click the mouse button). 

~ Scroll through the document and add space blocks between each paragraph. 

Fi Ie/Print Edit Style Fonts Format !tU...l~~!/!!~!!!!;222~:!!. __ ~' 
IIII Confer ence Release IIII! 

!Ed~lcaticmal Sev:ices Divison will present a 
one - day seminar entitled You as a 

iL"1dl~~:J:. a practical worksrop for super­
who will 'ex! moving into manage-

To save your document and then print it. 

~ Choose Save and Continue. 

~ Choose Format for Printer from the File/Print menu. 

~ Choose High Resolution. 

Print your document on the dot matrix printer. If you're not sure how, 
instructions for printing your document are at the end of Chapter 1: Learning Cg 
Compose 2 and in this chapter under Output on Typesetter. 

~ Put your News Release document away. 
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Create a Brochure This chapter will cover two major variations of working in Compose, editing in 
the source document, LisaWrite, and printing your document in the landscape 
mode. In landscape on the 8400 and 8600 typesetter the text will be shifted 90 
degrees and will print across the width dimension of the page. To print the entire 
document, on a typesetter, you should output your document on 12 inch paper. 

When printing landscape on the EP 308 or the Image Writer the image will be 
rotated automatically to print across the wide dimention of the page. 

In this chapter you will: 

• Print in high resolution-landscape mode. 

• Plan a page layout. 

• Edit your document in the source tool. 

• Use space blocks to position text. 

• Arrange text by moving compartments. 

• Shade a compartment. 

When you are finished, your brochure will look like the one shown below. 

Switch-On 
Communications 

presents 

You as a Manager 

... a practical workshop for supervisors who will 
be moving into management positions. 

Tuesday, June 7, 1984 

8:00 am to 5:00 pm 

Sherwood Forest Inn 

Farmington 

Why Should You Attend 
One of the responsibilities of every supervisor is 
the management and training of employees. Most 
supervisors, however, have never been provided 
with the basic skills to enable them in making 
management decisions even though the next step in 
their career will be to become a manager. 

Who Should Attend 
This seminar is designed for supervisors, foremen, 
adrninstrative assistants, and other line managers who 
have on - going responsibility for the training and 
management of employees. "The persons who attend 
this seminar should be serious candidates for 
management positions." 

What Will You Learn 
The seminar is being offered as a practical workshop 
stressing the fundamentals of managing employees . 

• The move from supervisor to manager. 
• How do people respond to managers. 
• Communicating with people. 
• Being Strong - minded. 
• Management styles. 

Participants will return to their company with skills 
that will have an immediate impact on their ability 
to deal with other employees. 

CgCompose2 

The registration fee is $250.00 per person. 
Registration is limited to the first 30 

applicants. 
For further infonnation call toll free; 

1-800-222-222 

Just flll out 
the Registration blank 

below: 

Please enroll the following employees in 
Switch-On's management development 
course. Enclosed with this application is a 
check for the seminar. 



The Landscape Mode When you check Landscape in the Page Size dialog box, you must choose 
whether to output your document in high or low resolution. The decision you 
make at this time is critical, because it cannot be changed. You cannot even 
choose Undo Last Change from the Edit menu. The Format for Printer ... 
dialog box must agree with your original page size selection. The Personal 
Composition System will not allow you to make another choice. 

If you want to change the resolution, you can paste a compartment that was 
composed on a high resolution page to a page that is low resolution. The 
attributes of the new page size will apply to the page. 

Low Resolution Page Size 

When you choose LoRes Landscape you actually increase the number of 
characters that can be placed on the screen because the size of everything is 
reduced by approximately one third. This appears to increase the page size 
because the characters are smaller. This can be of great benefit if you wish to get 
more information onto your landscape page. 

High Resolution Page Size 

When you choose HiRes Landscape there is no change in the size of the 
characters on the page. Because there is no reduction, you can place 
proportionately less characters on the page. 

Later in this example we will choose landscape and High Resolution. 

r Desk FilelPrint Edit Type Style Fonts Format n Page Layout Arrangement ' 

PAGE SIZE 

You may now choose the. size you wish your Cg .Compou 2 plges to be. 
This will be the ONLY chance you will haye to make this decision 
for this document. Note: Be sure that the printing Preferences 
agree with the page size chosen hele. 

SIZE ... 
Letter 

8.5 x 11" • 

210 x 297mm 0 

ST'lLE ... 
Portrait 

FOR L.ftI)SCAPE ... 
LaRes 

o 

o 

L*I 
8.5 X 14" o 

211lnm x 12" 0 

Landscape • 
HiRes • 

NOTE: For t!lJl!setting, 1l.S"[292mm] is the maximwn width. 
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Editing the Source Tool 

94 

The basic text for the brochure is in the document Conference Draft that you 
used for the News Release. The directions for editing this text are found below in 
the marked up copy. If you have trouble following the mark up directions, there 
is a completed example on the next page. All of the text will be formatted in 
Apple Classic. You will change the type size and pitch to give you greater 
flexibility in replacing the Apple Classic fonts with your Cg fonts. 

Turn to the page following the completed example for more instructions. 
4- :t,f~ e-Te,. ... 1 

h •• iRlte ... Ma, !J8" ~.itch-on co •• uniCatiOn.;;;AA8I1A ••• a Aa. a .. lA .. 

1i1 "S, I •••• '" a. ele, .... l. nLI & '''eh a, Ezhnstluhcl &1 la •• Di ..... ~ 

., ,. ~pr ••• nt;.f ft •• IRa ~') s.=lh81 6iitlt16d(VOU as • MansaarA.!........ c~ 
,":t,.., practical .o.kshop fo. sup.rvisors .ho .111 b •• oving into lIanage ... n.t -e 

(V POsltiOns)y:" :!.f:...l . (W ... y SI.. .. IJ. y" .. Att."J.~ ~t:.~,,( DIC-d. ag to H'IloA ;a"ti611. s •• , ... OR .'al ..... ar •• A>,. fine Dr the 

4F- .esponsib11iti.s of .v •• y sup.rviso. is the .. anag ••• nt Ind training of 
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h. ..... WtO 1014 LeaP'''J __ • 
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The Edited LisaWrite 
Document 

Switch -- On Communications 
presents 

You as a Manager 
... a practical workshop for supervisors who will be moving into management positions 

Why Should You Attend 
One of the responsibilities of every supervisor is the management and training of employees. Most 

supervisors. however. have never been provided with the basic skills to enable them in making 

management decisions even though the next step in their career will be to become a manager. 

Who Should Attend 
This seminar is designed for supervisors, foremen, adminstrative assistants, and other line managers 

who have on - going responsibility for the training and management of employees. "The persons who 

attend this seminar should be serious candidates for management positions. /I 

What Will You Learn 
The seminar is being offered as a practical workshop stressing the fundamentals of managing 

employees. 

• The move from supervisor to manager. 

• How do people respond to managers. 

• Communicating with people. 

• Being Strong - minded. 

• Management styles. 

Participants will return to their company with skills that will have an immediate impact on their ability to 

deal with other employees. 

Tuesday, June 7, 1984 
8:00 am to 5:00 pm 

Sherwood Forest Inn 
Farmington 

The registration fee is $250.00 per person. 

Registration is limited to the first 30 applicants. 

For further information call toll free: 

1-800-222-222 

Just fill out 
the Registration blank 

below: 
Please enroll the following employees in 
Switch - On I s management development 
course. Enclosed with this application is a 
check for the seminar. 
Name ______________________ __ 

Title ____________ _ 

Name ______________________ __ 

Title ____________ __ 

Company ___________________ _ 

Address ____________________ _ 

City/Town __________________ ___ 

Zip Phone ____ _ 

ConfIrmation will be provided to all applicants. 
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Editing the 
Source Tool 

Open your Compose Examples folder. 

~ Open the Chapter 2 folder. 

~ Select the LisaWrite Conference Draft stationery pad. 

~ Choose Tear Off Stationery from the Conference Draft stationery pad. 

~ Name the document Brochure Draft 

~ Open the document. 

Perform the editing functions described in the copy marked-up on the preceding 
two pages. Place only one return between each paragraph. The text at the bottom 
of the edited draft is the Conference Registration blank, which you must add to 
your finished document. 

Examine your edited copy carefully. When your Brochure Draft on the screen 
looks like the finished one: 

~ Choose Save and Continue from the File/Print menu. 

~ Choose Select all of Document from the Edit menu. 

~ Choose Copy From the Edit menu. 

Put your document Away. 

Getling Startea 
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Page Size 

Making a Compartment 

10 get stationery for your brochure you must use Cg Compose 2 paper. If your 
paper is on the desktop you can select it and open it from the desk menu. 

~ Open the disk icon. 

~ Select the Cg Compose 2 Stationery Pad. 

~ Choose Tear Off Stationery from your Cg Compose Stationery pad. 

~ Name the new document Conference Brochure. 

~ Open the Conference Brochure document. 

When the Page Size dialog box appears on the screen: 

~ Choose Letter Size. 

~ Choose Landscape for the style. 

~ Choose High Resolution. 

~ Check OK. 

File/Print Edit Type Style Format Text Page Layout Arrangement 

PAGE SIZE 

You may now choose the size you wish your Lisa Compose pages to be. 
This will be the ONLY chance you will have to make this decision 
for this document. Note: Be sure that the printing Preferences 
agree with the page size chosen here. 

SIZE ... ~ 
Letter • 8\e~aI14" 0 

QD 
8.S x ll" 

210 x 297mm 0 2l0mm x 12" 0 

STYLE ... 
Portrait 0 Landscape • 

FOR LRNOSCRPE ... 
LoRes 0 HiRes • 

Make a galley at the bottom of the Compose document. 

~ Place the pointer at the bottom of the Compose document. 

~ Draw a rectangle at least 1 inch by 1 inch. 

~ Choose Paste from the Edit menu. 

~ Choose Show Rulers from the Page Layout menu. 
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Note: The displaying of the rulers causes the document to scoll up and to the left a little bit. 

The overall width of the page is 11 inches. To divide the document into three 
equal columns, you can make three compartments 3 inches wide, 6 inches deep, 
and allow a Y2 inch margin between each compartment and the edge of the page. 

~ Choose Make a Compartment from the Page Layout menu. 

~ Draw your first compartment 1 inch from the top and Y2 inch from the left 
margin. Draw the compartment so that the bottom is on the 7 inch mark on 
your page. 

r~ ~ 

....... , ". : ... , ....... : ... , ....... : .. , .. ,. 
: : : · . . · . . · . . · . . 

~ .................. ( ..................... : ....................... : ............ .. 
1 

·1 
.1. 

. ......... ,:' .......... ; .... , ...... : ...... . 
· . . · . · . · . · . . , ............... i ........... , ......... , . ~ ... , ................... ~ .......... , .. . 
· . . · . . 
: : : ...... , ... ,:., ., ... , ... : .. , · . · . · . · . · . · . 
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Matching Compartments You can draw two identical compartments at the 4 and 7lh inch marks quickly by 
using a couple of shortcuts. 

~ Press and hold the ~ key. 

~ Press the letter M on the keyboard. Notice that the pointer becomes a symbol 
for drawing compartments. 

Begin the first compartment 1 inch from the top and 4 inches from the left 
margin. Draw this compartment about 1 inch by 1 inch. Do the same thing at the 
7 V2 inch mark as show in the figure below. 

~ Press and hold down the IShiftl key. Then select all three compartments. 

~ Release the IShiftl key. 

~ Choose Align Objects ... from the Arrangement menu. 

~ Choose Align •.• tops then Ok. 

~ Return to the Align Objects .•• menu and choose Match •••• Tallest from the 
dialog box. Choose OK. 

~ Return again to the Align Objects and choose Match ...• Widest, then OK 
from the dialog box. 

~ Choose Lock in Place from the Arrangement menu. This will place the 
compartments on the page so they can not accidently be moved. 

,.. Desk Fill!lPrirt Edit 

· . , .. , .......... ". " ... , ........ , ....... , ..... . · . · . · . · . · . 
....... ".: .......... ,-----.. --s- .... - .. · .... t .. ·· .. ····:· .. ···· .. ,. , ....... ": .... " ........ . 

, ' , , 
..... : , .... ~ i., ... : ............ , ...... . , , , , 

. I ~' 

...... ": .......... ~P ........... """Iii ........... ,."I'~,, ........ : .......... " ............ " .... " ........... c ... ,·,,'''' .. 
· . 

~~ .... , ........... , ..... ,.,., · . · . · . · . · . · . · . 
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Changing Fonts in Galley 
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You can change the fonts of the text from your Brochure Draft before merging 
the text into the compartments. Because you have used a different point size for 
the titles, subheadings, italic, bold and paragraph text, you can select each 
individual Apple Classic point size and replace it with a different Cg font. 

Note: If you do not bave tbe Cg Times bold, Italic, and Bold Italic, you can substitute your own 
fonts if you cboose. You can also apply tbe pseudo bold and italic from tbe rype Style menu 
after tbe text is merged into tbe compartments. 

1 Select the text galley. 

2 Choose Change Fonts in Galley ... from the Fonts menu. You will make 
several different font changes. 

~ Choose Change from: Apple Classic 24 point. 

~ Choose Change to: Cg Times Bold. 

~ Choose With point size of' 24 

~ Choose Kerning: Text 

~ Choose Character Compensation: none 

~ Choose Ok. 

,. Desk FlielPrlrt Edit T style Fonts Format: U Page LII,IOIt In'angemert 

Change Fonts in Galll!l,l ... 

Chill'lgl! From: o Apple MODERN 

08 pt,2D pitch o ID pt,12 pitch 

o 8 pt,15 pitch o 12 pt,ID pitch 

Change To: 

o BRUSH o ROCKlIELL HD 

o ROCKWELL eo IT o TAILI1VIRRT! 

o TRILI1VIRRT~ eo IT o co TIH~S 
o co TII1I:I eo IT o co OI1EQR 

With polrt size of: [~:~::I 

Kerning: 0 Dff • text 0 designer 

( Clncel ) 
• Apple CLfISSIC 

012 poirt 018 poirt 

014 point .24 polrt 

o RDClMLL PI) IT 

o TRILI1VIRR~ IT 

o CG TlICS ITALIC 

( ClearErtI1l ) 

o AOaaILL eo 
o TAILI1VIRRT~ eo 
• co TIICI BOLD 

Olaracter Compensation: • none 0 book set 0 ad set 0 tight set 
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Merge Text 

Making a Space Block 

3 You will make choices from the Change Fonts in Galley ... dialog box 
similar to these 5 more times. You will always choose Apple Classic, Text 
Kerning and no Character Compensation. You will change the following 
fonts as follows: 

~ 18 point Classic to 18 point Cg Times Bold. 

~ 14 point Classic to 18 point Cg Times Italic. 

~ 12 point Classic to 10 point Cg Times. 

~ 12 point 10 pitch to 12 point Cg Times Bold. 

~ 10 point 12 pitch to 10 point Cg Times Italic. 

Now you can merge text from the galley into the compartments. 

~ Place the pointer on the text galley at the bottom of the document. 

~ Press the mouse button and drag the galley into the first (left) compartment. 

~ Release the mouse button. 

Text will automatically merge into the compartment. If you look at the 
completed Brochure example you will note that now there is more text in the 
compartment than will appear when the brochure is finished. You will have to 
insert some space into the compartment to move text out of the column. 

~ Choose Hyphenation ... Off from the Composition Defaults dialog box on 
the Edit menu. The Brochure will look better without word breaks. 

~ ChooseOK 

To make a Space Block after the word presents, place an insertion point on 
paragraph return. 

~ Place the pointer just after the "s"in the word. 

~ Press the ~key and click the mouse button. 

~ Choose Make Space Block from the Format' menu. 

~ Release the mouse button 

~ Press and hold the ~key as you place the pointer on the bottom line of 
the space block. 
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III Confer ence 6r ochur e IIIIII 

..... ,' ...... , .... ,' ,., ., ........ , ....... , .. ,. 

~ Press and hold the mouse button. 

~ Drag the bottom line of the space block down until you get to the 3 inch mark 
on the page. Release the mouse button. 

~ Scroll down so that you can see more of the first column. Place a space block 
between the word Manager and the words a practical. 

~ Place the pointer on the return after the word manager. 

~ Press the ~key and click the mouse button. 

~ Choose Make Space Block from Format' menu. 

~ Drag the bottom line of the space block to the 5 inch mark on the page. 
Remember to use the ~ key to get into a compartment. 

~ Insert a Space Block after the word positions and drag it to the bottom of the 
compartment. Later you will place a compartment over this Space Block. 

When the rest of the text is moved out of the column (it should appear on the 
Galley), select the first compartment and choose Break Compartment Links 
from the Page Layout menu. Text from the Galley will no longer be associated 
with this compartment. The text will not automatically merge between the 
compartment and the galley. The galley is available to merge text into a new 
compartment that will not be linked.) 
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Placing Rules 

• , • • , I 

! 

I111 Confer ence Br ochlll e 111111 

. ", a practical warkshop 10r S1Ipe:MsOIS 
who will be moviIIg into maregement : 

pos:ltions. 

You will now insert four rules on the page to set off the title of the brochure. You 
will use 1.5 pt. rule for the first thin rule on the top and 4.0 pt. rule for the 
thicker one. You will have to deselect each rule after you draw it so you don't 
change the rule size. 

~ Select the rule size from the Page Layout menu. 

~ Draw each of the rules as shown below. If the rule is not where you want it, 
place the pointer on it, press and hold the mouse button and drag the rule 
into position. If the rule is not the right size, place the pointer on one of the 
end handles and resize it. 

~ Click elsewhere on the page, and then select the new rule size and draw the 
other rules. 

If you have trouble placing and aligning, you may want to try these features: 

~ Use duplicate to get the exact same size. 

~ Turn off the Auto-grid to place one of them correctly on the page. 

~ Use Align sides to make them flush with the compartment edge . 

. .... , .. l , 

You as a Manager 

'===== , 
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III, Confctt't1cf' BtO!ilJtC 111111 

You as a Manager 

Move the text galley into the second (middle) compartment. 

~ Place the pointer on the galley. 

~ Press and hold the mouse button. 

~ Drag the galley to the compartment and release the mouse button when the 
pointer is inside the compartment. 

Insert thee space blocks into the text. Put one between each paragraph of text. 

~ Insert a space block after the word manager at the end of the first paragraph, 
one after the word positions at the end of the second paragraph, and one 
after the word styles. You will size these space blocks so that the sentence that 
ends other employees is placed at the bottom of the compartment. 

~ Choose Break Compartment Links from the Page Layout menu. 
To make the column on your screen look like the figure on the page, you may 
have to insert space, or take a out little space before you go on to work on the 
final column. 

Communications 
presents 
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Moving Compartments 
Filled with Text 

There are other methods for moving text around on the page. For example, 
instead of inserting space blocks, you could insert returns to make extra space on 
the page. 

Another method is to place each component of the page layout into separate 
compartments. You can then move the compartments around to design the page 
the way you want. 

At the top of the third (right) compartment, make a small compartment inside of 
the one that is already drawn. 

~ Choose Make a Compartment from the Page Layout menu. 

~ Draw the compartment as shown. 

~ Merge text from the galley into the smaller compartment. 

~ Resize the compartment so that it contains only the text for this segment. 

Move this new smaller compartment to the bottom of the first column. You can 
position it over the space block that you have inserted. 

~ Place the pointer into the small compartment, then press and hold down the 
mouse button. 

~ Drag the compartment to the first column and place it so the last line is even 
with the last line in the middle (second) column. 

style Fonts Fonnat u~=~=~~Z=~ __ ~., ,.. Desk File/Print Edit 

II Confer enee 6r oeh II e IIIII 

..... , .. ,." .. , ...... , ....... . · . · . · . · . · . · . · . , 
! 'f······--'"Tiie&laY;··fune·7:T9tI~r·-·-···i' 

~ 8:00 am to 5:00 pm ~ 
: Sherwocxi Forest Inn : 
~ ........ -.. --.. --!.~!~\Q!!'-.. ---.... -... ~ 
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You can layout each segment of information by making a compartment large 
enough for the information and positioning the compartment where you want it 
on the page. The third (far right) column is divided into four segments. 

Look at the example of the finished brochure at the beginning of this exercise. 

~ Choose Make a Compartment from the Page Layout menu. 

~ Draw another small compartment the same size as the last one at the top of 
the third column. 

II i Confer etlce BI oehut e II 

, ........................................... -_ .. -.... -.-.. 
1 : 

l : 
i ! 
1 : 
.............................................................. \ 
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Using Shading 

~ Merge the text from the galley into the new smaller compartment. 

~ Resize the compartment to contain only the three sentences in italic. 

~ Make three more new compartments under the smaller one in the third 
column that you have been working in. 

~ Fill each of these compartments with text. 

You may have to change the paragraph alignment, the size of the compartments, 
or insert word breaks to make your brochure look more attractive. Put the 
finishing touches on the text in the third column to your own liking . 

.. r'!!!iDjlieiiilsk.F.iI.el.Pr.iiiint.Eiiiid.itlllllllliiiiiii Style Fonts Format u ____ • ______ IIiIIIIIII""I 
1111 ConFer enee Sr oeh.u e 111111 

r···T.!iii·i~"iSf.iii'fkiii]eii"Js·r2r.r():(I(,}pJ;1 
: peJ:lml. R<'listJtithlJl is liJllitat III the.: 
: :tJ~1: J:) ,ippliC<'iJ!IIs. i' ' 
: Fel]' fll11.heJ' iJiil1JmitiLl1! cdIl toll ill.'!L'!: 
i 1 -800 -222 - 222. i 
, ' , , 
~ .... -....... -.......•... -............ -.................................. .) 
[_·········TifslTiIT·ourlfie·············j 
j Registration blank I, 
! below: i i' 
iPJease enroll the following employees! : : 
h Swt:itch - Onls management f :: .. 

tlevelopment co'\USe. Enclosei with ii, 
lads application is a check for the ii' 
~m~. ! 
!_ ................................................................ J 

The compartment at the bottom of the page containing the registration blank 
may seem to be a problem because of the lines. If the lines are too long to fit in 
the compartment, place an insertion point at the end of the line and use the 
backspace key to take out the extra segments of the line. If you place a blank 
space or two (press the spacebar) between the word, such as Name and the line 
you can make the lines be flush on the right side of the compartment. You may 
remove the entire line and use rules in the registration blank. 

Select all the text in the last compartment of the final column, which is the entry 
blank. Make this text bold. 

~ Place the pointer in front of the text you want to select. 

~ Press down and hold the ~key. 

~ Press down and hold the mouse button. 
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~ Drag the pointer through the entire paragraph of text. 

~ Choose Bold from the Typestyle menu. 

To place shading in the final compartment: 

~ Select the compartment by placing the pointer on it and clicking the mouse. 

~ Choose Shade Objects from the Arrangement menu. 

~ Choose Lt. Gray from the dialog box that appears. 

~ Choose OK to put aside the dialog box. 

You can use shading in any compartment. 

,.. Desk File/Print Edit Fonts Format 1f 

Shade CIIjects ... ( cancel) 

o None 0 W'hite ....a Lt. Gray 0 Gray 0 Ok. Gray 0 Black 

( OK ) 

~ Choose Save and Continue from the File/Print menu. 
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Typeset the Brochure To print your brochure you must have High Resolution and Landscape 
checked in the Format for Printer dialog box. The Format for Print menu must 
dmatch the Page Size menu you completed when you opened the document. 

If you do not have these items checked and you try to print, you will receive an 
error message instructing you to change the Format for Printer dialog box. 

You also must have 12 inch paper in your typesetter to print out your entire 
document. Even if you do not have 12 inch paper, you may want to print it out to 
see how your typesetter handles landscape for future Compose documnents. 

~ Choose Format for Printer from the File/Print menu and make the 
appropriate changes. 

~ Choose Print from the File/Print menu. 

~ Choose OK. 

~ Put your document away. 

Note: For more information about Typesetting, see tbe Getting Started section on printing, or 
cbeck tbe chapter on your type of output device. 

,. Desk ..... Edit" Tp stule Format Ir Page Laycxt 

Format for ~aphic 8400 T~ - serial port A 
Paper Size 

• Letter (8.5 x 11 ") o Legal (8.5 x 14") o A4 (210 x 297mm) 
0210mm x 12" 
o Special Paper Size 

Printing Orientation 

&g 
Printing Quality 

• High Resolution 0 Low Resolution 

Search Spelling 

~ ( New Printer...) L!!LJ 

,. Desk .. , •• Edit Tp stule Fonts Format Ir Page I.aIpt lUangement 

Print on Compugraphic 8400 T~er - serial port A [ cancel 
Pages to Print 

.AII Pages OOno/ pagesT'"'---'-"'--'j Through: i---"--l _____ . L--~ 
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Introduction 

Desk Menu 

This chapter is an overview of Cg Compose 2 operations. It is a reference to what 
you can do in Compose through an explanation of the menu items. For step-by­
step procedural instructions on the use of these menu items, turn to Chapters 1 
and 2. 

The Cg Compose 2 menus are shown in the menu bar at the top of the screen. If 
you choose a menu item that is followed by an ellipsis ( ... ), you will get a dialog 
box with additional information and choices. Following the explanation of each 
menu will be a section covering the dialog box items associated with the menu. 

When a menu item is shown in gray instead of black, you cannot choose it. This 
is usually because it does not apply to the current selection. Some of the items in 
each menu may have a check mark next to them. This indicates that the item is 
currently active for the highlighted object or text. 

The Desk menu lists all of the icons and 
documents on your desktop. To open 
the document or icon, choose the icon 
name from the menu. The checkmark 
indicates the icon is currently open as a 
window display. 
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File/Print Menu 

114 

Set Aside Everything Returns all 
windows to their icons without saving 
the contents. 

Set Aside "Document Name" Returns 
the current document to its icon 
without saving the contents. 

Save & Put Away Saves the contents of 
the document, closes the window, and 
returns the icon to its original location. 

Save & Continue Saves the contents of 
the document and leaves the window 
open on the desktop. 

Revert to Previous Version Returns 
the document to its state as of the last 
time you saved it. 

Set Aside Everything 
Set Aside "testl" 

Save & Put Away 
Save & Continue 
Revert to Previous Version 

Print As Is 
Format for Printer ... 
Print ... 
Monitor the Printer ... 

Print As Is Allows you to print the document open on the desktop immediately. 
No additional print options can be be selected. The default printer will be the 
output device. 

Format for Printer . .. Sets formats in the document based on the printer that 
will be used. 

Print . .. Prints the document. 

Monitor the Printer . .. Shows the status of the document printing. 
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Format for Printer ... 

EP308 

This dialog box allows you to format the current document for the output device. 
The Printer Format remains with the document when it is stored. The choices 
will vary depending upon the type of output device. The items include: 

Format for EP 308 Printer - serial port A This item identifies the type of 
output device for this document format. It also identifies the port where the 
output device is connected. If the output device is not connected, the dialog box 
will indicate the message, Not presently connected. Cg Compose 2 documents 
may not be output on a Daisy Wheel printer. 

Paper Size Choose the paper size you wish to use. This size must also be chosen 
from the Page Size dialog box when the document is first created. 

Printing Orientation Portrait printing allows for upright or narrow printing 
and Landscape allows for sideways or wide printing. This must match the 
orientation you chose when the document was first created. On this menu the 
orientation is shown in picture symbols. 

All documents are automatically printed in High Resolution on the EP 308. 

New Printer ... Allows you to select another output device from a dialog box. 

,. Desk '.aiM' Edit Type Style Fonts Format II 

Format for (ompugraphic EP308 - serial port A 
Paper Size 

• Letter (8.5" x 11 ") 
D Legal (8.5" x'14") , 
DA4 (210 x 297mm) 
D210mm x 12" 

Printing Orientation 

II El ~ _. E:JD 
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8400, 8600 typesetter, 
& ImageWriter 

Format for 8400 - serial port A This item identifies the type of output 
device for this document format. It also identifies the port where the output 
device is connected. If the output device is not connected, the dialog box will 
indicate the message, Not presently connected. 
Cg Compose 2 documents may not be output on a Daisy Wheel Printer. 

Paper Size Choose the paper size you wish to use. This size must also be chosen 
when the document is first created. 

Printing Orientation Portrait printing allows for upright or narrow printing 
and Landscape allows for sideways or wide printing. This must match the 
orientation you chose when the document was first created. On this menu the 
orientation is shown in picture symbols. 

Printing Quality Low Resolution gives you a little faster printing, but High 
Resolution gives you much better quality printing on the 8400 or 8600. 

Note: If you choose Low Resolution and Landscape, the document size will be reduced by 
approximately one third when printed. 

New Printer ••. Allows you to select another output device from the printers 
that are listed. 

,.. Desk I""~.' Edit Type Style Format n Page Layout Search Spelling 

Format for Compugraphic 8400 Typesetter - serial port R 
Paper Size 

• Letter (8.5 x 11") 
DLegal(8.Sx14") , 
DA4(Z10 xZ97mm) 
DZ10mm x 1Z" o Special Paper Size 

Printing Orientation 

o a 
... EJD 

Printing Quality 
• High Resolution 0 Low Resolution 
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Print ... 

EP308 

8400, 8600 typesetter 

This dialog box allows you to specify some final choices about how the 
document should print. The choices will vary depending on the output device. 
The items include: 

Print on EP 308 Printer - serial port A This item identifies the type of 
output device on which the document will be printed. The item also identifies 
the port where the output device is connected. 

Pages to Print Allows you to print all pages or select a range of pages to be 
printed in the document. 

Number of Copies Select the number of copies you wish to print. 

Collation Allows you to output collated documents 

Media Input Allows you to feed single pages of special sized paper into the EP 
308 manually. 

r' Desk "@.' Edit Tille Style Fonts Format II Page L¥ut Arrangement 

Print on Compugraphic EP308 - serial port R Cancel 

Pii ~II~~~ es D Ono/ pag es: [~:~~::,:~:J Throug h: [,::,=,~:~,~:,::,:~] 
NII'rIber of Copies ,_,.,,_'"' __ ' ___ ''' 

.[!J[!J0IIlITl[I]ITlITJrill D other: L, ____ """',,..1 
(Dilation 
,D Pages Collated • Pages Not Collated 

Media II1JUl: 
• Automatic Feed 0 Manual Feed 

OK 

Print on 8400 Typesetter - serial port A This item identifies the type of 
output device on which the document will be printed. The item also identifies 
the port where the output device is connected. 

Pages to Print Allows you to select all pages or the range of pages you wish to 
print. 

r' Desk ..... Edit T~ Style Fonts Format 11 Page I.8I,jOIt Arrangemert 

Prlrt on Compugrjlphic 8400 Tpsetter - serial port R cancel 

PI!!!. to Prirt ----. 1""'---"'-
.AII Pages DOnly pages:L __ iThrough:~I_J 

11K 
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Monitor the Printer ... 
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Print on ImageWriter Printer - serial port B This item identifies the type 
of output device on which the document will be printed. The item also identifies 
the port where the output device is connected. 
Paper Feed Allows you to indicate whether you are printing on a single sheet or 
a continuous pin fed roll of paper. 

Number of Copies Select the number of copies for your printer. 

Pages to Print Allows you to print all pages, or select a range of pages to be 
printed in the document. 

,.. Desk 'M,.' Edit TUPe style Fonts Format If Page Layout Arrangement 
, 

Print on lmegekltiter Printer - serial port B Cancel 

Paper Feed 
• Fanfold 0 Single Sheets 

IUnber of Copies 
.1!J000ITl0ITl[!][ill 

Pages to Print r'"-'""·'·"""""'"""' r"""'""""""""'·""''"'" 

• A II Pa 9 es 0 On Iy pa g es: ,-","_.,.,.,.,_,""j T hroug h=l.."",_,.,_",,,,",,,,".i OK 

This dialog box displays the current status of the output device. If you are 
printing a Compose document you will not have access to this menu during the 
printing cycle. You will not be able to perform other work on the desktop. 

Note: You will only be able to terminate printing a Compose document from the output 
device. 

You may also display this dialog box if you are having trouble with the printer. 

,.. Desk ..... Edit 

Printer 
Imagowrit .. I II DMP 
Ink Jot Printor 
Daisy Wheal Prinhr 
EP308 Prinhr 
Cg8400 TypeSettir 

, Cg Compose 2 

TUPe style Format If Page Layout 5eardI Spelling 
, 

( Cancel RII Printing ) 
Connection Printing in Progress It'IIlting 

... ial port B 

(Not pr ... ntly conn.cto~!) 
(Not presently connlctad!) 
urial port A 

(Not PriUntl y connlctld!) 



Edit Menu Undo "Last Change" Restores the 
document to its state before the last 
operation. The last operation will 
appear in quotes. 

Cut Removes the current text or object 
selection from the galley or page and 
places it on the clipboard. 

Undo "Copy" ttz 

Cut 
Copy 
Duplicate 
Paste 
Clear Copy Copies current selection onto the 

Clipboard. Does not remove the I ............................. ·" .... · .. · .......... ,· .................... · ........ ,,· ....... , ...... · .. ,,'. 

original. Select All of Text 
Select All Compartments 

Duplicate Creates an exact copy of the Select Page 
object on the document. Select all of Document .A 
Paste Inserts whatever is on the 
Clipboard into a selected galley or 
insertion point on the page. 

Clear Removes the current selection 
without changing the Clipboard. You 
will get the same result if you press the 
ICleaijkey on the right-hand keypad. 

Select All of Text Allows you to select 
all text in a highlighted compartment. 
You can select text in more than one 
compartment if they are linked together. 

Select All Compartments Highlights 
all compartments on current page. 

Select Page Selects everything on page. 

Select all of Document Selects the 
entire document. 

Go to Page . •• Allows you to go 
directly to the page you indicate. 

Accept page? Allows you to accept the 
design and editing of the page so you 
can design or edit another page. 

Composition Defaults . .. Sets 
defaults for current page. 
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Go to Page ... 

Composition Defaults ... 
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Allows you to go directly to the page you specify. 

,.. ~ FlielPrlnt Edit T Ie Fonts Format If PlICJe Layout ArrangMlellt 
, 

Go To P-... : .... -"."."., 
~ l'_'_'_'~".".i 

This dialog box allows you to define the Composition Defaults for the current 
page you are working on. 

Hyphenation Turns the automatic hyphenation on or off. 

Letter spacing Defines the minimum and maximum letter spacing for justified 
text in a compartment. 

Line Spacing Sets the overall line spacing on the page. To vary line spacing on a 
page, use VerticalJustification or Space Blocks in the Format' menu. Each 
number equals one point. 

Word spacing Defines the minimum, preferred, and maximum wordspace for 
text in a compartment. Prefered will be the default when text is not justified. 

Point Sizes Defines the point sizes that will be available on the Typestyle menu. 

Rule Weights (in points) Defines the rule weights, in half point increments, 
available on the Page Layout menu. You may draw a rule from one-half point to 
128 points. 

Set Compugraphic defaults Returns all the settings in the dialog box to the 
Compugraphic defaults displayed below. 

,.. ~ . FIII!IPrIIt Edit TIP! stull! Fonts FOIlI'IiII: 11' Page li\uOIt Arrangemert 

~aphic ean.mitillll Preference 5heet 

I¥henatillll D. 
Off o. 

LirrSpai:ing 00.000000 
Tight 0 1 t I 4 5 & 7 t Loo .. 

Word spacing I I II I I II II I I II II I I II II I II I I II 

Poilt Sizes 

Rule It'ei!llts 
[in points) 

1 

tit. t tttc 
Pref 

18 : 2 : 10 i 3 112: 

Set ~lIPhic dl!flllits ) 
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Type Style Menu 

Other Cg Point Size ... 

Plain Text Removes underline, bold, 
italic, subscript, and superscript from 
text that is selected. 

Underline, Bold, Italic Adds the 
attributes of underlining, bold, or italic 
to selected text. 

Superscript Changes the baseline of 
selected text to make it above the normal 
text baseline. 

Subscript Changes the baseline of 
selected text to make it below the 
normal text baseline. 

Apple "?" point Allows you to change 
the size of the Apple Classic or Modern 
typestyle you are using. In addition to 
the size, you may specify the pitch 
(number of characters per inch), or 
proportional spacing from the items 
shown on the menu. 

Cg "?" point Allows you to indicate 
the point size of the Compugraphic type 
face that you have selected from the 
Fonts menu. The point sizes that appear 
on this menu were designated in 
Composition Defaults dialog Box. 

Underline 
Bold 
Italic 
Subscript 
Superscript 

Apple 8 Point 20 Pitch 

Apple 8 Point 15 Pitch 
e 10 Point 12 Pitch 

Apple 12 Point 10 Pitch 
Apple 12 Point PS 
Apple 14 Point PS 
Apple 18 Point PS 

Apple 24 Point PS 
(g 9 Point 

10 Point 
(g 12 Point 
(g 18 Point 
(g 24 Point 
(g 36 Point 
Other (g Pt. Size ... 

Other Cg Pt. Size. .. Allows you to indicate a point size other than those 
currently appearing on the menu. You may choose from 6 to 72 point type. 

This dialog box can be called to the screen when you have text selected or the 
pointer in the text insertion mode. The point size of new or selected text will be 
changed to the number indicated in the box. The point size may range from 6 to 
72 point type. 

r Desk File/Print Edit Type Style Fonts Format 1f Page Layout Arrangement 

Other [g Pt. Size... [I 
: ............ , 
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Fonts Menu 

Other Cg Fonts 
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Apple 'Modern' and Apple 
'Classic These two font menu 
selections are the same choices available 
in the other tools. When you select text 
or make an insertion point, the font will 
be changed to the Apple font you select. 

Cg Fonts This menu will vary 
depending on the fonts you purchase, 
and which ones you select to appear on 
the menu. The Cg font menu selections 
are available only in Compose. When 
you select text or make an insertion 
point, the font will be changed to the Cg 
font you select. 

Other Cg Fonts. .. Allows you to 
view all of the fonts you have stored on 
the Disk and designate a font change to 
an insertion point or text that you have 
selected. 

Replace Menu Fonts . .• Allows you 
to view a dialog box that contains all of 
the Cg Fonts loaded onto the Disk. It is 
used to designate the fourteen fonts that 
will appear on the Fonts menu. 

Change Fonts in Galley . .. Allows 
you to view a dialog box that changes 
the typestyle of the text in the galley. 

TXTBK 
BRUSH 
ROCKWELL MO 
CG OMEGA 
ROCKWELL BD 
ROCKWELL BD IT 
TRIUMVIRATE 
TRIUMVIRATE IT 
TRIUMVIRATE BO 
TRIUMVIRATE BD IT 
CG TIMES 
CG TIMES ITALIC 
CG TIMES BOlD 
CG TIMES BD IT 
Other Cg Fonts ... 

Replace Menu Fonts ... 

This dialog box shows all of the fonts that are loaded on the Disk. If you want to 
indicate a font not shown on the menu, select the font and OK. 

"Desk FllelPrlnt Edit T Ie Fants 
., 

OTI£R ca FOOS ... ( ClMeI ) 11K ) 

• BRUSH o CG OMEGA o CG OMEGA BO IT 

o co OMEOA BOLD o co OMEOA ITALIC o CO TIMES 

o CO TIMES BD IT o CG TIMES BOLD o CG TIMES ITALIC 

o ROCKWELL Bo o ROCKWELL Bo IT o ROCKWELL Mo 
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Replace Menu Fonts ... This dialog box shows all of the fonts that are loaded on the Disk. The fonts that 
are displayed on the Fonts menu are checked. Up to 14 fonts may be selected and 
displayed on the menu. 

Reset Allows you to return the selections back to the setting that was displayed 
when the menu was opened. The dialog box remains on the screen. 

Clear Allows you to remove the check marks in front of all of the fonts. 

Cancel Removes any changes made since the box was brought to the screen. 
When selected, the dialog box will go away, and the menu will look as it did 
before the dialog box was chosen. 

OK Invokes the most recent selections and removes the dialog box. 

,.. Desk File/Print Edit Type Style Fonts Format U Page Layout Arrangement .., 

Replace Menu Fonts ... Reset ) ( (lear ) ( (ancel ) ( DK ) 

.. BRUSH .. CG OMEGA o CG OMEGA BD IT 

o CG OMEGA BOLD o CIl OMEGA ITALIC .. CG TIMES 

.. CG TIMES BD IT .. CG TIMES BOLD .. CG TIMES ITALIC 

.. ROCKWELL BO .. ROCKWELL BO IT .. ROCKWELL MO 

.. ROCKWELL MO IT .. TRIUMVIRATE .. TRIUMVIRATE BO 

.. TRIUMVIRATE BO IT .. TRIUMVIRATE IT 

~ 
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Change Fonts in Galley 
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This dialog box allows you to select text on the galley that is in an Apple typestyle 
and change it to a Cg Font. This allows you to change the font before it is merged 
into the Compose document. 

Change From: Allows you to select the specific typestyle that is on the galley by 
designating the size and pitch of the text. 

Change To: Allows you to designate the name of the font you want applied to 
your Selection. 

With point size of: Allows you to designate the size of type from 6 to 72 point. 

Kerning: Allows you to designate the type of kerning that you want applied to 
your selection. You can choose Text, the standard kerning, and Designer, which 
will reduce more space between certain letter combinations. 

Character Compensation: Allows you to designate the how tight you want to 
set the spacing between all charcters in the text that you have selected. The 
spacing gets tighter as you move toward the right. 

Clear Entry Removes the check marks that you have placed in the Change 
To:,Kerning:, and Character Compensation: items. 

,.. Desk FlielPrlnt Edit T Ie Fonts 

Change Fonts In GllIlIt"I .. , 

ChInge From: • Apple MOIIEFtI 0 Apple D.RSSIC 

o B pt,20 pitch 0 10 pt,12 pitch • 12 paint 0 lB point 
o B pt,lS pitch 0 12 pt,10 pitch 0 14 paint 0 24 point 

ChInge To: (Cleaf Entl"\l) 

o BRUSH 0 IIOCI<I'I!LL HD o RDCIMLL til IT 0 _ELL ID 

o _ELL ID IT 0 TAIUHVIIlATE o TAIUHVIRRTI IT 0 TAIUHVIRRTlID 

o TAIUHVIIlATE ID IT 0 co TlMEI o em TlIII ITALIC 0 co TlIII IOLO 

o cm TIIII ID IT 0 co DI1EIIA 

With point size of: [""''''j 

Krmlna: • ofF 0 text 0 designer 

Clw"acteT C~lon: • none 0 baok set 0 lid set 0 tight set 
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Format, Menu 

r 
T ..., 
..... 

• ..... 
I 

Left, Center, Right, Justify Aligns 
highlighted titles or paragraphs of text 
with the sides of the compartment. 
Justify aligns both the left and right sides. 

Set Vertical Justification Allows you 
to change the line spacing of selected 
text. Move the bottom arrow on the 
ruler to change the spacing. An equal 
amount of space will be applied to each 
line of text. 

Clear Vertical Justification Removes 
VerticalJustification from selected text. 

Clear Tab Stop Removes the tab stop 
identified by the black triangle. 

Set Normal Tab Stop Sets left-flush tab 
identified by the black triangle. 

Set Centered Tab Sets centered tab 
identified by the black triangle. 

Set Right Flush Tab Sets right-flush tab 
identified by the black triangle. 

Set Decimal ' , 'Tab Sets a tab stop that 
will align decimal points. 

Set Comma' , 'Tab Sets a tab stop that 
will align commas. 

Set Tab Fill , " Allows you to 
designate a character pattern, such as a 
period, that will be inserted between 
items in columns separated by tab stops. 

Center 
Right 
JustiFy .J 

Vertical JustiFication 
Clear Vertical Justification 

Clear Tab Stop .-
Set Normal Tab .{ 
Set Centered Tab ., 
Set Right Flush Tab .} 
Set Decimal ',' Tab .: 
Set Comma ',' Tab .; 
Set Tab Fill .. , 

Insert Word Break 
Delete Word Break .0 
Show Word Breaks 

Make Space Block 
Compress Text .. , 

Insert Word Break Places a hyphen that will break a word at the end of a text 
line. The insertion point you indicate must break the word at a logical place 
determined by basic hyphenation rules and how the line will look when it is 
justified. If the word you attempt to break is not logical, the insertion point will 
be ignored. 

Delete Word Break Removes a word break that you have manually placed at 
the insertion point. 
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Compress Text ... 

126 

Show Word Breaks Alternately shows or hides manually inserted word breaks. 

Make Space Block Allows you to insert space at the end of a paragraph. 

Compress Text • .• Allows you to apply kerning or character compensation to 
selected text. 

This dialog box allows you to indicate the type of character to insert. 

lab Fill Pattern ... Allows you to indicate the type of character that can be 
inserted between tabs. 

,. Desk FllelPrlnt Edit T 

Till Fill PIIIt!m... I.:!J 

The items in this dialog box can be applied to text to improve the overall 
readability of the page. Generally speaking, you will want to reduce more space 
between letters as you increase the size of the font. 

Text Kerning Allows you to reduce the white space between certain letter pairs. 
You will recieve text kerning with every Cf font you purchase. 

Designer Kerning Allows you to apply tight kerning to the selected text. 
Designer kerning is an option that is purchased with your font. You will usually 
select it for fonts larger than 14 point. 
Character Compensation Allows you to reduce the amount of white space on 
the page between all of the selected text. The amount of reduction increases as 
you move to the right from book set to tight set. 

,. Desk FIIeIPrInt Edit TIP! II! Fonts FIImIIII: 11 PIIIII! ~I tanvess TI!Id: ... 

Kerning: • IIIIIII! 0 II!'JIt 0 deslpr 

OB'ad:er ~an: • IIIIIII! 0 .... set 0 ad set 0 tI,,* set 
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Page Layout Menu 

Design Page ... 

Make a Compartment Allows you to 

draw a compartment on a page for text 
and/or figures. 

Show Comp.lFig. Borders Alternately 
shows or hides compartment and figure 
borders on current page. 

Break Compartment Links Allows 
you to break the association between the 
galleys and compartments. 

Design Page . .. Allows you to design 
a new page after current page has been 
accepted from the Edit Menu. 

Insert Page Number Inserts current 
page number at insertion mark. 

Change Page Numbers . .. Allows 
you to change the starting page number 
and increment. 

1.0 pt. Rule, 1.5 pt. Rule, etc. 
Indicates various rule weights available. 
These may be changed in Composition 
Defaults dialog box in the Dialog Box. 

Rule -other . .. Allows you to specify 
other rule weights in half-point 
increments up to 128 point. 

Show Rulers Alternately shows or 
hides page and margin rulers. 

Customize Rulers . .. Changes the 
ruler format. 

Page Layout 

Make a Compartment .M 
v'Show Comp./Fig. Borders 

Break Compartment Links 

Design Page ... 

Insert Page Number 
Change Page Numbers ... 

1.0 pt. Rule .1 
1.5 pt. Rule .2 
2.0 pt. Rule .3 
4.0 pt. Rule .4 
6.0 pt. Rule .5 
B.O pt. Rule .6 
Rule - other... .7 

Show Rulers 
Customize Rulers ... 

This dialog box allows you to design the next page of your document after you 
have selected Accept Page from the Edit menu. Boxes will appear only next to the 
selections that are possible to use. For example, if no page is copied to the 
clipboard, boxes will not appear next to the selection as on clipboard. 

Style next page like last page, like page before last, and as on clipboard will 
copy all compartments, page numbers, and any object that was designated to 
Repeat on all Pages. Free Style will give you a blank page. 

Chapter 3: Cg Compose 2 Reference 127 



Change Page Numbers ... 
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Style and fill next page This selection works like Style next page. In addition, 
text in a galley will flow into the compartments as designated on the Style page. 

Style and fill all pages Any of these selections style and fill as many pages 
necessary for all text stored on a galley. Alternating gives you page styles of left 
and right (like this manual) if two pages have been designed differently. 

IBIGNPfH ••. 

~1II!ld:1JiI!II! 

- lila! 1_ IJiI!II! 0 - as l1li clipboard 0 

- lila! IJiI!II! beftJrr 1_ - Free-stvie 0 

5l!IIe iIIId fill III!ld: IJiI!II! 

- lila! 1_ IJiI!II! - as l1li clipboard 0 

- lila! PiIIII! beftJrr 1_ 

ggle iIIId fill all IJiIIII!S 

- lila! 1_ PiIIII! - as l1li clipboard 0 

- altzmilting 

From Page . .. Enter a range of pages to be changed. 

Offset Selected Pages Enter a value in the With a Starting Value of box to 
offset (add this amount to) the selected pages by the designated value. 

Renumber Selected Pages Designates the starting value for a page number in 
the document. Useful when a long report is split into many smaller Cg Compose 
2 documents . 

... Desk FI~lPIint Edit T Ie Fonts FIImIIII: If P 

kIith a smting VIIIIr 1# i : -'-' 
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Rule - other ... 

Customize Rulers ..• 

Rule's Point Size Designates a rule weight in half-point increments. The largest 
value you can enter is 128. The smallest is one-half. 
Examples: 20.0; 15.5; 70.5. 

Once entered, you may access this rule weight by pressing and holding the Apple 
key and pressing the number 7 on the main keyboard. Then draw the rule. 

,. Desk FllelPrlnt Edit T Ie Fants FOI'IIIIII:,r PIIGe 

~e-llher... t_ 1 

The Customize Rulers dialog box allows you change the increments on the rulers. 
Both Inches and Centimeters are available as a counting units. To help center 
figures and compartments, you may also choose the item allowing you to adjust 
the zero-point on the ruler. Then you click on the ruler to set the zero point. 

,. Desk FllelPrlnt Edit TIP! style Fants FOI'IIIIII: 11 Page L Arrangement 

CUSTOMIZE IU.ERS ••• 

IUER 
o ~IZONTfI. 0 I'ERTICFI. • BOTH 

Rller FIII'lIIiII: 
• Inches o centimeters ~ 
Major Divisian Spacing 
00.5" .1" 01.5" 02" 03" 

NLmIH!r ~ Minor Dlvisians 
01 02 03 04 05 06 .8 010 012 016 

/lUnberlng Increment 
.1 02 03 04 05 06 OB 010 012 016 

A:tjustable Zero-Point: 0 ~ • Off 

Chapter 3: Cg Compose 2 Reference 129 



Arrangement Menu 
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Bring to Front Brings selected 
object(s) in front of other objects. 

Send to Back Sends selected object(s) 
behind other objects. 

Group Objects Makes selected 
object(s) into one object, or sends 
selected object back to original objects. 

Lock in Place Locks selected object(s) 
in place, or unlocks selected object(s). 

Repeat on all Pages Repeats selected 
object(s), such as compartments and 
rules on all of the pages you create. Text 
within compartments will also repeat. 

Align Objects . .. Aligns selected 
objects. 

Shade Objects . .. Shades selected 
object(s). 

Show Grids Displays current page 
with grid lines, or hides grid lines. 

Arr angement 
Bring To front 
Send To Back 

Group Objects 

Lock in Place 

Repeat on all Pages 

Rlign Objects ... 

Shade Objects." 

.,.IShow Grids 

.,.IAuto Grid 
Align to Auto-grid 

Auto Grid Displays the current page with magnetic grid lines, or turns off the 
auto grid. 

Align to Auto Grid Aligns selected objects to the auto grid when the auto grid 
when it is selected. 
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Align Objects •.. 

Shade Objects ... 

Align Objects has two separate functions. You must select at least two objects 
(compartments, figures, rules, or page numbers) before this dialog box is 
displayed on the menu. 

You can choose one item at a time. Then, you can redisplay this box to use 
another feature. 

Align ... This feature aligns selected objects as indicated by a click in the 
desired box. 

Match . .. This feature will change the shape of selected objects to match the 
designated dimension. 

,. Desk FlielPrlnt Edit Til! stvIe Fonts Fannat Ir Pegr Ly!t Rrrlft!!ll!!i 

Ali"' .......... . 

HItdI .......... . 

II.IGN IIII.ECTS ... 

left: sides 0 CI!nI:en 0 ri_ sides 0 

CI!nI:en & middies 0 

taps 0 middies 0 

tallest 0 

widest 0 

This dialog box allows you to designate a shade for the selected compartment. 

,. Desk FllelPrlnt Edit T Ie Fonts Fannat I 
., 

SIIIIII! llljects ... 

o I'«Ine 0 Wbite 0 u. Gray 0 Gray 0 lie. Gray 0 Black 

Chapter 3: Cg Compose 2 Reference 131 





Chapter 4 

System Setup 



Contents 135 Introduction 

135 System Set Up 

136 Install Cg Compose 2 Tool 

137 Install Cg Compose Software 

138 Install Cg Device Driver Software 

139 Device Preferences 

141 Examples Folder 

142 Repair the Disk 

143 Diskettes 

134 CgCompose2 



Introduction 

System Set Up 

Setting up your system involves three stages: 

• Physically hooking up the terminal with the peripheral devices, such as the 
Disk and the printing devices. 

• Installing the System software. 

• Using the Preferences, which is a dialog box, that tells the system what 
devices are connected and the special settings. 

This chapter tells you how to install the tool Cg Compose 2, the printing device 
driver, and the special Cg Compose 2 operating software. 

Note: For each type of printing device there will be a specific driver you will install through the 
Preferences that allows printing on that device. 

You will use the set up information: 

• When you first set up your system. 

• When you add or change a printer, typesetter, or EP 308. 

• When you change the default printer. 

• When you get a new Disk, or want to change the location of start up software. 

• If your start up disk is damaged you need to repair the start up software. 

• If a tool is damaged and you need to reinstall it. 

• When you purchase new fonts you will need to install them in the Font 
Library and in the output device. 

Information about aspects of system set up not covered in this chapter can be 
found in other chapters of this manual, and in other manuals that have been 
included with your Personal Composition System. 

~ To install Compugraphic fonts, you will use the instructions in Chapter 5. 

• To connect the EP 308, see Chapter 6 of this manual. 

~ To connect the Cg 8400 typesetter, you will look at the reference manual and 
Chapter 7 of this manual. 

~ To connect the Cg 8600 typesetter, you will look at the reference manual and 
Chapter 8 of this manual. 

~ To connect the ImageWriter, modem or hard disk to the Personal 
Composition System, you will look at the Office System Manual, Chapter 6. 

~ To install Compugraphic operating software continue with Chapter 4. 
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Install the 
Compose 2 Tool 

The following steps outline the procedure to install the Cg Compose 2 tool on 
the Disk: 

1 If the Office Systems software and tools have not been installed, follow the 
procedures outline in the Office System, Manual Chapter 6. 

2 The Lisa should be powered up with the normal operating program. 

3 Insert the diskette labeled Cg Compose 2 Master Tool into the disk drive. 

4 Highlight the diskette icon, and open it through the File/Print menu. 

~ Hold down the Ishiftlkey and highlight both icons in the window. 

5 Select Duplicate from the File/Print menu. 

6· Move the flashing icons to the Disk. 

7 ClickOK. 

8 Once the duplication is complete, choose Eject Diskette from the 
Housekeeping menu. 

Empty Folders 
Cg Compose 2 Paper 

cg compose 2 
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Install Cg Compose 2 1 Turn the Lisa off, but leave the Disk on. When the Lisa power has gone off, 
insert the Cg Compose 2 Diskette 1 in the micro drive. Turn the power on. 

2 When the first click occurs and the memory icons appear on the screen, hold 
down the ~ key and press the number [gj on the main keyboard. This 
causes the Lisa to load from drive 2 (the micro drive; an internal hard disk is 
drive 1). 

Note: If you miss the click, the system will load from the Disk. Let the load complete, and when 
the message appears that the micro diskette is damaged, click Cancel to eject the diskette. Go 
back to step 1. 

3 The message Cg Compose 2 will appear in a dialog box. 

4 Click Install; this will start the installation of the Cg Compose 2 software. 

+ C9 Co.pose 2 
II 1985 Co.pugraphic Corp. 

This diskette is used to install Cg Co.pose 2 
software and to repair the start up disk. The 
Startup disk is attached to the parallel 
connector _ 

Click finished if yopu are finished. 

Click repair to fix. the da.aged disk. 

Click install to put new software on the disk. 

( Finished) 

Repair 

( Install 

5 If you are asked on which disk you would like to install this software, you 
should install the Cg Compose 2 software on the Disk where you have 
installed Office Systems software. For more about this, see Chapter 6, in the 
Lisa Office Systems Manual. 

6 When the message appears asking if you wish to erase the disk the software is 
being installed on, click Don't Erase. If you click Erase, all documents and 
tools stored on the Disk will be gone. 

7 When the System is finished with the Cg Compose 2 Diskette 1, it will be 
ejected. A message will be given to insert Cg Compose 2 Diskette 2. Remove 
diskette 1 and insert diskette 2. The Lisa will continue installing the software. 

8 Next, the Lisa will eject the Cg Compose 2 Diskette 2, and ask you to insert Cg 
Compose 2 Diskette 3. 

9 Finally, the Lisa will ask you to insert the Cg Compose 2 Diskette 4. There is 
no Diskette 4 with this version of software, click Done. 

10 Follow the screen instructions. Insert Cg Compose 2 Diskette 1 into the drive. 
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Install Cg Device 
Driver Software 

11 The message Cg Compose 2 software has been installed will appear. 
Click OK. 

12 Click Finished on the next dialog box. 

13 Click Start Up in the next box. This will return the Lisa to norm;tl operations. 
(If the Environment Window appears, place a check by Office Systems and 
choose Start.) When completed, open the Preferences and install the Device 
Driver Software. Store the Cg Compose 2 diskettes in a safe place. 

To output documents created with Cg Compose 2 software on a typesetter or EP 
308 you must install special software through the Preferences window. This 
software is called device driver and there is a unique set for each output device. 
To see if the software has been installed, open your Preferences and examine the 
Connect Devices dialog box. 

If the devices you have connected are listed at the proper ports, the software has 
been installed. The connection ports are Parallel, Serial A, Serial Band 3 upper 
and lower Expansion Slots. If your devices do not appear, then you must install 
the device driver software. 

Follow the steps listed below to check your software and install it if necessary. 

1 Place the pointer on Preferences and click the mouse button. 

2 Choose Open from the File/Print menu. 

3 Click on Connect Devices. 

4 Click on Serial A Connector. 

5 The EP 308, 8400, and 8600 Typesetter can only be connected at the Serial A 
Connector. If your device is not listed, click on Install Device Software. 

6 You will receive a note box requesting that you insert the device driver 
diskette. Place the micro diskette into the disk drive. 

OCcmed: IIMc:rs 11nItiII11Jati.:r SoItwiR 

Inlbll DI!loIa! ~ 
One 
o EP308 PrlnlB' 

~ 
Please IlIA: iI mkro dl!k!tte in the dr~. 

( II( 
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Device Preferences 

7 Click on Install Device Software after the disk has been inserted. 

8 Click on ,the bottom choice, which should be the name of the device 
software you intend to load. The Preferences will first copy the SDLC 
software and then the device software you are loading. 

9 After the software is installed, check the. Connect Devices to make sure the 
software is loaded. 

10 Eject the diskette by clicking on Desktop and choosing Eject Diskette from 
the Housekeeping menu. 

o Set ConiIeniences 0 Select DeFaults 

• Comect Devices 0 Install Device Software 

• Serial A Connector 
o Serial B Connector 
o Parallel Connector 
o Expansion Slot 1 
o Expansion Slot 2 
o Expansion Slot 3 

Eg8400 TypeSetter 
Imagewriter I II DMP 
Profile 
2 Port Card 
Nothing 
Nothing 

Connect To Ser"ial R Connector 

o Remove Device Software 

o Nothing 0 Serial Cable 0 Modem A 0 SOlC Dlmagewriter I II [IMP 
o Daisy Wheel Printer • Eg8400 TypeSetter 

~ 

, 

This section contains a summary of the information on setting preferences for 
the ImageWriter (Dot Matrix), 8400 and 8600 Typesetter, and the EP 308. 
For more specific information about a particular device turn to the appropriate 
chapter in this manual. 

On the Desktop there is an icon called Preferences. This icon contains 
information that you can use to customize the system to make it suit your needs. 

One of these Preferences is called Connect Devices. This dialog box will identify 
to the Personal Composition System the kind of printer attached to each port. 

To add an output device: 

~ The device must be connected to the Lisa. 

~ The driver software that identifies and communicates with the device must 
be installed. See Install Device Driver Software above. 
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To set a default printer: 

.. Click on Select Defaults. 

.. Place a check by the printing device you would most often select. This printer 
will be your automatic printer of choice. 

E-
o Set l:IIrM!niences I Select Defaults 

o Ccmect Devlm 0 Install Devlct! !oft:w8re 

Use this Prlntrr as Def_lt 
limagewriter I II [HI Ser-ial B Connector" 
o Cg8400 T\II!Setter Ser-ial A connector 
St.t .. Fr_ , 

o Mlao DlsII2tt:e B"11Ir 
I Profll~ PlII"all~1 Connector" 
o ~ofil~ Expansion Slot 1 (2 Purt Card] ~ Connector" 

Test ttenIor1I 
• Briefly 
o ThorOU!#lly 

To change printers: 

.. You may change the default printer by following the instructions listed above . 

.. If you want to indicate a printer that is already connected, but other than the 
one listed as the default: 

.. Choose Format for Printer as you are working on a document . 

.. Click on New Printer. 

Format for IrnageWtiter Prirt~ - _Ial port B ( canerl ) 
Paper Size 

• Letter (8.5 x II") o Legal (8.5 x 14") o computer (14 x 11") 
DA4 (210 x 297mm) 
D210mm x 12" 
D310mm x8" 

Paper lPrirting B"iertation 

8&~§ 
Prirtlng ~lity 

• High Resolution 0 Low Resolution 
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Examples Folder 

.. Click on the desired printer . 

.. Click OK. 

~ Desk ..... Edit TlI! Stull! Format II Page layQ!.t 5I!ard1 Spelllnq 

Format far ~Idt Printer? 
o Im.gewriter I II DHP urial port B 
o Ink Jet Printer (Not pre,ently connected!) 
o Daisy Wheel Printer 
• EP30S Printer 
o CgS400 TypeSetter 

(Not presently connected!) 
serial port A. (dehult printer) 
(Not presently oonnected!) 

To connect a new printer:. 

.. Make the physical connection by removing the plug of an existing printer and 
plugging in the new one. 

.. Go to the Connect Devices dialog box in the Preferences and check on the 
port where the new device is connected. 

.. On the list of devices you should see the new device you are connecting. If 
the device is displayed, click in the box next to it. The new device should 
appear next to the port where it is connected . 

.. If the device is not listed, Install the Device Driver software. (See above) 

lelPrint 

o Set ConiIeniences 0 Select Defaults 

• Connect Devices 0 Install Device Software 

o Serial R Connector 
• Serial B Connector 
o Parallel Connector 
o Expansion Slot 1 
o Expansion Slot 2 
o Expansion Slot 3 

41308 Printer 
lmagewriter I II lIMP 
Profile 
2 Port Card 
Nothing 
Nothing 

o Remove Device 

Connett To Serial B Connector ~ 
o Nothing 0 Serial Cable 0 Modern A 0 sou: • Irnagewriter I II DMP 
DDaisy W1IeeI Printer DCg8400 TypeSetter DEP308 Printer 

You should have an Examples Folder for each of the tools on your disk. The 
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folder contains the stationery pads you will use to learn the System. 

1 The Cg Compose 2 Examples Folder Diskette is on a separate micro diskette. 
It is installed like each of the tools. 

~ Place the micro diskette in the disk drive. 

~ Open the diskette. 

2 Select the Examples Folder. 

3 Choose Duplicate from the FilelPrint menu. 

4 Move the blinking icon to the Disk window. 

5 When completed, choose Eject Diskette from the Housekeeping menu. Put 
the diskette in a safe place. 

6 When you have finished using the Examples Folder on your Disk, throw it 
away to make space. 

It may be necessary to Repair the Disk after an unexpected system termination or 
to free some blocks on the Disk to make more room to work. You should have a 
minimum of 1,000 free blocks on the Disk to work on Compose documents. The 
procedure for this operation is described below following a brief explanation of 
the circumstances that call for a Disk Repair. 

• In cases where the system is interrupted because of a power failure, the 
Personal Composition System will request that you check the startup disk by 
repairing it. This could be because of a power shut off to the System, or as a 
result of your pushing the reset button because the System has ceased to 
respond, or "locked up." 

• The Cg Compose 2 document is very large and takes up more blocks than any 
other tool. To compress the data on the disk and prevent the system from 
failing in the future, it is a good idea to repair the disk periodically. The 
process takes only a few minutes and will increase the overall speed of the 
System. 
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Diskettes 

1 The Lisa should be turned off. The Disk should be turned on and the red light 
constant (not blinking). Put the Office System 1 Diskette into the micro 
disk drive. You can also use Cg Compose 2, Diskette 1, to repair. 

~ Press the On button in front of the terminal. 

~ When you hear a click, press and hold the ~ key and the number ~ on 
the main keyboard (not the 2 on the numeric keypad). 

2 Place a check next to the following items that the screen will display as the 
System goes through the repair process: 

~ Repair 

~ OK (Identifies the Disk) 

~ OK (The disk has been repaired) 

~ Don't Install 

~ Finished 

~ Start Up-You can resume normal operations. 

Note: If you choose to install the Compose 2 Software (Diskettes 1, 2, and 3), you must also 
install the Write & Set, and Device Driver Software. 

To save space on the Disk and speed up the response time of your Personal 
Composition System, you will want to store documents and custom stationery 
pads on micro diskettes. 

1 After you have completed a document or before you turn off the System at 
night, move the document onto a micro diskette. Label the Diskette. File 
similar documents on the same diskette. 

2 When you need to work on a particular document that is on a diskette, move 
it onto the Disk, then work on the document. If you want to save the original, 
duplicate the document and move the flashing duplicate on to the Disk. You 
must have a considerable amount of blocks free work on a document while it 
is on micro diskette. To view the number of blocks, look at the Attributes on 
the File Print menu when you are addressed to the diskette. 

3 Store your source documents on micro diskettes. Cg Compose documents can 
consume large blocks of memory space. Major editing in Compose can be 
slower than it is in other tools. It will be more efficient to make your changes 
on the source documents. If you need to recompose a document, you can 
merge your edited source document into a new Cg Compose 2 document. 
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Introduction 

Environments Window 

This chapter covers the information you will need to install, change, and delete 
fonts from your Personal Composition System. A font is a set of characters within 
a single typeface. By using different fonts in your documents you can 
communicate with greater precision and control. You can create documents that 
will be easier to understand and will be remembered longer. You can use font 
changes to direct emphasis and mood changes in your written documents. 

You can have typefaces other than the Apple Classic and Modern, that ordinarily 
come with office products, by purchasing fonts from Compugraphic and 
installing them on the System. You can choose, from a library of hundreds of 
typefaces, the fonts that will communicate effectively for your organization. 

The fonts you purchase will come in two parts. One part, called a master, is/ont 
width in/ormation that you install from a micro diskette in your System/ront 
end. This information is used to position each character on the page. The second 
part is the actual character shapes, which come on a floppy disk (8 inch for the 
8400 and 5 JA inch for the EP 308 and 8600.) This part is installed in the output 
device. When you print a document, the characters that are placed on the printed 
page are created from the information stored in the output device. 

This chapter will explain the procedures for installing/ont width information in 
the system front end. For information about installing fonts in output devices, 
turn to: 

~ Chapter 6 for the EP 308 

~ Chapter 7 for the 8400 

~ Chapter 8 for the 8600 

Font width information is installed on the System Disk (from micro diskette) 
using the Font Librarian. Once you have installed the font width information 
with the Font Librarian, they will be accessible through the Fonts menu in Cg 
Compose 2 documents. You will not need to use the Font Librarian again unless 
you wish to add new fonts to your System. 

You can access the Font Librarian through the Environments Window. The 
Environments Window is a dialog box where you may choose to work with the 
Office System, which is the normal operating program for creating documents; or 
with the Font Librarian, which is used for managing fonts. This is a special 
feature that is now available in Cg Compose 2. Follow the steps below to bring up 

. the Environments Window, so you may store new fonts on the System. 

. .. The Personal Composition System should be turned on. If you have 
documents open on the desktop, the System will put them away 
automatically when it brings up the Environments Window. When you leave 
the Environments Window, your screen will return to the previous display. 
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~ Press and hold down the ~key. 

~ Press the lighted On/Offbutton. 

If this is your first time in the Environments Window dialog box, set the Office 
System as the default so the Personal Composition System will always go to 
Office System when it is started up. 

~ Choose Office System. 

~ Choose Set Default. 

~ Choose OK. 

To enter the Font Librarian from the Environments Window: 

~ Choose Font Librarian. 

~ Choose Start. 

( Restart) 

c=J FONT LIBRARIAN 

c=J Office System 

Environments 

( Power Off) 

( Set Default ) 

( No Default ) 

( start) 

Caution 
Carefully read all of the information about the Font Librarian 

before adding, moving, or deleting any fonts. 

The Font Librarian is used to manage Compugraphic font width information. 
Installing Cg Compose 2 software places the Font Librarian in the Environments 
Window. The Font Librarian is comprised of two libraries. One is called the Cg 
Fonts Library. It contains the name and width information for each font. The 
other library is called the Representative Fonts Library. It contains information 
about the displayed character shapes on the sreen. 
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Font Librarian 
Menu Items 

File/Print Menu 

1. BRUSH OLDSTYLE SERIF 
2. ROCKWELL MO g CG TIMES 
3. ROCKWELL MO IT 10 CG TIMES 
4. ROCKWELL BO 11 CG TIMES 
5. ROCKWELL BO IT 12 CG TIMES 
5. TRIUMVIRATE 14 CG TIMES 
7. TRIUMVIRATE IT 18 CG TIMES 
S. TRIUMVIRATE BO 24 CG TIMES 

SQUARE SERIF 

Install Master can be selected only 
when the Master Diskette is inserted into 
the disk drive. Fonts on the master 
diskette will overwrite any existing fonts 
in the library that match, or have the same 
face number. New fonts will be added to 
the library. 

Backup Library creates a copy of the 
current library in the correct order. If 
changes are made in the Library, make 
sure you create a backup before leaving 
the Font Librarian. You should back it up 
immediately after you make changes. 

g ROCKWELL 

Backup Library 
Restore Library 

Eject Diskette liE 

Print Font List 

Quit liQ 

Restore Library returns the library to a previous order. It is used so that 
documents made under an earlier library can be displayed. 

Eject Diskette allows you to eject the micro diskette from the disk drive. 

Print Font List allows you to print out a selected window, on a dot matrix 
printer. 

Quit allows you to eject the current diskette in the drive and return to the 
Environments Window. 
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Select All Fonts allows you to select all 
of the fonts in the highlighted window. 

Add Selected Fonts allows you to add 
selected fonts from the back up or master 
diskette in the disk drive. 

Delete Selected Fonts allows you to 
delete fonts that you have selected from 
your library. This menu item should be 
used with extreme caution. 

Show Attributes . •. displays 
information about the selected item. It 
allows you to see the number of blocks 
used, and the last modification date and 
time. 

Alphabetical View allows you to 
display library fonts in alphabetical order. 

InOrder View allows you to display 
library fonts in the order that they are 
stored on the Disk. 

Show Date and Time allows you to 
view the current time and date. This item 
may be useful for labelling backup diskettes. 

Display 
Select All Fonts .A 

Add Selected Fonts 
Delete Selected Fonts 

Show Date & Time 

This library contains the character width information that controls the relative 
positioning each character on a page. The width information includes character 
compensation, proportional spacing, kerning, and the space needed for multiple 
sizes. Although you never see this information, it is recorded as a part of each 
document produced. You can view this information about each font, by making 
the library window larger. 

~ Place the pointer on the size control box of the window. 

~ Press and hold down the mouse button. 

~ Stretch the window to the right, then release the mouse button. 
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The larger window will show the following columns: 

Typeface is the name of the font. 

Comp is the complement purchased with the font. 

Face is the part number of the font. 

Comp is the alternate complement purchased with the font. 

Kerning is the type of kerning (Text and Designer) available with the font. 

TYPEFA[E 
1. BRUSH 
2. CENTURY TXTBK 
3. CG OMEGA 
4. CG OMEGA BO IT 
5. CG OMEGA BOLD 
5. CG OMEGA ITALIC 
7. CG TIMES 
8. CG TIMES BO IT 
9. CG TIMES BOLD 

CG TIMES ITALIC 

11I11 [g Fonts Llbral Y 11111 

[omp Face -- [omp Face 
000501 000325 -- 005944 000325 
000501 000290 -- 005944 000290 
000501 002505 -- 005944 002505 
000501 002511 -- 005944 002511 
000501 002510 -- 005944 002510 
000501 002507 -- 005944 002507 
000501 002500 -- 005944 002500 
000501 002505 -- 005944 002505 
000501 002504 -- 005944 002504 
000501 002501 -- 005944 002501 

Kerning 

St d/Oe.i gner. 
Std/De.igner> 
Std/De.ignen 
Std/De.igner> 
Std/De.ignen 
Std/Designers 
Std/De.ignen 
Std/De.igner. 
Std/De.ignen 

Note: The information on each font in this window should match the numbers on the printout 
that was shipped with your font. 

The Cg Font Library can display fonts in alphabetical order and in the actual 
order that they are listed in the library. 

Important: 

The ordered list of the library becomes a part of every Cg Compose 2 document 
that is created. 

• If the document is reopened at a later time, the list is compared against the 
current list of fonts in the library. If the lists match exactly (they have the same 
fonts listed in the same order) your document will open immediately for 
further composition work. 

• If new fonts have been added to the end of the list, but the order of the list is 
unchanged, the document will be opened with no further problem. 

• If the same fonts are found in the list, but in a different order (because the 
positions of the fonts have changed), you will experience a delay in opening 
the document. The System will have to remap the fonts before it can display 
the document. You will receive a warning box asking if you want to restore 
your library, or remap the font list. If the document is short choose to remap. 
The process will only take a few seconds. But if the document is long or 
complex, restore your library by going to the Font Librarian and inserting 
your back up disk. 
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Add Selected Font 

Representative 
Fonts Library 

Note: Before leaving the Font Librarian, you should create a backup if you have changed the 
font order. You will use the backup to restore the library before opening a document created 
under the former library. 

• To open a document that uses a font no longer in the library, you must restore 
the font library before the document can be opened. 

Note: Instructions for backing up and restoringfonts are included later in this chapter. 

If you need to update a font that is in the library, choose to Add Selected Font, 
which will replace, or overwrite, the original font. If you delete the original and 
add the new font, the list will be changed and remapping will be necessary to 
open all documents made under the original library. The menu item Delete 
Selected Fonts must be used with care because it will change the order of fonts 
in the Cg Library. If you have to change the library order, you should backup the 
original, so you can restore the library before displaying documents created prior 
to the change. 

You may install up to 100 fonts in the Cg Fonts Library. This will take up 
approximately 370 blocks of Disk space. 

The document characters which you see displayed in your document on the 
desktop must be bit mapped so they can appear on the screen. The information 
to create these characters resides in the Representative Fonts library and requires 
a great deal of storage space. To keep the amount of storage space to a minimum, 
several groups of representative fonts have been developed for screen display to 
simulate the true fonts that will output on the printed page. 

If you decide to change a representative font in your library, you may purchase it 
from Compugraphic and add it or use it as a replacement. Representative Fonts 
are installed using the same procedure as installing Cg Fonts. 

The following categories of typefaces are displayed in your Representative Fonts 
Library Window: 

1 Modern 
2 Oldstyle Serif 
3 Square Serif 
4 Modern Sans Serif 
5 Modified Sans Serif 
6 Connecting Script 
7 Non-Connecting Script 
8 Novelty 
9 Specialty 
10 Reserved 
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Diskette Masters 

The Representative Font Library will hold up to ten point sizes in each category. It 
can be used to store custom characters such as logos, trademarks, and other 
symbols used in your documents. This library requires approximately 380 blocks 
of Disk space. Shown below is an example of the Representative Fonts Library for 
the categories of Oldstyle Serif and Square Serif. Each category contains seven of 
the ten point sizes ofthe available 10. 

rrr- Represertatilll! Forts Librarll 

!!I TYPE 
OLOSTYLE SERIF (Screen Res) 

9 CG TIMES 
10 CG TIMES 
11 CG TIMES 
12 CG TIMES 
14 CG TIMES 
18 CG TIMES 
24 CG TIMES 

SQUARE SERIF (Screen Res) 
9 ROCKWELL 

10 ROCKWELL 
11 ROCKWELL 
12 ROCKWELL 
14 ROCKWELL 
18 ROCKWELL 
24 ROCKWELL 

--_ .. _-_ .. _.- . __ .. -.-

Master Diskettes, supplied by Compugraphic Type Division, contain the fonts 
you order. Before you open your package of new fonts, you should carefully 
examine the list of fonts to make sure you recieve the fonts you ordered. 

You will now install the fonts from the Master Diskette to the Cg Library 
following the instructions listed on the next page. You can not make a backup of 
the Master Diskette, but after installing the fonts you should initialize a blank 
diskette, and back up your libraries. In most cases it will be possible to to back up 
both the Cg Fonts and Representative Fonts Library on the same micro diskette. 

Once the fonts are installed, the original Master Diskettes should be stored in a 
safe place. Because fonts can be added from backups, and font libraries can be 
restored from backups, it is unlikely you will need the Master Diskettes again. 

The original libraries shipped with the product can be found on Cg Compose 2 -
diskette 3. In the event of problems, these libraries can be used as backup 
diskettes, but it is not recommended that they be used in this manner. 
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Follow the steps listed below to proceed from Office System to the Environments 
Window, then to the Font Librarian where you will install fonts in the Cg Fonts 
Library. 

Caution 
Carefully read all of the information about the Font Librarian 

before adding, moving, or deleting any fonts. 

~ The Personal Composition System should be turned on with Office System 
Software on the screen. 

1 To get into the Environments Window 

~ Press and hold down the ~key. 

~ Press the lighted On/Offbutton 

2 To get into the Font Librarian 

~ Click on Font Librarian. 

~ Click on Start 

Note: If the Font Librarian does not appear, click on Power Off You must first install Cg 
Compose 2 (Diskettes 1,2, and 3) as described in Chapter 4: System Set up. 

3 Insert the Master Diskette that contains your fonts into the disk drive. 

4 Choose Install from the File/Print menu. This will add all new fonts to the 
end of your library without asking for confirmation of each font. It will 
overwrite any existing dupli~ate fonts in the same order. 

Install will add all fonts From "Master". 
replacing q library Fonts which match those on 

( Cancel) 

the diskette. II< 

5 ChooseOK 

6 Choose Eject Diskette from the File/Print menu. Store your Master Diskette 
in a safe place. . 

7 Before leaving the Font Librarian, make sure you have a backup of your Cg 
Fonts Library. 

~ Place a blank diskette in the disk drive. 

~ The diskette will be initialized. This will erase and format the diskette so that 
it can be used to store the library. 
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~ Click on your Cg Fonts Library window. 

~ Choose Backup Library from the File/Print menu. This message will only 
appear when a used disk, or backup library is inserted. 

~ ChooseOK 

Backup will erase the current copy of 
[g Fonts Library on the diskette. 

8 To backup your Representative Fonts Library 

( [ancel ) 

01( 

~ Point to the Representative Library and click the mouse button. 

~ Choose Backup Library from the File/Print menu. 

~ Choose OK. 

9 To eject the diskette and exit the Font Librarian, choose Quit from the 
File/Print menu. 

1. 
2. 
3. 

'4. 
5. 
6. 
7. 
8. 
9. 

10. 

BRUSH 
ROCKWELL MO 
ROCKWELL MO IT 
ROCKWELL BO 
ROCKWELL BO IT 
TRIUMVIRATE 
TRIUMVI RATE IT 
TRIUMVIRATE BO 
TRIUMVIRRTE BO IT 
CIl TIMES 

1. BRUSH 
2. ROCKWELL MO 
3. ROCKWELL MO IT 
4. ROCKWELL SO 
5. ROCKWELL BD IT 
6. TRIUMVIRATE 
7. TRIUMVIRATE IT 
S. TRIUMVIRATE SO 
9. TRIUMVIRATE BO IT 
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OLOSTYLE SERIF 

SQUARE SERI F 

9 CIl TIMES 
10 CIl TIMES 
11 CIl TIMES 
12 ell TIMES 
14 ell TIMES 
18 ell TIMES 
24 Cil TIMES 

9 ell TIMES 
10 CIl TIMES 
11 CIl TIMES 
12 CIlTIM£S 
14 CG TIMES 
18 CIl TIMES 
24 CG TIMES 

., 
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Changing the Font 
Library 

As a rule you should not need to make any changes to your library, except to 
install new fonts, or to replace existing fonts because you have added Designer 
Kerning or custom characters. If you have purchased more than 100 fonts, you 
may have separate library versions you will use by restoring the fonts in your 
library to different versions. These procedures are all basically the same. Follow 
the steps listed below to make changes in your library. 

Caution 
Carefully read all of the information about the Font Librarian 

before adding, moving, or deleting any fonts. 

~ The Personal Composition System should be turned on with Office System 
Software on the screen. 

1 To get into the Environments Window 

~ Press and hold down the ~ key. 

~ Press the lighted On/Offbutton 

2 To get into the Font Librarian 

~ Click Font Librarian. 

~ Click Start 

3 If you do not have a backup of your current library make one before you 
change it. You may need the backup for opening documents that you made 
under this library. 

~ Place a diskette in the disk drive. 

~ Choose to have the diskette initialized. This will erase and format the 
diskette so that it can be used to store the library. 

~ Choose Backup Library from the File/Print menu. 

~ ChooseOK 

Backup will erase the current copy of 
[g Fonts Library on the diskette. 

( [ancel ) 

01< 

4 Insert the diskette containing the fonts you wish to change. 

5 Choose the menu item that allows you to perform your desired task. 

• Choose Restore library from the File/Print menu to return the entire library 
to a previous order. 
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Restore will erase the current 
Cg Forts Library 
and replace it with a copy of 
(g Forts BadG4l. 

( (ancel ) 

01( 

• Choose Install Master to overwrite old fonts with new characteristics and to 
add new fonts to the bottom of the list. This choice will not change the order 
of the library. 

• Select any individual fonts from the diskette. You may use the ~ and 
IShiftlkeys to select more than one font. Choose Add Selected Fonts from 
the Edit menu to place fonts at the bottom of the font library. 

(g Forts 

Library: 
000501002244 TRIIM'IRRTE 
005944002244 Kern: Std/Designers 

Diskette: . 
000501002244 TRllHIIRRTE 
005944002244 Kern: Std/Designers 

(lick Library to leave this font as is. 
(lick Diskette to replace this fort. 

( (ancel 

( Library 

( Diskette) 

Note: After you make a change to the Cg Font Library you should backup the library so you 
can restore it ifnecessary. 

6 Choose Eject Diskette from the File/Print menu. 

7 If you are finished with the Font Librarian, choose Quit from the File/Print 
menu which will eject the diskette and return the Environments Window. 

S Click on Office System and Start to return to your work. 

Do you have a backup copy of the curren!: 
(g Fonts Library? 

You will not be able to open (g Compose 2 
documents which used fonts in this library if you 
CI!I1I'IDt restore the library to its present 
concIitilll. For further information, refer to the 
(g Compose 2 Manual. 

(lick (ancel if you wish to make that backup IIO!V. 
(lick OK if you wish to delete the fonts selected. 

Chapter 5: Font Librarian 

( (ancel ) 

IJ( 

157 





Chapter 6 

Compugraphic EP 308 



Contents 161 Introduction 

162 Hardware Components 

165 Essentials 

166 Installing the System 

167 Overview of Installing Intellifonts and Application Program 

168 Command File 

170 Sample Command File 

171 Installing Intellifonts and the Application Program 

176 Powering Up the EP 308 

177 Copy Counter 

177 Toner Cartridges 

184 Procedure to Print 

189 Troubleshooting 

190 Diagnostics 

160 CgCompose2 



Introduction This chapter will tell you everything you need to know about setting up, 
operating, and maintaining your Compugraphic Electronic Printer 308 (EP 308). 

Your EP 308 is used to print a variety of documents created on the Personal 
Composition System. The EP 308 document may contain both text and graphics, 
and can be printed on paper or transparency material. The EP 308 reproduces all 
fonts displayed on the screen including foreign language characters and special 
characters. You can underline, italicize, or bold any font using a variety of sizes 
and linespacing. 

The EP 308 prints documents in High Resolution, Portrait, or Landscape mode. 
You may use automatic paper feed with 11 or 14 inch paper; special paper sizes 
require manual paper feed. When printing a multiple page document, the EP 308 
can collate the document. 

In this chapter you'll learn about: 

• Hardware components 

• Software components 

• Setting up the system 

• Operating the system 

• Maintaining the EP 308 

Before you begin working with the EP 308, you should be familiar with basic 
Personal Composition System operating procedures. If you have questions about 
using Cg Compose 2, refer to chapters 1 through 5 of this manual. 

Chapter 6: Compugraphic EP 308 161 



Hardware Components 
ICS 
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The Image Control System (ICS) is a controller that connects the Personal 
Composition System terminal and the EP 308. The ICS creates images for printing 
on the EP 308. 

You may connect one or two terminals to the ICS. The system accepts a 
document from either terminal. When each document finishes printing, the ICS 
will check each terminal for new documents waiting to be printed. 

The ICS consists of the following components: 

1 Front control panel has three blue buttons. These buttons are used for 
loading programs into memory, displaying internal information (pause, copy 
counter, etc.), and installing the system. 

2 On/Off Switch supplies power for both the ICS and the EP 308. 

3 Internal hard disk is used to store fonts, programs, and page images for 
output of multiple copy documents. 

4 Floppy disk drive is used to transfer programs and fonts from floppy disks 
to the hard disk. You also load the special Utility Program from the floppy 
disk drive. 

5 Two input ports can connect two terminals. 

6 An output port connects the EP 308 to the controller. 

7 A power plug is located on the back of the controller. The EP 308 power 
cord is connected to this plug. The printer power is controlled by the On/Off 
switch on the front on the ICS. 

@@(j) 
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Hardware Components 
ICS Front Control Panel 

On the front of the res is a control panel with the following buttons: 

1 IABORTlwhen followed bylENTERlwill stop the current document. 

2 IENTERI is used to display information on the control panel. 

3 IPAUSE/CONTI is used to enter and exit pause mode alternately. 

4 IRESETloccurs when IABORTI and IPAUSE/CONTI are pressed at the same 
time. The IeS will read a program from the floppy disk drive or the internal 
hard disk.IRESETlshould not be pressed while the Busy indicator is on. 

Indicator lights are used to show the status of the system: 

5 POWER indicates power to the system. 

6 READY indicates the IeS is ready to print a document. 

7 BUSY indicates a document is being printed. 

8 PAUSE indicates the pause mode is active. While in pause mode no pages will 
be printed. Press IPAUSE/CONTI to get out of pause mode. 

9 ACTIVITY INDICATOR indicates the system is active. A small light will blink 
when the EP 308 is busy. 

® 
READY 

f / ! f 
POWER 

.~ ~ 

@ 

ABORT ENTER 
Q) CV 
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Hardware Components 
EP308 
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The EP 308 is the device that makes the images on the paper. It is connected to 
the top port on the back of the ICS. The power cord is also connected to the back 
of the ICS. The EP 308 can print on paper or transparency material. 

The EP 308 consists of the following components: 

1 Release Lever to allow the changing of the toner cartridge and to inspect the 
inside of the printer. 

2 Side Door to remove the toner cartridge. This side door can be opened only 
after the release lever has been pulled. 

3 Toner Cartridge can produce approximately 3,000 copies before 
replacement is necessary. 

4 Paper Cassette holds the supply of paper. 

5 Print Tray holds the printed document. 

6 Manual Paper Feed Slot is for the insertion of special size paper. 

7 Operator Message Panel indicates ready to print, out of paper, paper jam, 
or service is needed. 

8 Power Switch should always be left in the On (I) position. 
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Essentials 
True Type 

What are Intellifonts? 

Program Disks 

The EP 308 creates type differently than a dot matrix printer. A dot matrix printer 
uses very coarse dots to create characters on a page. The EP 308, however, uses 
true type to create characters. A true type character is sharper and clearer than a 
dot matrix character. 

Although the EP 308 uses dots to create characters, it uses many more dots per 
character than a dot matrix printer. Hence, the resolution in a true type character 
is very dense. The EP 308 prints 300 dots per inch, while a dot matrix printer 
prints about 160 dots per inch (in high resolution). 

cg Times 10 point from a dol matrix printer. 

Cg Times 10 point from the Electronic Printer 308. 

Information needed to create true type is stored on the internal hard disk. Each 
time you print a document, the type information is accessed automatically from 
the disk. The ICS then sends the information to the EP 308. 

One of the major features of Cg Compose 2 is its ability to use true 
Compugraphic fonts. You can order from a library of many fonts. You can order 
sets of fonts also. Compugraphic has grouped together typefaces commonly used 
in certain applications. For example, if you are a lawyer you can buy a font 
package containing fonts commonly used on legal documents. 

The Compugraphic fonts you purchase are on 51A inch floppy disks called 
Intellifonts. Intellifonts contain all information needed to create each character 
in the font. They also have the unique ability to scale to whatever point size is 
selected in a document automatically. 

This information is transferred from the floppy disks to the internal hard disk. 
Once transferred to the hard disk, store the floppy disks in a safe place. 

Two additional disks accompany your system: 

• Pers. Compo Sys'/EP 308 Utility Program, Part Number 697045-1002 . 

• Pers. Compo Sys'/EP 308 Application Program, Part Number 697044-1002. 

The Utility Program allows you to do a number of specialized functions such as 
copying and deleting fonts from a disk. It also allows you to copy the 
Application Program to the hard disk. The Application Program is used when 
printing documents. 
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Installing the System 

Setup of the Personal 
Composition System 
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The hardware for your EP 308 is set up and tested by a Compugraphic 
representative. Before using your EP 308 to print documents, you may have to 
complete the software installation procedures. These procedures include 
installing Cg Compose 2 software in the front end, loading fonts, and copying the 
applications program onto the hard disk. You must also load paper and a toner 
cartridge into the EP 308. 

Some of these steps may already have been completed by your Compugraphic 
representative. If so, you will use these steps only if you purchase additional fonts 
or receive new programs. That is the only time these procedures are necessary­
they are not completed every day. 

Before printing a document on the EP 308 make sure the Cg Compose 2 software 
has been installed on the Personal Composition System: 

• To check if Cg Compose 2 has been installed: 

1 Click once on the Preferences Icon. 

~ Choose Open "Preferences" from the File/Print menu. 

2 Check Connect Devices. 

~ Check Serial A. 

~ Check EP308 Printer. 

~ If the selection EP308 Printer does not appear, follow the instructions to 
load driver software in Chapter 4 of this manual. 

3 Select Set Aside "Preferences" from the File/Print menu. 

• To install the Office System software and the different operating tools 
(Lisa Write, LisaDraw, etc,) see: 

~ Lisa Office System Manual, Chapter 6. 

• To install Cg Compose 2 software see: 

~ Chapter 4 of this manual. 
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Overview of Installing 
Intellifonts and 

Application Program 

Necessary Materials 

Font Complements 

This section discusses how to install the Intellifonts and Application Program. 
These operations include the following steps: 

• Load the Utility Program. 

• Create a command file in a LisaWrite document. 

• Print the command file like any other document. 

• Copy the Application Program to the hard disk. 

• Copy the Intellifont disks to the hard disk. 

When all commands in the command file have been executed, a list of the 
functions completed will be printed on the EP 308. 

Before installing Intellifonts, you should have completed the following chapters: 

• LisaGuide in Chapter 1 of the Lisa Office System Manual; 

• Chapter 1 in the LisaWrite Manual; 

Make sure you have the following materials: 

• The EP 308 installed with a toner cartridge and paper; 

• Pers. Compo Sys.lEP 308 Utility Program (part Number 697045-1002); 

• Intellifont Master Disk(s); 

• Pers. Compo Sys.lEP 308 Application Program (Part Number 697044-1002); 

• Personal Composition System powered up and ready to print; 

• A LisaWrite Document. 

Each Personal Composition System font has more characters that each EP 308 
Intellifont. To print all the Personal Composition System characters, the EP 308 
needs two font complements for each Intellifont. 

Each Intellifont that you purchase for the EP 308 will be shipped on two floppy 
disks. One disk contains the complement labeled 500, 501, or 549. A second disk 
contains the complement labeled 5477 or 5944. Both font complements for the 
font must be copied to the hard disk. The system will find the correct one to use 
automatically when printing a document. 

An additional Intellifont called Graphic Elements is also used by the system. It 
contains all of the special elements used when printing graphs, shades, etc. This 
Intellifont is labeled with the complement 5942. This font must be copied to the 
hard disk. 
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Command File 

Functions of the 
Command File 

The Utility Program is used to initialize the hard disk, add fonts to the system, 
print font information, update the hard disk, and adjust printer margins. The 
fUnctions in the Utility are controlled by Command Files. Command Files are 
typed in LisaWrite documents. They are easy to use and will help you make the 
most of all the capabilities ofthe EP 308. 

Specific commands are entered in a Command File for specific functions. For 
example, there are different commands to install fonts, initialize the hard disk, 
and to delete a font from the system. A Command File varies in length depending 
on which functions you wish to perform. You may have as many different 
command files as you need to set up your system. 

There are several different commands you may use with the Utility Program. The 
hard disk is used to store the Applications Program and up to 100 Intellifonts. 

Specific functions available in a Command File include: 

init hard disk; initializes the hard disk. The Utility Program floppy disk must 
remain in the disk drive when you initialize the hard disk. Use this command 
carefully; all fonts are deleted from the hard disk when executed. 

add font,all fonts; copies all of the font information from an Intellifont disk to 
the hard disk. It is necessary to enter this command for each Intellifont disk you 
want to copy to the hard disk. 

add font, selected fonts,#; copies selected fonts from an Intellifont disk to the 
hard disk. The # symbol represents the typeface complement and part number. 
The point size can follow if desired. This command is used when you want to 
copy a specific font from an Intellifont disk. Some sample uses of this command: 

add font, selected fonts,501-2244-10; adds a font with a complement 501, 
number 2244, with a point size of 10. When typing this command, press the keys 
loptionllhyphenlto separate the part numbers. 

add font,selected fonts,501-2245; adds a font with a complement 501, 
number 2245 in any point size. When typing this command, press the keys 
loptionllhyphenlto separate the part numbers. 

copy program; copies the Application Program from the floppy disk to the hard 
disk. Any Application Program that exists on the hard disk will be replaced 
automatically with the new program. 

wait,xx; prompts the ICS to wait before executing the next command. The xx 
represents a two digit number that you choose. This number will appear on the 
control panel when the wait command is reached. Any characters other than a 
two digit number will display 00. 

This command is used before other commands when it is necessary to change 
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disks on the ICS. This number could be written on the floppy disk to coordinate 
the insertion of the desired disk. When the ICS encounters a wait command and 
displays it on the control panel, change disks and press IPAUSE/CONTI. If you 
press IENTERI, the next command in the file will be skipped. 

If the wrong disk is in the drive when you press IPAUSE/CONTI, the wait number 
will redisplay. Remove the disk, insert the correct one, and press IPAUSE/CONT~ 

print comment, text; allows comments to print on the output page. Example 
comments include the date, your name, font names, or other information 
connected with installation. A comment cannot exceed 255 characters. 

When using this command, you must use thelOptionllHyphenlin place of a word 
space. If you want to print a hyphen, type two hyphens in a row (--). 

Command Files use a special hyphen in a LisaWrite document. Press and hold the 
IOptionl key, press the Ihyphenl key, and release the [OJ:i!lOil] key. 

delete font,selected fonts,#; removes a font from the hard disk. The # symbol 
represents the typeface complement and part number. This command will accept 
a list of font numbers to be deleted if they are separated by a comma. 

This command must be used carefully. It is useful to give special document names 
to Command Files containing delete font commands. 

delete font,all fonts; removes all fonts from the hard disk. This process can take 
a long time, depending on the number of fonts stored on the disk. 

print page; prints a page of all commands executed. This is done automatically 
when all commands have been processed or if an error is encountered. 

font index,hard disk; prints a list of all the fonts stored on the hard disk. The 
printout includes the typeface name, user ID number, point size, part number, 
and the amount of storage space for the font. 

font dump, selected fonts,# prints a font dump of selected fonts. The # symbol 
represents the typeface complement and part number. The font dump includes 
information that is contained in the font index as well as the actual characters. 

font dump,all fonts; prints a font dump of all fonts stored hard disk. It is used 
when you want to see what all of the fonts on the hard disk look like. 

move left margin,n; moves the left margin of printed documents. The n is the 
amount of space in 1I75ths of an inch. For example, lO moves the left margin 
approximately 1I8th (lOI75th) of an inch to the right. If preceeded by a minus 
sign GOptionllHyphen~ the margin will move to the left. 
The change will be reflected by a test pattern that is printed automatically. 
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Sample Command File 
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move top margin,n; adjusts the positioning of images from the top of the page 
in 1I75ths of an inch increments as described in the left margin adjustment above. 
The change will be reflected by a test pattern that is printed automatically. 

Before creating a Command File consider the following: 

~ It is best to enter a Wait command in front of every command. Increment the 
number for each command. It is also helpful to write this number on the disk 
that corresponds to the command in the file. 

~ Each Program disk and Intellifont disk has a silver tab called the Write Protect 
Tab. This tab should never be removed-it prevents you from accidentally 
initializing or deleting information from the disk. 

~ The Utility Program is designed to be flexible. Word spaces and returns are 
completely ignored by the system. Feel free to use them to make information 
easier to read on the screen. 

~ Each command must end with a semi-colon (;). If you leave it out, the system 
will stop processing your command file and print a message. 

~ Use only Plain Text when entering commands. 

~ A Command File must be printed with Pages Not Collated 

~ You must use the IOptionllHyphenl to designate a hyphen in a command file. 

The following is a sample Command File for a new installation: 

printcomment,Installing-Intellifonts-and-Application­
Program-(4--1--85); 
init hard disk; 
wai t, 01; copy program; 
wai t, 02; add font, all fonts; 
wait, 03; add font, all fonts; 
wait, 04; add font, all fonts; 
wait,05; add font, all fonts; 
wait, 06; add font, all fonts; 
wai t, 07; add font, all fonts; 

~ The first command is a print comment. 

~ The next command initializes the hard disk. This is done the first time fonts 
are installed or if you wish to delete all fonts from the hard disk. 

~ The next command copies the Application Program to the hard disk. It is 
preceded by a wait command. 

~ An add font command for each of the Intellifont disks is next. Each command 
is preceded by a wait command. The number of add font commands varies 
with the number of Intellifonts you purchased for your system. 
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Installing Intellifonts 
and the Applications 

Program 

Before installing information on the system make sure the system is set up as 
outlined in Chapter 4. 

1 Turn on the ICS. The EP 308 power switch should also be on. 

~ Insert the Utility Program(Part No. 697045-1002) into the disk drive. 

~ Press the two outside blue buttons on the control panel at the same time. 

~ A series of numbers will appear on the display panel indicating a self-test 
(diagnostic) is being conducted on the different components of the system. 

~ If the self-test does not pass, a number will appear on the front panel with a 
flashing light. See the end of this chapter for an explanation of these numbers. 

~ Two dashes will appear on the display panel when the Utility Program has 
been loaded. 

~ The display panel will next indicate READY. 

r-- RESET ---, ••• ABORT ENTER PAUSEI 
CONT 

~ Important: If you are initializing the hard disk in the Command File leave the 
Utility Program disk in the disk drive. If you are not initializing the hard disk, 
remove the disk. 

2 On the Lisa, tear off a sheet of LisaWrite Paper. 

~ Click once on LisaWrite Paper. 

~ Choose Tear Off Stationery from the File/Print menu. 

~ Name the document. Be sure to include Command File in the name. 

~ Select Open "Command File ... " from the File/Print menu. 

3 Choose Single Space' from the Format' menu. 

4 Carefully type your Command File information in the document. The 
number of add font commands that you type will depend on the number of 
Intellifonts you have ordered. Refer to the previous page for a sample 
Command File. Remember to use IOptionllHyphenlfor any hyphens. 

5 Carefully read over the typed document. 

6 Select Save & Continue from the File/Print menu. 
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7 Print the Command File. 

.. Choose Format for Printer . .. from the File/Print menu. 

Desk '''IflN' Edit Type Style Fonts Format II 

Format /-or (ompugraphic EP108 - serial port A 
Paper Size 

• Letter (8.S" x 11") 
D Legal (8.5" x·14") 
D .'>.4 (210 x 297mm) 
D210mm x 12" 

Printing Orientation 

o EJ ~ _.c:JD 

Page Layout Arrangemert 

( New Printer ... 

.. If Format for Compugrapbic EP 308 does not appear on the top of the 
screen, select New Printer in the lower right. Select EP 308 Printer from 
the list and Click OK. 

.. Click OK in the screen, Format for Compugrapbic EP 308. 

.. Select Print from the FilelPrint menu. 

.. Click Not Collated 

.. ClickOK 

8 Go to the ICS. 

9 If the first command in the Command File was to initilize the hard disk: 

.. The Utility Program disk must remain in the disk drive. 

.. The indicator will switch to BUSY, and the activity light will blink. 

.. The hard disk will be initialized. 

Note: If you removed tbe Utility Program disk tbe message 00 will appear on tbe control 
panel. Re-insert tbe Utility Program and press PAUSE/CONT. 

.. When completed, the red disk light will go out. Remove the Utility Program 
from the disk drive. 

Note: If you make a mistake tbe EP 308 will print out a message. Tbe message will explain 
wbat you need to do to correct your error. A list of possible messages follows tbis section. 

.. The indicator will next display the first wait command number in the 
Command File. 
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10 If the next command is to copy the Applications Program to the hard disk: 

~ Insert the Application Program into the floppy disk drive. 

~ Press IPAUSE/CONTI. 

n Once completed, the next wait command number will be displayed. 

~ Remove the Application Program disk if necessary. 

~ Insert the first Intellifont disk. 

~ Press IPAUSE/CONT~ The indicator will change to BUSY, and the activity 
light will blink. The red disk light may go on and off. 

12 Once completed, the indicator will change from BUSY to the next wait 
number, 02. 

~ Remove the first Intellifont disk and insert the next Intellifont disk. 

~ Press IPAUSE/CONTI. The font information on this disk will be copied. 

~ Continue this process for all Intellifont disks listed in your command file. 

13 When all commands have been completed, the EP 308 will produce a 
printout titled DISK UTILITY ACTION LOG. 

~ This printout lists all commands completed and any errors made. A list of 
possible messages follows this section. A sample printout may look like this: 
DISK UTILITY ACTION LOG 
Installing Intellifonts and Application Program 4-1-85 
Hard disk ini tialized. 
Program copied. 
Font Added: 5944-2500-0 
Font Added: 501-2500-0 
Font Added: 5944-2244-0 
FontAdded: 501-2244-0 
FontAdded: 5477-2780-10 
COMMAND FILE COMPLETED 

~ The numbers following Font Added: indicate the complement, typeface 
number, and point size printed on each Intellifont disk label. 

14 Return to the Lisa. 

~ Select Save & Put Away from the File/Print Menu. 

~ Store the "Command File" document in a safe place. 

15 The installation of your system is complete. 

Note: If you make a mistake or want to stop the process press ABORT followed by ENTER on 
the control panel and return to step 4. 
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Making a Font Index 

Font Dump 
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Once you have installed your system you may want to have a printout of all 
Intellifonts stored on the hard disk. This list is called a Font Index. To create one: 

1 The ICS should be loaded with the Utility Program 

2 Write and print the following Command File in a LisaWrite document: 
font index, hard disk; 

A sample Font Index looks like this: 

USER 10 
0000 
0000 
0000 
0000 

CHARACTER 
COMPLEMENT 
501 
5944 
501 
5944 

TYPEFACE 
NUMBER 
326 
326 
2500 
2500 

FONT NAME 
BRUSH 
BRUSH 
CG TIMES 
CGTIMES 

POINT SIZE 
4-127 
4-127 
4-127 
4-127 

FONT STORAGE 
60 Kb 
39 Kb 
64 Kb 
39 Kb 

User ID is used for other front-end systems. Complement and Number are used 
when deleting a font from the hard disk. 

You may wish to putthe command fan tin d ex, h a r d dis k ; atthe end of a 
command file when you add or delete fonts from the system. 

If you would like a printout of the characters within a specific font you may use 
the Font Dump command. To get a Font Dump of a specific font enter in a 
Command File: 

font dump, selected fonts, enterfontidentification number; 

To get a Font Dump of all fonts stored on the hard disk enter: 

font dump, all fonts; 

If you have many fonts stored on your hard disk it may require a large period of 
time to produce a font dump. 
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Utility Program Messages Below are the messages that can appear while using the Utility Program. These 
messages are printed from the EP 308. Messages ending with a colon will be 
followed by a second message such as a complement, part number, wrong 
command, left margin adjustment, etc. 

DISK UTILITY ACTION LOG 
COMMAND FILE COMPLETED 
Font not found: 
Font added: 
Font not added: 
Font already on disk: 
Invalid command: 
Left margin moved: 
Left margin not moved. 
Job aborted by operator. 
Hard disk full. 
Hard disk ini tialized. 
Insert correct floppy, 

then press CONTINUE or press ENTER to skip. 
Program copied. 
Unable to copy program. 
Processing discontinued. 
Hard disk 1-0 error. 
Floppy disk 1-0 error. 
Frontpanelmalfunction. 
Font deleted: 
Font too large to dump: 
Invalid number: 
Amount of unused space: 
Delete unwanted fonts or reload hard disk. 
No fonts on hard disk. 
Top margin moved. 
Top margin not moved. 
No fonts on floppy disk. 
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Powering Up 
the EP 308 

The EP 308 OnlOff power switch (located on the lower left front ICS panel) 
should always be in the On (I) position. The EP 308 power cord is connected to 
the back of the ICS. 

1 Turn the ICS power switch ON. Printer power will also be turned on. 

~ A small red light will appear on the front control panel next to POWER. 

~ A series of numbers will appear on the control panel indicating a self-test of 
the different components of the system. 

~ If a self-test does not pass, a number will appear on the front control panel 
along with a flashing decimal point. See the end of this chapter for an 
explanation of these numbers. 

2 The program on the hard disk will begin to load. 

3 When programming is complete an indicator will point to READY on the 
front display panel. 

r- RESET ---, ••• ABORT ENTER PAUSEI 
CONT 

A solid green light will appear on the front of the EP 308 message panel when the 
printer has warmed up. 

If the EP 308 is out of paper the program will not load. This condition is 
indicated by the flashing letters IA on the ICS control panel. 

~ A yellow light will also appear on the message panel of the printer. 

~ Add paper to the paper tray in the lower front of the printer. 

~ Press IRESETI which is IPAUSE/CONTI and IABORTI at the same time. 
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Copy Counter 

Toner Cartridges 

Cartridge Use Indicator 

The system contains an automatic copy counter. This copy counter records the 
number of copies printed since the system was installed. 

Complete the following steps to display the total amount of copies printed: 

1 Press IPAUSE/CONTI on the control panel. 

2 Press IENTERI 00 will be displayed. 

3 Press IPAUSE/CONTI the first two of six digits will be displayed. 

4 Press IPAUSE/CONTI the second two of six digits will be displayed. 

5 Press IPAUSE/CONTI the final two of six digits will be displayed. 

6 Press IPAUSE/CONTIPause Mode will be activated. 

7 Press IPAUSE/CONTI the system will go back to the Ready or Busy Mode. 

Note: The copy counter only works when the Application Program is loaded in the system. 

The EP 308 has a removable toner cartridge that will make approximately 3,000 
copies. This is based on approximately 5 % coverage of text on an 8 V2 x 11 inch 
page. The exact number of copies for each toner cartridge varies because: 

• Graphic items use more toner; 

• Large point sizes require more toner. 

The print quality of a cartridge deteriorates quickly when toner material is low. 
Watch the quality of your printed documents when you reach 3,000 copies. Print 
quality is deteriorated when: 

• Type becomes weak and grey. 

• White streaks appear on the printed document. 

Each cartridge has a small indicator window that slowly changes colors as the 
cartridge is used. This indicator should be used as a guide only. 

The indicator does not measure the amount of toner used by each page printed. It 
is activated by the number of pages that pass through the printer-and is not 
always an accurate measure of the actual toner remaining in the cartridge. 

The different colors indicate the following: 

• Green-indicates a new cartridge. 

• Green to Yellow:""-have a new cartridge ready to install. 

• Red-the cartridge should be changed when the print quality deteriorates. 
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Installing the 
Toner Cartridge 

1 Raise the top of the EP 308. 

~ Lift up on the green handle on the right side. The power will go off on the 
printer automatically. 

~ Open the door on the right side. 

Note: The right door can only be opened after the top has been raised. 

2 Remove the used cartridge by pulling it straight out. 

3 Remove the packaging from the new printer cartridge. 

~ Hold the new cartridge horizontally. 

~ Turn 45 0 slowly in both directions about five times (with the drum as the 
center of rotation). 

4 Insert the new toner cartridge into the EP 308. Make sure it is pressed all the 
way into the printer. 
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5 Hold the toner cartridge steady. 

~ Flex the black tab on the cartridge until it breaks loose. 

~ Pull the tab out completely to remove the attached sealing tapes. 

6 Raise the top of the fixing assembly. 

~ Replace the fixing roller cleaner felt with a new one. 

~ Lower the top of the fixing assembly. 

Fixing roller 

Top of fix ing 
assembly 

Fix ing assembly 
cleaner 

Note: The fixing assembly gets hot during printing; be careful not to burn yourself. 

Note: If the fixing roller is dirty, turn off the power switch and clean the roller with a damp 
cloth after the printer has cooled down. 

7 Close the upper half of the printer. 

~ The power will go back on when the top is closed. 
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Storing and Handling 
Toner Cartridges 

After installing a new toner cartridge it may be necessary to clean the corona wire 
inside the printer. 

1 Open the top of the printer by releasing the green lever on the side. 

2 The corona wire is located in the middle of the unit. Use a cotton swab to 
clean the wire gently. 

~ Be careful not to bend or damage the wires. 

3 Close the top of the printer. 

Do not store EP 308 toner cartridges under the following conditions: 

• Direct sunlight-deteriorates the toner material. 

• Abrupt changes in temperatures and humidity. 

• Dusty areas. 

• Areas where ammonia gas is emitted. 

• In a car-do not leave cartridges in a car for a long time. 

When handling cartridges avoid the following: 

• Do not stand the cartridges on end or turn them upside down. The caution 
label or the handle should always be up. 

• Keep cartridges away from children. 

• Do not attempt to adjust or take apart the cartridges. 

• Do not open the drum protective shutter. 

• Do not expose cartridges to direct sunlight or bright light. 

• Do not use cartridges for an hour or more after moving them from a cold 
environment to a warm one. 

• Use the cartridges before the expirati0l! date printed on the packaging. Print 
quality may deteriorate if you use outdated cartridges. 
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Loading Paper As with an office copier, good output quality and proper paper feed depends on 
the paper quality used. Best results may be obtained by using a premimum -4 
paper grade as specified for copiers. 

To load paper in the EP 308: 

1 Remove the paper cassette from the EP 308. 

~ A yellow light on the front of the EP 308 indicates that the machine has run 
out of paper. 

-Ii] A1! 

2 Shuffle the stack of paper before placing it in the cassette. 

~ Push the stack of paper to the back of the paper cassette. 

Note: It is important to pusb tbe stack of paper to tbe back of tbe paper cassette. If not properly 
inserted, page images may be skewed wben printed. 

~ Push the stack under the front restraining clips. 

3 Replace the paper cassette into the EP 308. 

~ The yellow light will change to the green light. 
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Manual Paper Feed 

Changing Paper 
While Printing 

You will use manual paper feed when you want to use odd size paper. A manual 
paper feed slot is located on the back of the EP 308. 

To use manual paper feed 

1 Select Format for Printer . .. from the File/Print menu. 

2 If Format for Compugraphic EP 308 does not appear on the top of the 
screen, select New Printer at the bottom of the screen. 

~ Choose EP 308 Printer. 

~ ClickOK. 

~ Click OK in the screen, Format for Compugraphic EP 308. 

~ Select Print from the File/Print menu. 

~ Click Manual Paper Feed. 

~ ClickOK. 

3 Insert your paper in the rear slot of the EP 308. 

~ The paper will feed into the printer. 

~ Insert each sheet necessary for your document. 

If you wish to change the paper type while a document is printing: 

1 Press PAUSE on the front of the ICS 308. 

~ If the Pause indicator blinks, wait for it to go solid. 

~ When the Pause indicator is solid, remove the paper cassette. 

~ Change the paper in the cassette. 

~ Replace the paper cassette. 

~ Press the PAUSE button. 
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Loading Letterhead Paper 1 Remove the paper cassette from the EP 308. Not all letterhead paper will 
produce good print quality on the EP 308. You might have to experiment to 
determine the best paper for the best print quality: 

~ A yellow light on the front of the EP 308 will indicate an out of paper 
condition. 

2 Shuffle the stack of paper. 

~ Place the letterhead face down with the top towards the front of the 
cassette. 

~ Push the stack of paper to the back of the paper cassette. 

Note: It is important to push the stack of paper to the back of the paper cassette. If the paper is 
not inserted properly, page images may be skewed when printed. 

~ Push the stack under the front restraining clips. 

3 Replace the paper cassette into the EP 308. The yellow light will change to 
the green light. 
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Procedure to Print 
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1 Make sure you have set up the EP 308 as outlined in chapter 4. 

2 With the document window opened 

~ Select Save & Continue from the File/Print menu. 

3 Select Print ... from the File/Print menu. 

~ Select Pages to Print if necessary 

~ Select the Number of Copies 

~ Select either Collated or Not Collated 

~ Select either Automatic or Manual Paper Feed 

Desk .. , •• Edit TU!!e stule fonts format 11 Page layout FlrrIlll!!I!IIlI!It 

Print on Cornpugraphlc EP308 - serlll port: R Cancel 

Pii to Print '''"''-'-'''''-'''''''-'"" ''''"-'--''"''"''"''''"'''' 
All Pag as 0 Only pag es: L_,_"""""""",,,_,J T h ro ug h: [," .• _""'"".,""""""..: 

tbnber of 9!e!.,es ammwmmmmITJmJ 0 other: [~:~:~,~=~:,:J 
Colilltion 

,,0 Pages Collated • Pages Not Collated 

Media Input 
• Automatic Feed 0 Manual Feed 

4 Click OK. 

OK 

Note: If you want only one copy of the document, choose, "Print As Is," from the File/Print 
menu. The printer defined in the Format for Printer. will be used. 

~ The indicator on the ICS will switch from READY to BUSY. The activity 
indicator light will blink on the ICS control panel. 

r- RESET ---, ••• ABORT ENTER PAUSE/ 
CONT 

5 The time required to print a document depends on the number of graphics, 
font changes, and the number of documents previously printed. 

6 Once the document has finished printing, the indicator will switch back to 
READY on the control panel, and the activity light will stop blinking. 
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Adjusting the Print Density 

If White Stripes 
Appear on Documents 

After you install of a new toner cartridge in the EP 308, you may need to adjust 
the print density. 

1 A print test button is located on the left side of the printer. 

~ Press the button once. The printer will print a test copy of lines on paper. 

2 Check to see that the lines are smooth and consistant. 

3 A density control dial is located on the right side of the printer. 

~ A normal setting is 5. 

~ Increase or decrease the density adjustment if necessary. 

4 Print a document containing some text and graphic items for a more accurate 
density setting. 

If the Cartridge Use Indicator is not red, and white stripes appear on pages: 

1 Remove the cartridge from the printer. 

~ Hold it horizontally and turn it 45 0 in both directions several times. 

2 Replace the toner cartridge. 

3 Reprint documents. 
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If Prints Are Not Clear 

186 

It may be necessary to clean the toner cartridge: 

1 Open the top of the printer by releasing the green lever on the right side. 

~ The power will go off on the printer. 

2 Open the right side door. 

~ Remove the toner cartridge from the printer. 

3 Remove the cleaner from its storage location (see diagram). 

~ Insert the blue tip of the cleaner into the slot on the cartridge. 

~ Move the cleaner from end to end. 

4 Remove the cleaner and put it back in its storage place. 

5 Replace the toner cartridge and close the doors on the printer. 

~ The power will go back on when the top is closed. 
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Aborting a Document 
While Printing 

Pausing While Printing 

1 If you wish to abort printing while the information is being prepared for 
printing, hold down the IApple Keyl and press the period. 

2 If the front control panel displays BUSY and the activity light is blinking: 

~ Press IABORTI 

~ The READY and BUSY indicators will blink. 

~ Press IENTERlbutton within five seconds. 

~ The READY and BUSY indicators will go solid. 

~ If a sheet of paper is in the paper feed area, it will be ejected. 

3 The READY light will go solid when complete. 

4 The Lisa will display a message stating that the document is no longer being 
printed on the EP 308. 

~ Click OK. 

~ The system is ready to print the next document. 

Note: [ftwo systems are connected to the EP 308, only the document printing will be aborted. 

A IPAUSElbutton is located on the control panel. Any time you press this button 
the pause mode is activated. Pressing it a second time deactivates the pause 
mode. You may wish to activate the pause mode to add paper or to stop the 
printing of a document temporarily. 

If you press IPAUSEI while a page is printing, the indicator light will blink. This 
means a page is printing. Once the page has finished printing, the PAUSE 
indicator will go solid. When the PAUSE indicator is solid, no pages will print 
until you press the IPAUSElbutton. 

To activate the pause mode while printing a document: 

1 Press IPAUSEI on thefront ofthe ICS. 

~ The indicator will blink on PAUSE. 

2 When the page has finished printing the PAUSE indicator will go solid. At this 
time you may change the paper or complete any other function. 

3 Once completed, press IPAUSElagain. 

~ The indicator will change to BUSY and the document will continue printing. 
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Out of Paper Procedure 

Paper Jam Procedure 

188 

1 When the paper tray is empty, a solid yellow light will appear on the EP 308 
message panel. The READY indicator will flash on the ICS control panel. 

Ell" READY:, 
POWER 

r- RESET ---, ••• ABORT ENTER PAUSEI 
CONT 

2 Remove the paper tray from the lower front. 

3 Add paper to the paper tray. 

4 Replace the paper tray. The yellow light will go out, and the green light will 
re-appear on the EP message panel. 

5 The document will continue printing automatically. 

1 If a sheet of paper becomes jammed while a document is printing: 

~ A yellow light will appear on the EP panel above the paper jam symbol. 

~ The READY indicator will flash on the ICS control panel. 

2 Open the top of the printer. 

~ Release the green lever on the right side. 

~ Check for any paper and remove it. 

3 Remove the paper cassette from the front of the EP 308. 

~ Pull out any paper that is jammed. 

~ A small door is located on the back rear of the printer. Check for a jammed 
sheet of paper. 

~ Replace the paper cassette. 

~ Close the top of the printer. 

4 Once the jam has been cleared the EP 308 will re-print the jammed page and 
the rest of your document. 

Note: You must open the top to clear the message on the EP message panel. 
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Troubleshooting 

Printing Image 
Appears Skewed 

Alert Boxes 

Lisa Does Not Respond 

1 Make sure paper in the cassette is pushed to the back of the cassette. 

2 Do not jam too much paper in the cassette; paper should not be loaded above 
the indicator line on the side of the cassette. 

If you experience difficulty when printing a document, an alert box will be 
displayed on the screen explaining what the difficulty is. The alert box will 
instruct you how to solve the problem. 

1 If the BUSY indicator is displayed on the control panel of the ICS and the 
activity light is blinking: 

~ The system is preparing a document for the EP 308. 

~ This process can take a few minutes depending on the complexity of the 
document. The hourglass will remain on the screen until all information has 
been sent to the EP 308 for processing. 

~ Paper should begin to feed out of the EP 308 after a few minutes. 

2 If more than the usual time has gone by and the document is not printing: 

~ You may wish to abort the document printing. 

~ Press IABORTlon the control panel, 

~ Press IENTERI within five seconds. 

~ The indicators will blink, then point to READY. 

3 If the hourglass still appears on the screen or the system will not respond: 

~ Push the On/Off switch on the front of the Lisa. 

~ Thrn the ICS off and then back on again. 

4 If all ofthe above steps fail, and the system still will not respond: 

~ It is necessary to press the Reset button on the lower back of the Lisa. 

~ After pressing the Reset button, you must repair the Startup Disk using the 
Office System 1 micro diskette. See Office System Manual, Chapter 4, on 
repairing the startup disk. 
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Diagnostics 

2-port & System 
Memory Subsystems 

Communications 
Subsystem 

The following is a brief description of messages displayed during the 
programming of the system.The messages should help you determine if the 
equipment is working properly, and should also help you to describe any 
problems to a Compugraphic Representative. Some of these messages may only 
require a simple correction such as closing the disk drive door or putting paper in 
the printer. Most of these, however, indicate a problem that will require the 
attention of a Compugraphic Representative. 

When the system is turned on or the reset buttons are pressed, the system runs a 
self-test (diagnostics) on the different components. As the test is running, a series 
of numbers display on the control panel. If any of these tests come across a 
problem, the program stops and the test number blinks on the control panel: 

Message Meaning 
88 Power supply or CPU failure (test not started) 
00 CRC of Boot EPROM 
01 CRC of Diagnostic EPROM 
02 8155-2 Memory tests 
03 Remaining 8088 instruction tests 
04 CPU Subsystem Components test 
05 Initial System Memory test 
06 Basic RIP Subsystem test 

The following numbers are displayed when the rest of the system is tested. If any 
problems are found, the right hand decimal point on the control panel turns on. 

Message Meaning 
07 Address and Data Bus tests (Sys) 
08 Mapped Address and Data Bus tests (2-port) 
09 Data test in 1st 64K (Sys) 
OA Data test in 2nd 64K (Sys) 
OB Data test in 3rd 64K (Sys) 
OC Data test in 4th 64K (Sys) 
OD Data test in 1.5 Megabyte Memory (2-port) 
OE Contention test (2-port) 
OF Extended RIP Subsystem test 

10 
11 
12 
13 
14 

Baud Rate Timer 0 test (for Channel A) 
Baud Rate Timer 1 test (for Channel B) 
Channel A MUX test 
Channel A test 
Channel B MUX test 

15 Channel B test 
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Floppy Disk Message Meaning 
Subsystem Test 16 Board test 

17 Data Separator 

Hard Disk Subsystem test 18 Board test 

EP 308 Interface test 19 Printer power ready-maybe EP 308 is not on 
lA Interface test-Check power supply of EP 308 

Check that the paper cassette is in and full of paper 

Load Status Messages 31 Program load initiated 
32 Autoload from floppy disk 
33 Autoload from Hard Disk 
35 Boot ended (loader has been loaded) 
36 Diagnostic initiated 
37 Forced load initiated 

Program Load Errors 3A Unsupported program load device 
3b Unsupported diagnostic 
3C CRC check of loader CS & DS failed 
3D Load option not supported 
3E No load image found after autoload 

Floppy Disk 40 Floppy disk image not present 
Loading Errors 41 Disk unusable-Address mark is missing 

42 Disk unusable-Format information not valid 
43 Record specified could not be found on disk 
44 HEAD positioning failure 
45 Floppy disk controller (FDC) not generating interrupts 
46 FDC not responding correctly-Read-id failed 
47 FDC failure-Invalid command not recognized by FDC 
48 FDC failure-Valid command not recognized by FDC 
49 FDC failure-Command or Result phase failure 
4A Floppy disk is unusable-CRC error encountered 
4b Floppy disk is unusable-Could not find spec. sector 
4C Motor speed out of spec. (greater 3' out) 
4D Recalibrate didn't get track 0 signal 
4E No disk in drive or door not closed-No index pulses 
4F Floppy drive not on-line 
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Floppy Disk 
Loading Messages 

Hard Disk 
Loading Messages 

Hard Disk Loading Errors 

Selection Error 

What To Do 
When Things Go Wrong 

192 

Message 
50 

51 

Meaning 
WARNING-Motor speed is greater than 2.5 % out of specification­

schedule maintenance 
WARNING-Primary home block could not be read-Alternate home 

block was used 
53 No floppy disk drive on line after 20 retries 
54 No load images on floppy disk after 20 retries 

5A 
5B 
5C 

60 
61 
62 
63 
64 
65 
66 
67 
68 
69 
6A 
6B 
6C 
6D 
6E 

dA 

Alternate home block was used 
No hard disk drive on line after 20 retries 
No load images on hard disk after 20 retries 

Hard disk image not present 
Hard disk drive not on line 
Selected drive not available 
110 transfer error 
SCSI bus is never free 
Selected drive never returned interrupt 
SCSI bus did not return free after command 
REQ was deasserted during phase or transfer count zero 
SCSI status error class OO-drive errors 
SCSI status error class 01-target errors 
SCSI status error class 02-drive system related 
SCSI status error-equal bit set 
SCSI status error-busy bit set 
SCSI status error-invalid status returned 
Track and Sector value for transfer are too large 

Invalid switches selection, do again 

If the diagnostics have determined that there is a problem, the following steps 
should be taken: 

~ The problem may simply be that the Application Program was not installed 
on the hard disk, the paper cassette is not full or in the right location, or the 
disk drive door is not closed. All of these items are covered earlier in this 
chapter. Check each one and try to re-program the system. 

~ If the problem does not clear up, call Compugraphic Service. They can inform 
you of more detailed diagnostic tests available on the system and schedule a 
service call if necessary. 
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Introduction 

System Components 

The Compugraphic 8400 typesetter uses digitized fonts to produce characters on 
photographic paper. Digitized means that the font has been converted to a series 
of numbers. The numbers are stored on an eight-inch floppy disk. To set type, the 
8400 translates the numbers into characters, which are "printed" on 
photosensitive paper. When the paper is developed in a special processor, the 
type appears. 

You receive Personal Composition System fonts on a Master 8400 Font Diskette. 
You will move these fonts from the Master Font Disk onto a User Font Disk. You 
can have many User Font Disks, depending on how many fonts you order. 
Remember to make backup copies of User Font Disks! 

You should not typeset from Master 8400 Font Diskettes. All typesetting is done 
with a User Font Disk. The Master Font Disk is your permanent copy of font 
information for each font you buy. It should not be altered or destroyed. 

In this chapter we'll discuss 8400 hardware and software, how to install fonts, 
and how to typeset a document on the 8400. 

This section introduces the 8400's components and explains how they interact. 

Paper Film 
Transport Compartment 

Film 
Counter 

Cassette Compartment 
for Photographic 

Material 

Disk Drive 

2nd Disk Drive 
optional 

The On/Off Button is located on the left side of the middle panel of the 8400. 
You must turn the 8400 on before you insert any disk. When you turn it on, you 
will see a series of numbers and letters on the Status Message Display. This 
indicates that the 8400 is performing a self test. The Status Message Display keeps 
you informed of conditions and errors in the 8400. 
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Control Panel 

.~­l.~~~_~ ~ 

On/Off 
Button 

Message 
Display 

By pressing buttons on the Control Panel, you can direct the 8400 through 
various operations. When you enter data through the Control Panel, the 
information entered appears on the Status Message Display. 

Disk Drives One disk drive is standard on the 8400. You may also buy an 
optional second disk drive or an internal hard disk for the 8400 typesetter. The 
internal hard disk is called the "100 Font Option." Disk Drive 1 is the top drive on 
the 8400. Drive 2 is the bottom drive. 

Disk Drive 

Silver 

The 8400 reads programs and fonts from the floppy disk in the disk drive. Always 
turn the 8400 on before placing a disk in the disk drive. Insert all disks with the 
identification label facing left. If a disk is not loaded correctly, the 8400 disk 
drive cannot read the information stored on the disk. 

After placing a disk in a disk drive, close the drive door by gently pushing it to the 
right until it clicks. To remove a disk from a disk drive, push the release button to 
the right of the drive door. As the door opens, the disk pops out about one inch. 
Make sure all floppy disks are removed from the disk drives before you turn off 
the 8400. 
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Software Components 

Font Setup 

Font Complements 

You will use three disks to make a User Font Disk. 

• The first disk is called the Font Librarian Program. The Font Librarian turns 
the 8400 into a font transfer machine. You must load the Font Librarian 
Program before fonts can be copied from the Master Font Disk to the User 
Font Disk. 

• The second set of disks are the Master 8400 Font Diskettes. They contain the 
fonts the Personal Composition System will use. You must copy the 
information from the Master Font Disk to a User Font Disk. 

• Each Master Font Disk comes with a 8400 Font Diskette Printout. The 
printout is a list of font names and numbers. You will use the information on 
this printout when making the User Font Disk. 

• The third disk is a blank eight-inch floppy disk. This will become the User 
Font Disk. The User Font Disk can hold as many as 16 fonts. If you own more 
than 16 fonts, you will need more than one User Font Disk. Make sure all 
disks and this manual are close at hand when you make User Font Disks. 

Each Personal Composition System font has more characters than each 8400 font. 
To typeset all the Personal Composition System characters, the 8400 needs two 
font complements for each font. Both complements must be on the same User 
Font Disk. 

Every 8400 font you buy will arrive in two parts. The first will be a 500, 501 or 
549 font complement. The second will be either a 5944 or 5477 font 
complement. Make sure you copy both parts to your User Font Disk. 

A User Font Disk can hold up to 16 fonts. Each font complement fills one of the 
16 available font positions on the User Font Disk. 

Another font you must include on each of your User Font Disks is the Graphic 
Elements Font. It has a font complement of 5942. This font contains the different 
components the 8400 needs to typeset graphs, figures, and shading from the 
Personal Composition System. 

You may see the code 00:63 on the 8400 message display if you forget to include 
the Graphic Elements Font on the User Font Disk. If you see the 00:63 message, 
you probably need to add the Graphic Elements Font to this User Font Disk. 
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To make a User Font Disk, you need information contained on the Font Disk 
Printout. Let's look at the upper left corner of the printout. (Each printout may 
look slightly different. ) 
Date: 06-Apr-85 10:10:07 
Order/I: 101111 
Control Code: 508 
Disk Type: MCS 8400 Font Diskette 
Files on Diskette 
UID Comp # Face # Ex 

000501 FC 
000501 002244 FAO 

1 000501 002244 FDL 
000501 002500 FAO 

2 000501 002500 FDL 
000501 002780 FAO 

3 000501 002780 FDL 
000501 002782 FAO 

4 000501 002782 FDL 
000~01 002783 FAO 

5 000501 002783 FDL 
005477 FC 

6 005477 002780 FDL 
005477 002782 FAO 

7 005477 002782 FDL 
005477 002783 FAO 

8 005477 002783 FDL 
005942 FC 
005942 002843 FAO 

9 005942 002843 FDL 
005944 FC 
005944 002244 F AO 

10 005944 002244 FDL 

Description 
DOMESTIC 2 
TRIUMVIRATE 
TRIUMVIRATE 
CG TIMES 
CG TIMES 
10 P MODERN I L 
10 P MODERN 
10 P COURIER/L 
10 P COURIER/L 
12 PITCH ELITE/L 
12PITCHELITE/L 
PERS COMP SYSTEM 1 
10 P MODERN 
10 P COURIER/L 
10 P COURIERIL 
12 PITCH ELITE/L 
12 PITCH ELlTE/L 
PERS COMP SYS GEL 
GRAPHIC ELEMENTS 
GRAPHIC ELEMENTS 
PERS COMP SYSTEM 2 
TRIUMVIRATE 
TRIUMVIRATE 

TID 

TID 

TID 

T 

T 

T 

T 

T 

T 

T 

TID 

The top section contains information about the Master Font Disk. It gives the 
date the fonts were produced, the order number that corresponds to the sales 
order number, and the control code that corresponds to your business's customer 
number. This number prevents these fonts being used on any other 8400. The 
disk type is an 8400 font disk. 

The rest of the printout lists the font names and the numbers associated with 
them. Each font has both a 12-digit number and a name. The 12-digit number is a 
combination of the Comp# and Face# columns. Combining these two columns 
provides a unique number for every font. The first column is the Comp# column. 
Comp is short for Complement. A complement is the special set of characters 
that are contained on the font. The Pace# column contains the part number for 
each font. 

The Ex column contains kerning information used by other front end systems 
(not by the Personal Composition System). The Description column is the font 
name. The TID column designates whether the font is a Text or Display cut. 
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Assigning 
UID Numbers 

The first column on the left lists the User Identification number (DID) for each 
font. You will use the UID number to copy the font from the Master Font Disk to 
the User Font Disk. 

The UID numbers assigned by Compugraphic are repeated on each Master Font 
Disk. If your fonts are sent on two or more Master Font Disks, some fonts will 
have the same UID numbers. Before you transfer the font information from the 
Master Font Disk to the User Font Disk, you must assign a unique UID number to 
each font used on the 8400. 

1 Remove the plastic wrapper from the first Master Font Disk. 

~ With a felt tip pen, write the number "1" on the disk label and the printout. 

2 You must assign a unique 4-digit UID number to each font on the printout. 

~ Label the fonts on the first Master Disk 100 plus the UID number already on 
the printout. For example, 1001, 1002, etc. 

~ If there is a second Master Disk, write the number "2" on the disk label and 
on the printout. For the unique DID number, place a 200 plus the UID 
number already on the printout. For example, 2001, 2002, etc. 

3 For each Master Disk that you have, label each disk, printout, and UID as 
described above. 

Date: 06-Apr-85 10:10:07 
Order II: 101111 
Control Code: 508 
Disk Type: MCS 8400 Font Diskette 
Files on Diskette 
UID Comp II Face II Ex Description 

000501 FC DOMESTIC 2 
000501 002244 FAa TRIUMVIRATE 

1001 000501 002244 FDL TRIUMVIRATE 
000501 002500 FAa CG TIMES 

1002 000501 002500 FDL CG TIMES 
000501 002780 FAa 10 P MODERN I L 

1003 000501 002780 FDL 10 P MODERN 
000501 002782 FAa 10 P COURIER/L 

1004 000501 002782 FDL 10 P COURIER/L 
000501 002783 FAa 12 PITCH ELITE/L 

1005 000501 002783 FDL 12PITCHELITE/L 
005477 FC PERS COMP SYSTEM 1 

1006 005477 002780 FDL 10 P MODERN 
005477 002782 FAa 10PCOURIER/L 

1007 005477 002782 FDL 10PCOURIER/L 
005477 002783 FAa 12PITCHELITE/L 

1008 005477 002783 FDL 12PITCHELITE/L 
005942 FC PERS COMP SYS GEL 
005942 002843 FAa GRAPHIC ELEMENTS 

1009 005942 002843 FDL GRAPHIC ELEMENTS 
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Font Librarian 
Utilities 

Making an 8400 
User Font Disk 

Loading the 
Font Librarian 

You will use the Font Librarian Program to copy fonts and perform other utility 
functions. The utility functions initalize a floppy disk, transfer fonts from Master 
Font Disks to User Font Disks, and delete fonts from the User Font Disk. 

Each utility function is accessed by a number. Utility functions are 

Utility Number Utility Function 
40 Set Internal Clock 
41 Initialize a Floppy Disk 
42 Copy Font by UlD Number (one disk drive) 
43 Copy Font by 12-Digit Number (one disk drive) 
44 Copy Font by UlD Number (two disk drives) 
45 Copy Font by 12-Digit Number (two disk drives) 
46 Duplicate User Font Disk (two disk drives) 
47 Delete Font by UID Number 
48 Delete Font by 12-Digit Number 
49 Erase a User Font Disk 
60 Display Font Disk Information 
61 Display Single Font 
62 Display All Fonts on Disk 

To use the Font Librarian functions, load the Font Librarian Utility Program disk 
into the 8400. To use a specific function, enter that function's number on the 
8400 Control Panel. The Status Message Display tells you what the 8400 is doing. 
Step-by-step directions for each utility function are given in the next section. 

For this procedure you will need: 

• The Font Librarian Program 

• The Master Font Disk(s) 

• Blank 8-inch floppy disks 

Have these items at hand when you get ready to make font disks. The following 
steps are only done once-when setting up fonts. They are not done daily. 

1 Push the 8400 On/Off button to ON. 

• Insert the Font Librarian Program into the disk drive and close the door. The 
label on the disk should be facing left. 

• Press IRSTI ~ ~(reset, load, enter) on the Control Panel. 

• Wait about 1 minute. 

• When the codeOOOO appears and the red pause light comes on, press the 
button to the left ofthe disk drive door. 

• Remove the disk. 
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Iinitializing Floppy Disks 

2 Set the time stamp: 

~ Press 40. 

~ Press 2-digit hour. 

~ Press the ISEPlbutton (separate). 

~ Press 2-digit minute. 

~ Press ISEPI. 

~ Press 2-digit second. 

~ Press~(enter) 

~ AOOO appears when the time stamp is set. 
1 Select a blank 8 inch floppy disk. Make sure a tab is over the notch, and insert 

the blank disk into the disk drive. 

~ Press 41. 

DI~I 
o 

01-1 
o 

Fold tab over Diskette 

~ Press the letters, FA C E F ACE to give the disk a name (you can give the disk 
any eight character name). 

~ Press~. 

~ Wait for bbbb on the message panel and the red pause light to come on. 

~ AOOO appears when the procedure is complete. 

~ Remove the disk from the drive. 

2 To initialize another disk 

~ Insert the new disk into the disk drive. 

~ Press thelP/Clbutton. 

~ Wait for bbbb on the message panel and the red pause light to come on. 

3 When you have initialized all your disks: 

~ Press IQI~~. 

Note: Do not initialize your Master Font Disks! You only initialize blank floppy 8 inch User 
Font Disks. 
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Copying Fonts 
Single Disk Drive 

Complete the following steps if your 8400 has a single disk drive. 

I The 8400 should be programmed with the Font Librarian as outlined above. 

~ Insert the Master Font Disk into the disk drive. 

~ Press 42. 

~ Press the 4-digit UID that was originally on the Master Font Disk printout. 
You must enter leading zeros to make the DID 4-digits. For example, 0001, 
0002, etc. 

UID Compll 
000501 
000501 

1 000501 
000501 

2 000501 

~ Press ISEPI 

Face II Ex Description 
FC DOMESTIC 2 

002244 FAO TRIUMVIRATE 
002244 FDL TRIUMVIRATE 
002500 FAO CG TIMES 
002500 FDL CG TIMES 

~ Press the unique 4-digit UID that you created on the printout (ex: 1001). 

~ Press~ 

~ Wait for bbbb, then remove the disk from the drive. 

~ Insert an initialized User Font Disk. 

~ Press Ip/C~ 

~ Wait for bb:bb and remove the User Font Disk. 

~ Press~ ~ ~ 

TID 

TID 

TID 

~ Start from step 1 of this procedure to ~opy each font from the Master Font 
Disk to the User Font Disk. You may use different Master Font Disks to copy 
other fonts if necessary. 

If the code CCCC appears on the message panel instead of bb:bb, the whole font 
cannot be transferred to the User Font Disk in one step. The font must be 
transferred in several portions. 

~ Insert the User Font Disk and press Ip/c~ 

~ Wait for the code CCCC again, and re-insert the Master Font Disk. 

~ Press Ip/c~ 

~ Continue switching the Master and User Font Disks and pressing IP/Cluntil 
AOOO appears on the message panel. This means the font transfer is complete. 

~ Continue copying the next font. 
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Copying Fonts 
Dual Disk Drive 

Copying Fonts 
To the Hard Disk 

(100 Font Option) 

Complete the following steps if your 8400 has two floppy disk drives. 

1 Program the 8400 with the Font Librarian as outlined above. 

~ Insert the Master Font Disk into the top disk drive. 

~ Insert the initialized User Font Disk into the bottom disk drive. 

~ Press 4 4. 

~ Press the 4-digit UID that was originally on the Master Font Disk printout. 
You must enter leading zeros to make the UID 4-digits. For example, 0001, 
0002, etc. 

~ Press ISEPI. 

~ Press the unique 4-digit UID that you created on the printout (ex: 1001). 

~ Press~. 

~ The font will be copied from the Master Font Disk to the User Font Disk. 

~ When you see the code AOOO, the font has been copied successfully. 

~ Start from step 1 of this procedure to copy each font from the Master Font 
Disk to the User Font Disk. You may use different Master Disks if necessary to 
copy other fonts. 

Complete the following steps if your 8400 has an internal hard disk. 

1 Program the 8400 with the Font Librarian as outlined above. 

~ Press 3 2 3~ 

2 Insert the Master Font Disk into the top disk drive. 

~ Press 4 4. 

~ Press the 4-digit UID that was originally on the Master Font Disk printout. 
You must enter leading zeros to make the UID 4-digits. For example, 0001, 
0002, etc. 

~ Press ISEPI. 

~ Press the unique 4-digit U1D that you created on the printout (ex: 1001). 

~ Press~. 

~ The font will be copied from the Master Font Disk to the Hard Disk. 

~ When you see the code AOOO, the font has been copied successfully. 

~ Return to step 2 for each font you want to copy to the hard disk. 
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Deleting Fonts 

When All Fonts 
Are Copied 

Status Messages 

The Delete Font Utility can be used to delete a font you copied to the wrong disk 
or to delete a font from a disk to substitute a different font. Never delete a font 
from a Master Disk. To delete a font from a disk: 

1 The 8400 should be programmed with the Font Librarian as outlined above. 

2 If you are deleting a font from a floPPY disk, insert the disk into the top drive. 

3 Press 47 

~ Enter the 4-digit UID of the font to be deleted. 

~ Press ISEPI 

~ Enter 
1 to delete from floppy disk (in drive 1). 

3 to delete from hard disk. 

~ Press~ 

~ The font will be deleted from the disk. 

When the fonts have been copied, label the disk. If you copied them to a floppy 
disk take off the tab so that the disk cannot be erased accidently. 

Listed below are number codes that may appear in the Status Message Display 

Code 
Displayed 

00:00 
AO:OO 
bb:bb 
CC:CC 
CO:Ol 
CO:02 
CO:03 
CO:04 
CO:05 
CO:06 
CO:07 
CO:08 
CO:09 
CO:1O 
FA:80 
FA:91 
FA:93 
FA:96 
FA:97 

Cg Compose 2 

Message 
Reset Operation Complete, 8400 Ready 
Operation Complete 
Operation Complete 
Font Operation Not Completed 
Illegal Utility Command 
Illegal Device 
Illegal Time Entry 
Illegal Date Entry 
Write Protected Disk-Must have a protect tab over slot 
Illegal Name/Tag Entry-Enter four digits for UID 
Destination DID Required 
Not Applicable to Master Disk 
UID or Part Number Required 
UID Not Found 
Device Not Found 
Critical Resource Not Present, Disk not Formatted, etc. 
File Already Exists/Read Failure/Font Not Found 
Disk Full 
No Disk 



Font Dump Utility The Font Dump Utility will give you a printout of font information stored on 
User Font Disks. The printout identifies the disk drive, disk volume name, UID 
number, character complement and typeface number, font name, and date the 
font was created by Compugraphic. 

To obtain a font dump: 

1 Load the Font Dump Utility Program 

~ Push the 8400 On/Offbutton to ON. 

~ Make sure typesetting paper has been loaded in the 8400 paper compartment. 

~ Insert the Font Dump Utility Disk into the disk drive and close the door. The 
label on the disk should be facing to the left. 

~ Press IRSTI ~ ~(reset, load, enter) on the Control Panel. 

~ Wait about 1 minute. 

~ When the code 00:08 appears and the red pause light comes on, press the 
button to the left of the disk drive door. 

~ Remove the disk. 

2 To obtain a printout of the fonts on a floppy disk: 

~ Insert the User Font Disk into the top disk drive. 

~ Press 511 ~ 

3 To obtain a printout of the fonts on a hard disk 

~ Press 513~ 

4 The code 00:10 will appear in the Status Display 

~ The 8400 will read the disk and begin to typeset the font dump. 

5 When the code 00:11 appears 

~ The 840'0 is finished. 

~ Presslffi Iffi 
~ Cut the typesetting paper in the cassette compartment using the paper cutter. 

~ Remove the cassette and process the paper. 

~ Put the cassette back and press it firmly in place. 
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Loading the 
8400 Program 

For Daily Operation 

Format for Printer 

206 

To program the 8400 for daily operation you must first load the Operating 
Program. Once this program is loaded into memory you will remove the disk 
and insert the appropriate User Font Disk. Leave the User Font Disk in the disk 
drive while the 8400 is typesetting. 

1 To load the Operating Program 

~ Push the On/Off button to On. 

~ Insert the green label disk with the name Basic Operating Program into the 
disk drive. Close the disk drive door. 

If you are loading the program for the first time after powering-up, the program 
will start loading automatically when the disk drive is closed. 

If the 8400 has been on for a while, or you are reloading programs: 

~ Press IRSTI ~ ~. 

~ The message 00:08 will appear in about 45 seconds. 

Note: . See the list on page 18 if another message appears. 

~ Press the button to the left of the disk drive door. 

~ Remove the Program Disk. 

~ If the fonts you wish to use are stored on a User Font Disk, insert the 
appropriate one into the disk drive. 

~ Close the disk drive door. 

~ Press IP/CI. The pause light will go out. 

Before typesetting a document you must make several choices 

1 Make sure that Preferences are setup as described in Chapter 4 for the 8400. 

2 Choose Format for Printer . .. from the File/Print menu. 

~ If Format for Compugraphic 8400 Typesetter does not appear in the upper 
left corner, 

~ Click on INew Printerl. 

You will see a screen displaying Format for Which Printer? 

~ Click on Cg 8400 Typesetter. 

~ Click on OK. 

3 The Format for Compugraphic 8400 Typesetter will appear. 
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Typesetting a 
Document 

~ Paper Size Choose the size paper that you will be using. If you are 
typesetting a Compose 2 document, the paper size must correspond with the 
size choosen in the Page Size menu. 

~ Printing Orientation The first selection allows you to print documents up 
to 8 inches wide (Portrait Mode). The second selection allows you to print 
documents up to 11 inches wide (Landscape Mode). 

~ Print Quality Use high resolution for the 8400. This produces the highest 
quality output. Low resolution is used only to speed up the typesetter. If you 
are printing in low resolution landscape mode, the size of your characters will 
be reduced by approximately one third. 

1 See Chapter 4 to make sure the Preferences are set up correctly for typesetting 
on the 8400. 

2 Make sure the pause light is out on the 8400 control panel. 

~ If the Pause light is on, press IP/Clon the Control Panel. 

3 Send a file to the 8400 by choosing Print ... from the File/Print menu. 

Note: If you want only one copy of the document, choose, "Print As Is," from the File/Print 
menu. The printer defined in the Format for Printer. will be used. 

~ Select All Pages or a range of page(s). 

~ ClickOK 

4 The message 00: 10 will appear on the Status Display when the document 
begins typesetting. 

Note: Errors that might appear while typesetting include No Cassette, Out of Film, Paper jam, 
etc. A list of these messages appears at the end of this chapter. 

4 When 00:11 appears, typesetting is complete 

~ Press Ip/cl on the Control Panel once. 

~ The red pause light will come on. 

~ Press IEB IEB to advance the paper into the cassette. 

5 Open the right side door and move the paper cutter across the paper. 

~ Lock the paper in the cassette by pressing the lever on the cassette. Pull back 
and up to remove the cassette. 

6 Take the cassette to the processor. 

~ Fold the paper according to the instructions on the processor. 

~ Once the paper is processed, remove the cassette. 
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Troubleshooting 

8400 Status Messages 

~ Replace the cassette in the 8400. Align it against the front blue guide and push 
straight down hard, until you hear it click. 

6 Press the Ip/cl button once. The red pause light will go out. 

If you wish to stop a document from typesetting once it has been sent: 

1 Press IRSTI ~ on the 8400 control panel. 

~ The Lisa will display an alert box saying that typesetting has been terminated. 

~ ClickOK 

Below is a list of some common messages that may appear on the 8400 Control 
Panel. Most of the messages can be corrected by: 

~ Pressing IRSTI ~ on the Control Panel 

~ Correcting the problem 

~ And re-typesetting the document. 

Message 
00:08 
00:10 
00:11 
00:63 

00:91 
00:92 
00:93 
OA:13 

OA:33 

OA:39 

FA:97 

Meaning 
ProgramminglReset Operation Complete 
Document is 1:ypesetting 
Document is Done Typesetting 
Font Does not exist on disk 
Press IRSTI ~ and replace with correct User Font Disk 
Is the Graphic Elements (Camp # 5942) font on the disk? 
Character Not On Font 
Disk Read Error 
Cannot Access Character On Disk 
No Typesetting Paper 
Replace Paper and press IRSTI ~ 
No Cassette 
Insert Cassette and press IRSTI ~ 
Paper]am 
Correct Paper and press IRSTI ~ 
No Disk 

Other indicators on the control panel include: 
Pause light is on Pause active-press Ip/cl to typeset. 
Pause light blinking Pause will be active at end of document. 
Busy light on the 8400 is busy typesetting a document. 
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Alert Boxes If you experience difficulty when typesetting a document, an alert box will be 
displayed on the screen explaining what the difficulty is. The alert box will 
instruct you how to solve the problem. Some common problems and solutions: 

• A font is not on the disk may appear if you did not copy all the necessary 
fonts to the 8400 disk. See the procedure outlined earlier in this chapter. 

Make sure that you loaded the Graphic Elements font on the 8400 disk 
(Complement #5942). This font is necessary for the 8400 to typeset figures, 
drawings and graphs, and must be copied to each User Font Disk. 

• A font does not exist on the Lisa may appear if you changed the Cg font 
library. See Chapter 5 for more information on the Font Librarian. 

• No Paper or No cassette conditions messages may appear on the screen. 
Correct the problem on the 8400 

• Cannot print your document may appear if Preferences are not set up 
correctly (see Chapter 4), the Format for Printer ... dialog box is not setup 
correctly, or the 8400 is not programmed. 
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Introduction 

Hardware Components 

The Compugraphic 8600 typesetter uses digitized font information to produce 
character images on photographic paper. Digitized means that each character has 
been converted to a series of numbers. These numbers are stored on the 8600 
internal hard disk. To set type, the numbers pass through a computer, which 
translates them into the characters we know. They are projected onto 
photographic paper, which is developed in a separate processor. 

The fonts used by the Personal Composition System are sent to you on 8600 Font 
Diskettes. To typeset on the 8600, you must copy each font from the Font 
Diskette to the 8600 internal hard disk. Font Diskettes are write protected so they 
cannot be altered or destroyed. 

In this chapter you will learn about the 8600 hardware and software, how to 
install fonts, and how to typeset a document on the 8600. 
This section introduces the hardware components of the 8600 and explains how 
to use them. 

Mini 
Disk Drive 

Switch 

Control 
Panel Material 

Cassette 
Compartment 

The On/Off Button is located in the middle of the 8600. You must turn on the 
8600 before inserting any diskette. Once the power is on, the 8600 will show a 
series of numbers on the Status Message Display. These numbers mean that the 
8600 is conducting a self test and programming itself. The Status Message Display 
keeps you informed of conditions and errors in the 8600. 
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Essentials 

Font Setup 

Control Panel 

8600 Front Panel 

By pressing buttons on the Control Panel, you can direct the 8600 through 
various operations. When you enter data through the Control Panel, the 
information entered appears on the Status Message Display. 

Internal Hard Disk stores all programs and fonts used by the 8400. When the 
8600 needs a font, it "reads" that font from the hard disk into 8600 memory. 

Disk Drive is used to install programs and fonts from diskettes and to the 
internal hard disk. Insert all diskettes with the identification label facing up. If a 
diskette is not placed in the disk drive correctly, the 8600 cannot read the 
information on the diskette. Always make sure the 8600 is turned on before 
placing a diskette in the disk drive. 

After inserting a diskette in a disk drive, close the drive door by gently pushing it 
down. To remove a diskette from a disk drive, lift the drive door up and pull the 
diskette out. Make sure all diskettes are removed from the disk drive before you 
turn of/the 8600. 

All 8600 fonts are sent to you on 5 \4 inch Font Diskettes. Each diskette contains 
one font. You must install the information on the Font Diskettes to the 8600 
internal hard disk. 

Look at the 8600 Font Diskette labels. You will use the information on these 
labels when installing fonts to the hard disk. 
Make sure that all disks and this manual are close at hand when installing fonts. 
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8600 Font Diskette Labels 

Font Complements 

Assigning 8600 
Font Position 

Numbers 

The label on each 8600 Font Diskette contains important information. Look at 
the label: 

~ The top line contains the Font Name. The letters T, D, or TD designates a 
Text, 'Display, or Text/Display cut. 

~ TF #: is the unique typeface number assigned by Compugraphic. 

~ COMP #: is the complement number for this font. Complements are 
explained below. 

~ PC #: is an internal control number that Compugraphic issues to keep track of 
all diskettes. 

~ C/C: is the control code that corresponds to your business's customer 
number. This code prevents the fonts from being used on another 8600. 

~ The last line is the date the font was created by Compugraphic. 

Each font on the 8600 is comprised of three Font Diskettes: 

~ The first two diskettes are Primary Diskettes. They contain the basic 
alphanumeric characters. The Primary Diskette labels have the Comp 
numbers 5002, 5477, or 5944. 

~ The third diskette is a Pi Diskette. This diskette holds special characters used 
in typesetting. Pi Diskettes have Comp numbers of either 500,501, or 549. 

The combination of these three diskettes make up one font on the Personal 
Composition System. The 8600 finds the correct character in each font. 

Another font you must load on the hard disk is the Graphics Elements Font. It 
has a font complement of 5942. This font contains the different components the 
8600 needs to typeset graphs, figures, and shading from the Personal 
Composition System. This font is copied as a Primary Diskette. 

In the following procedure you will assign a unique Font Position Number to 
each 8600 Font Diskette. This number is used when installing fonts on the 8600 
hard disk. 

1 Group all Font Diskettes with the same name and TF # together. There should 
be three diskettes for each font. 

2 To help organize your font library, place the fonts in alphabetical order. This 
is an optional step, which will help you in later procedures. 

3 Each Font Diskette must now be given a unique font position number. 
Remove the plastic wrapper from the three diskettes for the first font. 

~ Look for the diskette with the COMP # " 005002-this is the first Primary 
Diskette for this font. 
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216 

~ With a felt tip pen, write the number 1.0 on the 5002 diskette label. 

~ Look for the Pi Diskette with the COMP # " 000500, 000501, or 000549 next. 
Write the number 1.2 on this diskette label. 

~ Finally, write the number 2.0 on the diskette labeled COMP # " 005944 or 
COMP # " 005477. This is the second Primary Diskette. 

4 Continue this numbering process for all fonts in your library. 

~ The next set of Font Diskettes will be labeled],O, 3.2, and 4.0. 

Note: If your 8600 has fonts that are used by another front-end system you may have to start 
with a different numbering process. Each font must have a unique location. 

For this procedure you will need: 

• The Font Diskettes numbered as described above 

These procedures only have to be done when installing/onts. They are not done 
on a daily basis. A step-by-step list of procedures appears below. 

1 Push the 8600 On/Off button to ON. 

~ When the code 03 appears, the 8600 is programmed. 

2 Install the first three Font Diskettes. 

~ Insert the Font Diskette labeled 1.0 into the disk drive. 

~ On the front control panel, press iFONTi. 

~ Press 1 0 then iLOAOi. 

~ The message OC 051 will appear 

~ When OC 053 appears, remove the diskette. 

~ Insert the Pi Diskette labeled 1.2. 

~ Press iFONTil 2 then iLOAOi. 

~ When OC 053 appears, remove the diskette. 

~ Insert the Primary Diskette labeled 2.0. 

~ Press iFONTi2 0 then iLOAOi. 

~ When OC 053 appears, remove the diskette. 

3 Repeat the above steps for each set of Font Diskettes. Be sure to enter the font 
position number you wrote on each diskette. 

~ Additional displayed number messages are listed later in this chapter. 
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Creating a 
Slave Font Table 

Messages and 
Meanings 

Font Directory 

After all Font Diskettes have been installed on the 8600 it is necessary to create a 
slave font table. This is a table used by the 8600 as an internal font directory. A 
slave font table must be recreated whenever you add or delete fonts from the 
8600. If you do not recreate it, the 8600 will not acknowledge the new fonts. 

To make a slave font table: 

~ Press the numbers 5 4 5. 

~ Press IENTI. 

It is only necessary to make a slave font table after you add fonts to your 8600 
hard disk. It is not necessary to create one every day. 

The following messages may appear on the Status Message Display while 
installing fonts: 

Number 
Displayed 

OC051 
OC053 
OC059 

OC063 

oc065 
OC067 

OC073 
OC083 

Message 
The font is being installed. 
The font is installed on the hard disk. 
The diskette in the drive is not an 8600 Font Diskette. 
Check the diskette in the diskette drive. 
You are loading a Pi Diskette before loading the Primary Diskette. 
Install the Primary Diskette first. 
A font already occupies this position. 
You are installing a Pi Diskette before installing the Primary. 
Install the Primary Diskette first. 
Primary font already exists. 
Wrong typeface for Master (for example, Triumvriate Pi 
Complement for Cg Times Master). 

The Font Directory is a printout of font information stored on the hard disk. 

To print a Font Directory: 

~ Make sure typesetting paper has been loaded in the 8600 paper compartment. 

1 Push the 8600 On/Offbutton to ON. 

~ Press 5 3 llRUNI 

~ The 8600 will print a directory. 

~ When the message 032 or 034 appears. 

~ PresslPAUSElthenlFILM FEEDI. 

~ Cut the typesetting paper in the cassette compartment using the paper cutter. 

~ Remove the cassette and process the paper. 
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Using the 8600 
For Daily Operation 

Format for Printer 

1b program the 8600 for daily operation turn the system on. The operating 
program automatically loads from the hard disk. 

1 To program the 8600 

~ Push the On/Off button to On. 

~ The message 001 will appear 

~ When the message 003 appears, the 8600 is ready. 

Note: See the list below if another message appears. 

~ If your 8600 is setup to default to the Personal Composition System it is ready 
to typeset documents. 

2 If your 8600 defaults to a different front-end 

~ Press 3 9 21ENTI 

~ Press 61 61ENTIIRUNI 

Before typesetting a document you have several choices to make. 

1 Make sure that Preferences are set up as described in Chapter 4. 

2 In the document, choose Format for Printer ... from the File/Print menu. 

~ If Format for Compugraphic 8600 Typesetter does not appear in the 
upper left corner, 

~ Click on INew Printerl. 

You will see a screen displaying Format for Which Printer? 

~ Click on Cg 8600 Typesetter. 

~ Click on OK. 

3 The Format for Compugraphic 8600 Typesetter will appear 

~ Paper Size Choose the paper size you will be using. If you are typesetting a 
Compose 2 document, the paper size must correspond to the size chosen in 
the Page Size menu. 

~ Printing Orientation Choose your printing orientation. The first selection 
allows you to print documents up to 8 inches wide (portrait mode). The 
second selection allows you to print documents up to 11 inches wide 
(landscape mode). 

~ Print Quality Generally high resolution is used for the 8600. This produces 
the highest quality output. Low resolution can be used to speed up the 
typesetter. If you are printing in low resolution landscape mode, the size of 
your characters will be reduced by approximately one third. 
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Typesetting a 
Document 

Terminating Typesetting 

1 See Chapter 4 to make sure the Preferences are set up correctly for typesetting 
on the 8600. 

2 Make sure the pause light is out on the 8600 control panel. 

~ If the pause light is on, press !RUN~ 

3 Send a file to the 8600 by choosing Print ... from the File/Print menu. 

Note: If you want only one copy of the document, choose, "Print As Is," from the File/Print 
menu. The printer defined in the Format for Printer. will be used. 

~ Select All Pages or a range of page( s). 

~ ClickOK 

4 The message 030 will appear when the document begins typesetting. Then 
the message 031 will appear in the status window. The 8600 will beep. 

Note: Errors that might appear while typesetting include No Cassette, Out of Film, Paper Jam, 
etc. A list of these messages appears at the end of this chapter. 

5 Typesetting is complete when 032 or 034 appears. 

~ Press !PAUSE!on the Control Panel. 

~ The red pause light will come on. 

~ Press !FILM FEED! to advance paper into the cassette. 

6 Open the right side door and move the paper cutter across the paper. 

~ Lock the paper in the cassette by pressing the lever on the cassette, and pull 
back and up to remove the cassette. 

7 Take the cassette to the processor. 

~ Fold the paper according to the instructions on the processor. 

~ Once the paper is processed, remove the cassette. 

~ Replace the cassette in the 8600. Align it against the front blue guide and push 
straight down. 

8 Press the !RUN!button once. The red pause light will go out. 

~ The 8600 is ready to typeset additional documents. 

If you wish to stop a document from typesetting once it has been sent: 

1 Press !RESET! on the 8600 control panel. 

~ The Lisa will display an alert box saying that typesetting has been terminated. 

~ ClickOK 
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Troubleshooting 
8600 Status Messages 

Alert Boxes 

Below is a list of some common messages that may appear on the 8600 Control 
Panel. Most of these conditions can be corrected by: 

~ Pressing !RESET! on the Control Panel. 

~ Correcting the problem. 

~ Pressing !RUN!. 

~ And typesetting the document again. 

Message 
001 
003 
005 
007 
011 
013 
015 
017 
030 
031 
032 
034 

Meaning 
System performing self-test. 
System self-test completed. 
Ready for operation. 
8600 is in the pause mode. 
No film; check paper supply and print document. 
No cassette; check cassette compartment and print document. 
Paper not feeding properly. Check paper transport. 
Cover is open. 
Starting a document. 
Document input is complete. 
End of document. 
End of document. 

If you experience difficulty when typesetting a document, an alert box will be 
displayed on the screen explaining what the difficulty is. The alert box will 
instruct you how to solve the problem. Some common problems and solutions: 

• A font is not on the hard disk may appear if you did not load all of your 
fonts onto the 8600 hard disk. To load a font onto the hard disk see the 
procedure outlined earlier in this chapter. 

Make sure that you loaded the Graphic Elements font on the 8600 hard disk 
(Complement #5942). This font is necessary for the 8600 to typeset figures, 
drawings and graphs. 

This message may also appear if you did not create a Slave Font Table on the 
8600. This procedure is outlined earlier in the chapter. 

• A font does not exist on the Lisa may appear if you changed the Cg font 
library. See Chapter 5 for more information on the Font Librarian. 

• No Paper or No cassette conditions messages may appear on the screen. 
Correct the problem on the 8600 

• Cannot print your document may appear if Preferences are not set up 
correctly (see Chapter 4), the Format for Printer ... dialog box is not setup 
correctly, or the 8600 is not powered up. 
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Cg Compose 2 and 
Other Tools 

The most efficient way to use Compose is to take information created in other 
source documents and assemble the final page layout of your document in Cg 
Compose 2. This is done by copying all or part of your source documents and 
pasting the information into Compose galleys. The source information is divided 
into two different categories: text and figures. 

• Text includes documents that are created with LisaWrite, LisaCalc, LisaList, 
LisaTerminal, and tables from LisaGraph . 

• Figures include documents created with LisaProject, LisaDraw, and LisaGraph. 

Text Text can be thought of as a stream of characters that can be edited, reformatted, 
and changed. Each of the entries in a Lisa Graph , LisaCalc, or LisaList table is 
regular text that is separated by tabs and returns. When the text is merged into 
Compose, you can not perform the specialized functions of the original tool, for 
example the calculations of LisaCalc, but you can change the display of the text. 

Figures 

Special Applications 

When you copy a speadsheet or a list the information is in columns separated by 
tab stops and returns. The text table will retain the tab stops and returns when 
pasted into a Compose galley and then merge into a compartment. You may go 
into the text table and edit the columns by replacing information or changing the 
tab stop position of the columns. You cannot stretch the tabs larger than the size 
of the compartment. 

Eachfigure is considered a block when copied and pasted into a Compose galley. 
You cannot revise or edit the contents of information within the boundries of the 
figure. You can move the figure around on the page. You can crop the figure by 
grabbing the outside edge of the block and pulling the edge over the figure. The 
figure will not shrink, but the amount that you can view will decrease. 

Note: You cannot edit text that is part of the drawing, graph, or project chart. 

LisaTerminal You can paste text from Lis:iferminal documents directly into 
Compose, but it is reccomended that you paste them into LisaWrite first. In 
LisaWrite you have the Search and Replace feature, which you can use to remove 
extra returns and spaces that may be added to your text in the transmission. You 
also can use the Spelling Checker to proof your writing before you paste it into a 
Compose document. This step may help you detect errors in communications. 

Figures Placed in LisaWrite You can paste LisaDraw, LisaGraph, and 
LisaProject documents directly into LisaWrite. LisaWrite will handle these figures 
as individual blocks, or paragraphs that you cannot edit. Space will be provided 
to hold the figure in the text, but when you merge the text into Compose, only 
the text and the space will appear. The figure will not be in the text. 
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If you are planning to assemble a document in Compose, you should work with 
text only in LisaWrite and merge the text and figures in your Compose document. 
You have more flexibility to layout your page with Compose because you can add 
rules, vary the size of compartments and cut text to run around figures on the 
page. 

Multiple Typestyle Changes When text is in a galley you can change the font 
before you merge the text into a Compose compartment. This is accomplished by 
selecting a galley and choosing Change Fonts in Galley ... from the Fonts menu. 
You can change more than one font before you merge the text. 

When you are working with text source documents you can choose Modern or 
Classic in several different sizes. You can designate a different size font for 
various components of your document so that each type of heading, subheading 
and text change, such as bold or italic, will be a different point size. When you 
paste the document into a Compose galley, you can replace each of the point sizes 
while the text is in the galley with a different font that you designate. 

Study the dialog box Change Fonts in Galley ... to see which point/pitch sizes 
you can replace. While the text is in a galley, you may select each of the point size 
and replace it with one of the fonts that you have showing on the Font menu. You 
may place new fonts on the menu to have a wider choice by choosing Replace 
Menu Fonts •••. You cannot search and replace the psuedo bold or the psuedo 
italic when text is in the galley. 
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Apple Key 
Combinations 

Some Cg Compose 2 menu items contain the Apple key symbol followed by a 
character. Menu items that appear with the Apple key symbol can be chosen by 
using the mouse, or by pressing and holding the ~key and pressing the 
character associated with that menu item. When you release the the ~key 
the operation will be performed as if you had selected the menu item. 

For example, to use the Cut menu item you select what you want to cut, press and 
hold the ~ key, then press the ~ key, and release tpe ~ key. 

The Apple key combinations listed below apply only to Cg Compose 2 
documents. While most of these items are the same for other tools, you should 
check each tool individually by looking at the menus, or the user manuals until 
you are certain how the particular key works for that tool. 

Note: Apple key definitions 1 through 6 may be changed for a document through Composition 
Defaults in the Edit Menu. 

1 1.0 pt. Rule P Plain Text 
2 1.5 pt. Rule Q Delete Word Break 
3 2.0pt. Rule R Right 
4 4.0 pt. Rule U Underline 
5 6.0pt. Rule V Paste 
6 8.0 pt. Rule W Insert Word Break 
7 Rule -other . . . X Cut 
A Select All of Document Z Undo Last Change 
B Bold Terminate 
C Cut [ Show/Hide Rulers 
D Duplicate - Clear Tab Stop 
G Go to Page ... { Set Normal Tab 
I Italic I Set Centered Tab 
J Justify } Set Right Flush Tab 
K Center Set Decimal Tab 
L Left Set Comma lab 
M Make a Compartment 
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Type of one size and face is called a/onto The "face" is the portion of the 
character that displays and prints. At the top of the Type Style menu is Plain 
Text. This indicates that the font will be printed without any of the other 
attributes listed directly beneath it, such as bold, or underline. The Bold and 
Italic are attributes that can be applied to any font that you choose. These items 
will not produce a true font, but will apply a psuedo bold or slant affect to the 
type selection. 

At the bottom of the menu are the selections of size that are available for the fonts 
that you are using. You may select Apple Modern and Classic which are 
available in all of the Lisa tools. 

Apple Classic fonts larger than 12 point will print as Cg Times. Apple Modern 
fonts larger than 12 point will print as Triumvirate. 

The pitch number following the Apple type indicates the number of fixed 
characters per inch (the pitch). This is mono spaced type. 

The other type in this menu is measured in points (72 points equals one inch). 
These fonts have proportional spacing for each character. 

The list below shows the fonts as they print. The type style of each font is plain. 
Each of these fonts also may be bold, underlined, italic, superscript, or 
subscript. You can print any combination of point sizes and fonts on any printer. 

8 Point, 20 Pitch Modern 

8 Point, 20 Pitch Classic 
8 Point, 15 Pitch Modern 
8 Point, 15 Pitch Classic 
10 Point, 12 Pitch Modern 
10 Point, 12 Pitch Classic 
12 Point, 10 Pitch Modern 
12 Point, 10 Pitch Classic 
12 Point Triumvirate 
12 Point Cg Times 

14 Point Triumvirate 
14 Point Cg Times 

18 Point Triumvirate 
18 Point Cg Times 
24 Point Triumvirate 
24 Point Cg Times 
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Keyboard Layout The following option characters are available for all type fonts on the Personal 
Composition System. This keyboard layout replaces the reference card stored 
below the keyboard. 

To access a special character, press and hold the IOptionlkey, press the desired 
key, and release the ~ key. For example, if you want a cent sign: 

~ Press and hold the lQIillQ!!I key 

~ Press the number I!I key on the main keyboard 

~ Release the IOptionl key. 
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8400117 
100 Font Option 203 
alert boxes 209 
assigning UID numbers 199 
copying fonts-dual disk drive 203 
copying fonts-hard disk 203 
copying fonts-single disk drive 20 
deleting fonts 204 
font complements 197 
Font Dump Utility 205 
Font Librarian Utilities 200 
font setup 197,198 
Format for Printer 116,206 
initializing floppy disks 201 
loading the Font Librarian 200 
status messages 204,208 
system components 195 
terminating typesetting 208 
troubleshooting 208 

8600211 
alert boxes 220 
assigning font position numbers 215 
Control Panel 214 
creating slave font table 217 
daily operation 218 
disk drive 214 
font complements 215 
font directory 217 
font diskette labels 215 
font setup 214 
Format for Printer 116, 218 
hardware components 213 
installing fonts on hard disk 216 
internal hard disk 214 
messages 217 
status messages 220 
terminating typesetting 219 
troubleshooting 220 
typesetting a document 219 

A 
About Menus 52 
Accept and Design a Page 37 
Accept Page 56 
Add Selected Font 152 
Align Objects 22, 57, 131 
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Align Tops 22 
Aligning Compartments 22 
Annual Report 14-20 
Apple Key Combinations 225 
Arrangement Menu 130 

B 
Bold Text 226 
Break Compartment Links 102 

C 
CgCompose 2 

Manual 7 
Terms 51 
Window 51 

Cg Fonts Library 148, 150 
Changing 

fonts 88 
Fonts in Galley 25, 100, 124,224 
linespace 86 
page numbers 128 
printers 140 
shapes 57 
word breaks 90 

Character Compensation 24, 58 
Compartments 15 

aligning 22 
duplicating 22 
linking 56, 85 
making 22,56,69,83,97 
matching 84,99 
merging text into 85 
moving 105 
placing within compartments 106 

Compose document compartments 15 
Compose document menu names 15 
Compose Examples Folder opening 13 
Compose Paper 55 
Composition Defaults 67, 120 
Composition Defaults changing 31 
Compress Text 58, 126 
Compugraphic Defaults 67 
Connecting Printers 141 
Copying a Source Document 71 
Corona Wire 180 
Creating a Slave Font Table 217 
Creating a Source Document 74 
Customize Rulers 129 
Cutting Text 87 
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Default Printer 68, 140 
Design Page 59, 60, 127 
Desktop 11 
Device Preferences 139 
Digitized Type 213 
Disk 

opening 12 
repairing 142 
viewing 11 
Utility Action Log 173 

Diskette Masters 153 
Diskettes 143 
Document opening 13 
Document putting away 79 
Duplicating a Compartment 22 

E 
Edit Menu 119 
Editing 80 
Editing Text 57 
Editing the Source Tool 94, 96 
Entering Text 27,57,69 
Environments Window 147 
EP 308164 

aborting a document 187 
adjusting print density 185 
cartridge indicator 177 
changing paper 182 
command file 168 
copy counter 177 
correcting diagnostic errors 192 
diagnostics 190 
floppy disk loading errors 191 
font complements 167 
Font Dump 174 
Format for Printer 115 
load status messages 191 
loading letterhead paper 183 
loading messages 192 
loading paper 181 
making a Font Index 174 
out of paper 188 
output 44 
paper jam 188 
pausing while printing 187 
procedure to print 184 
program disks 165 
program load errors 191 
sample Command File 170 

toner cartridges 177 
troubleshooting 189 
unclear prints 186 
Utility program messages 175 

Examples Folder 11 

F 
Figures 223 
Figures Placed in LisaWrite 223 
File/Print Menu 114 
Final Editing 33, 42 
Font Librarian 148 
Font Librarian Menu Items 149 
Font Library changing 156 
Fonts 147, 226 

changing 77 
installing 154 
Menu 122 

Footer making 35 
Format for Printer 43, 115 
Format for Printer ImageWriter 116 
Format for Typesetter 46 
Format Menu 125 
Format Settings 59 
Format Styles 59 
Format Text 58 
Formatting Blank Stationery 66 
Formatting Text in a Galley 24 

G 
Galley 

creating 26 
dragging 26 
making 68 

Getting Started 7 
Go to Page I?O 
Group Objects 57 

H 
Header making 35 
High Resolution 93 
Horizontal Paragraph Ruler 60 

ICS 162 
ICS front control panel 163 
ImageWriter 118 
Inserting Rules 30 
Inserting Space Blocks 90 
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Installing 
Cg Compose 2 137 
Compose 2 Tool 136 
device driver software 138 
EP 308166 
EP 308 Application Program 167 
Intellifonts 167, 171 
toner cartridge 178 

Intellifonts 165 
Introducing Compose 8 
Italic Text 226 

K 
Kerning 24,28,58 

L 
landscape Mode 93 
layout 37, 40 
linespace changing 86 
linking Compartments 25, 56 
lisa Office System Manual 7 
lisaDraw, 223 
lisaGraph, 223 
lisaProject, 223 
lisaTerminal223 
lisaWrite, 223 
loading 8400 Operating Program 206 
locking in Place 23 
locking Objects 57 
low Resolution 93 

M 
Making 

Compartment 16, 21, 56, 69, 97 
Galley 68 
Space Block 101 
Stationery Pad 64 
8400 User Font Disk 200 

Manual Paper Feed 182 
Matching Compartments 99 
Merging Text 26, 101, 104 
Monitor the Printer 118 
Moving a Figure to the Page 23 
Moving Compartments 105 
Multiple Typestyle Changes 224 

N 
News Release 81 
News Release preparing 80 
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o 
Option Characters 227 
Other Cg Fonts 122 
Other Cg Point Size 121 
Output Dialog Boxes 63 
Output ImageWriter Printer 43 
Output Typesetter 44 
Outputting a Document 91 

p 
Page 58 

layout 60 
layout Menu 127 
number inserting 36 
size 57, 66 
size 97 

Paragraph 58 
Pasting a Document 82 
Pasting a Figure 72 
Pasting Text 76, 87 
Placing Compartments Within Compartments 106 
Placing Rules 103 
Plain Text 226 
Pointers 54 
Powering EP 308 176 
Practice with Compose 16 
Preferences 7 
Preparing a Source Document 82 
Printers 

changing 140 
connecting 141 
default 140 

Printing trouble with 46 
Printing Orientation 45 

R 
Renaming the New Document 14 
Repairing the Disk 142 
Replace Menu Fonts 224 
Replace Menu Fonts 59, 123 
Representative Font library 148, 152 
Rules 129 
Rules making 72 
Rules placing 73, 103 

S 
Scrolling 61, 62 
Selecting 54 
Selecting objects 55 
Selecting text 55 



Set Tab Fill 126 
Setting Vertical Justification 89 
Shading Objects 107, 131 
Space Block making 33 
Special Applications 223 
Stationery Pad making 74 
Storing Toner Cartidges 180 
System Set Up 135 

T 
Tabs 59 
Tabs setting 40 
Tearing Off Stationery 14 
Text 52,58,223 

cutting 29, 87 
entering 27, 69 
merging 26, 77, 101, 104 
pasting 87 
wrapping 57 

Tool 7 
Trouble with Printing 46 
True Font 226 
True Type 165 
Type Style Menu 121 
Typeset a Memo 64 
Typesetting on the 8400 207 
Typestyle changing 27 

U 
Using the Manuals 7 

V 
Vertical]ustification 32 
Vertical Page Ruler 60 

W 
Word Breaks inserting 34 
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Attention 
Federal regulations require that, due to the laser technology in the EP 308, Compugraphic 
Corporation must track the location of all units for five years after the initial shipment. 

We therefore request that you return the card below with the name and address of the new 
owner (if applicable) should your EP 308 change location for any reason. Also, please be sure 
to include the following information: 

~ Any change in ownership information. 

~ The serial number of the Printer unit located inside of the printer. Open the top of the 
printer by releasing the green handle on the right side. The serial number is printed on 
the right lower side of the unit. 

~ The reason for the change (i.e., moved, sold, stolen, destroy~d). 

Thank you for your assistance. 

---~-------------------------------------
I 
I 

EP 308 Ownership Change Reply Card 

Printer Serial No. __________________ Date ________ _ 

Previous Location New Location 

Owner _____________ _ Owner _____________ _ 

Company _________ Dept. __ Company _________ Dept. __ 

Address _____________ _ Address _____________ _ 

City _________ State _ Zip __ City _________ State _ Zip __ 

Reason for change ___________________________ _ 

Date Purchased ___________ _ Effective Date of Change ________ _ 
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